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Please read the Operation Guide before using the printer. Keep it close to the printer for
easy reference.

The sections of this guide and parts of the printer marked with symbols are safety warnings meant to protect the user,
other individuals and surrounding objects, and ensure correct and safe usage of the printer. The symbols and their
meanings are indicated below.

A WARNING: Indicates that serious injury or even death may result from insufficient attention to or incorrect
compliance with the related points.

A CAUTION: Indicates that personal injury or mechanical damage may result from insufficient attention to or
incorrect compliance with the related points.

Symbols

The A\ symbol indicates that the related section includes safety warnings. Specific points of attention are indicated
inside the symbol.

A .................... [General warning]
A .................... [Warning of danger of electrical shock]
& .................... [Warning of high temperature]

The © symbol indicates that the related section includes information on prohibited actions. Specifics of the prohibited
action are indicated inside the symbol.

® ................. [Warning of prohibited action]
® .................. [Disassembly prohibited]

The @ symbol indicates that the related section includes information on actions which must be performed. Specifics
of the required action are indicated inside the symbol.

o ................. [Alert of required action]
% .................. [Remove the power plug from the outlet]

9 .................. [Always connect the printer to an outlet with a ground connection]

Please contact your service representative to order a replacement if the safety warnings in the guide are illegible or if
the guide itself is missing. (fee required)
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Caution

NO LIABILITY IS ASSUMED FOR ANY DAMAGE CAUSED BY IMPROPER INSTALLATION.

Notice on Software

SOFTWARE USED WITH THIS PRINTER MUST SUPPORT THE PRINTER'S EMULATION MODE. The printer
is factory-set to emulate the PCL. The emulation mode can be changed by following the procedures described in
Chapter 3.

Notice

The information in this guide is subject to change without notification. Additional pages may be inserted in future
editions. The user is asked to excuse any technical inaccuracies or typographical errors in the present edition.

No responsibility is assumed if accidents occur while the user is following the instructions in this guide. No responsi-
bility is assumed for defects in the printer's firmware (contents of its read-only memory).

This guide, any copyrightable subject matter sold or provided with or in connection with the sale of the page printer,
are protected by copyright. All rights are reserved. Copying or other reproduction of all or part of this guide, any
copyrightable subject matter without the prior written consent of Kyocera Mita Corporation is prohibited. Any copies
made of all or part of this guide, any copyrightable subject must contain the same copyright notice as the material from
which the copying is done.

Regarding Tradenames

PRESCRIBE is a registered trademark of Kyocera Corporation. KPDL is trademark of Kyocera Corporation.

Diablo 630 is a product of Xerox Corporation. IBM Proprinter X24E is a product of International Business Machines
Corporation. Epson LQ-850 is a product of Seiko Epson Corporation.

Hewlett-Packard, PCL, and PJL are registered trademarks of Hewlett-Packard Company. Centronics is a trade name
of Centronics Data Computer Inc. PostScript is a registered trademark of Adobe Systems Incorporated. Macintosh is
aregistered trademark of Apple Computer, Inc. Microsoft, Windows, and Windows NT are registered trademarks of
Microsoft Corporation. PowerPC and Microdrive are trademarks of International Business Machines Corporation.
CompactFlash is a trademark of SanDisk Corporation. ENERGY STAR isa U.S. registered mark. All other brand and
product names are registered trademarks or trademarks of their respective companies.

This Kyocera Mita page printer uses PeerlessPrintXL to provide the HP LaserJet compatible PCL 6 language emula-
tion. PeerlessPrintXL is a trademark of The Peerless Group, Redondo Beach, CA 90278, U.S.A.

This product was developed using the Tornado™ Real Time Operating System and Tools from Wind River Systems.
AGFA @ This product contains UFST™ and MicroType® from Agfa Monotype Corporation.

—— usB
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IBM PROGRAM LICENSE AGREEMENT

THE DEVICE YOU HAVE PURCHASED CONTAINS ONE OR MORE SOFTWARE PROGRAMS ("PRO-
GRAMS") WHICH BELONG TO INTERNATIONAL BUSINESS MACHINES CORPORATION ("IBM"). THIS
DOCUMENT DEFINES THE TERMS AND CONDITIONS UNDER WHICH THE SOFTWARE IS BEING
LICENSED TO YOU BY IBM. IF YOU DO NOT AGREE WITH THE TERMS AND CONDITIONS OF THIS
LICENSE, THEN WITHIN 14 DAYS AFTER YOUR ACQUISITION OF THEDEVICE YOUMAY RETURN THE
DEVICE FOR A FULL REFUND. IF YOU DO NOT SO RETURN THE DEVICE WITHIN THE 14 DAYS, THEN
YOU WILL BE ASSUMED TO HAVE AGREED TO THESE TERMS AND CONDITIONS.

The Programs are licensed not sold. IBM, or the applicable IBM country organization, grants you a license for the
Programs only inthe country where you acquired the Programs. You obtain norights other than those granted you under
this license.

The term "Programs" means the original and all whole or partial copies of it, including modified copies or portions
merged into other programs. IBM retains title to the Programs. IBM owns, or has licensed from the owner, copyrights
in the Programs.

1.License
Under this license, you may use the Programs only with the device on which they are installed and transfer possession
of the Programs and the device to another party.
If you transfer the Programs, you must transfer a copy of this license and any other documentation to the other party.
Your license is then terminated. The other party agrees to these terms and conditions by its first use of the Program.
You may not:
1) use, copy, modify, merge, or transfer copies of the Program except as provided in this license;
2) reverse assemble or reverse compile the Program; or
3) sublicense, rent, lease, or assign the Program.
2. Limited Warranty
The Programs are provided "AS IS."
THERE ARE NO OTHER WARRANTIES COVERING THE PROGRAMS (OR CONDITIONS), EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE.
Some jurisdictions do not allow the exclusion of implied warranties, so the above exclusion may not apply to you.
3. Limitation of Remedies
IBM's entire liability under this license is the following;
1) Forany claim (including fundamental breach), in any form, related in any way to this license, IBM's liability will
be for actual damages only and will be limited to the greater of:
a) the equivalent of U.S. $25,000 in your local currency; or
b) IBM's then generally available license fee for the Program
This limitation will not apply to claims for bodily injury or damages to real or tangible personal property for which IBM
is legally liable.

IBM will not be liable for any lost profits, lost savings, or any incidental damages or other economic consequential
damages, even if IBM, or its authorized supplier, has been advised of the possibility of such damages. IBM will not be
liable for any damages claimed by you based on any third party claim. This limitation of remedies also applies to any
developer of Programs supplied to IBM. IBM's and the developer's limitations of remedies are not cumulative. Such
developer is an intended beneficiary of this Section. Some jurisdictions do not allow these limitations or exclusions,
so they may not apply to you.

4. General

You may terminate your license at any time. IBM may terminate your license if you fail to comply with the terms and
conditions of this license. In either event, you must destroy all your copies of the Program. You are responsible for
payment of any taxes, including personal property taxes, resulting from this license. Neither party may bring an action,
regardless of form, more than two years after the cause of action arose. If you acquired the Program in the United States,
this license is governed by the laws of the State of New York. If you acquired the Program in Canada, this license is
governed by the laws of the Province of Ontario. Otherwise, this license is governed by the laws of the country in which
you acquired the Program.

Typeface Trademark Acknowledgement

All resident fonts in this printer are licensed from Agfa Corporation.

Helvetica, Palatino and Times are registered trademarks of Linotype-Hell AG. ITC Avant Garde Gothic, ITC Book-
man, ITC ZapfChancery and ITC Zapf Dingbats are registered trademarks of International Typeface Corporation.
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Agfa Monotype License Agreement

D

2)

3)

4)

5)

6)
7

8)

9)
10)

11)

12)

"Software" shall mean the digitally encoded, machine readable, scalable outline data as encoded in a special
format as well as the UFST Software.

You agree to accept a non-exclusive license to use the Software to reproduce and display weights, styles and
versions of letters, numerals, characters and symbols ("Typefaces") solely for your own customary business or
personal purposes at the address stated on the registration card you return to Agfa Japan. Under the terms of this
License Agreement, you have the right to use the Fonts on up to three printers. If you need to have access to the
fonts on more than three printers, you need to acquire a multi-user license agreement which can be obtained from
AgfaJapan. Agfa Japan retains all rights, title and interest to the Software and Typefaces and no rights are granted
to you other than a License to use the Software on the terms expressly set forth in this Agreement.

To protect proprietary rights of Agfa Japan, you agree to maintain the Software and other proprietary information
concerning the Typefaces in strict confidence and to establish reasonable procedures regulating access to and use
of the Software and Typefaces.

You agree not to duplicate or copy the Software or Typefaces, except that you may make one backup copy. You
agree that any such copy shall contain the same proprietary notices as those appearing on the original.

This License shall continue until the last use of the Software and Typefaces, unless sooner terminated. This License
may be terminated by Agfa Japan if you fail to comply with the terms of this License and such failure is not
remedied within thirty (30) days after notice from Agfa Japan. When this License expires or is terminated, you
shall either return to Agfa Japan or destroy all copies of the Software and Typefaces and documentation as
requested.

You agree that you will not modity, alter, disassemble, decrypt, reverse engineer or decompile the Software.
Agfa Japan warrants that for ninety (90) days after delivery, the Software will perform in accordance with Agfa
Japan-published specifications, and the diskette will be free from defects in material and workmanship. Agfa
Japan does not warrant that the Software is free from all bugs, errors and omissions.

THE PARTIES AGREE THAT ALL OTHER WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING
WARRANTIES OF FITNESS FOR A PARTICULAR PURPOSE AND MERCHANTABILITY, ARE
EXCLUDED.

Your exclusive remedy and the sole liability of Agfa Japan in connection with the Software and Typefaces is repair
or replacement of defective parts, upon their return to Agfa Japan.

IN NO EVENT WILL AGFA JAPAN BE LIABLE FOR LOST PROFITS, LOST DATA, OR ANY OTHER
INCIDENTAL OR CONSEQUENTIAL DAMAGES, OR ANY DAMAGES CAUSED BY ABUSE OR MIS-
APPLICATION OF THE SOFTWARE AND TYPEFACES.

New York, U.S.A. law governs this Agreement.

You shall not sublicense, sell, lease, or otherwise transfer the Software and/or Typefaces without the prior written
consent of Agfa Japan.

Use, duplication or disclosure by the Government is subject to restrictions as set forth in the Rights in Technical
Data and Computer Software clause at FAR 252-227-7013, subdivision (b)(3)(ii) or subparagraph (c)(1)(ii), as
appropriate. Further use, duplication or disclosure is subject to restrictions applicable to restricted rights software
as set forth in FAR 52.227-19 (¢)(2).

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, UNDERSTAND IT, AND AGREE
TOBE BOUND BY ITS TERMS AND CONDITIONS. NEITHER PARTY SHALL BE BOUND BY ANY
STATEMENT OR REPRESENTATION NOT CONTAINED IN THIS AGREEMENT. NO CHANGE IN THIS
AGREEMENT IS EFFECTIVE UNLESS WRITTEN AND SIGNED BY PROPERLY AUTHORIZED REPRE-
SENTATIVES OF EACH PARTY. BY OPENING THIS DISKETTE PACKAGE, YOU AGREE TO ACCEPT
THE TERMS AND CONDITIONS OF THIS AGREEMENT.

iv
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FCC statement (for users in the United States)

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This
device may not cause harmful interference, and (2) this device must accept any interference received, including inter-
ference that may cause undesired operation.

Note:

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in
accordance with the instructions, may cause harmful interference to radio communications. However, there is not
guarantee that interference will not occur in a particular installation. If this equipment does not cause harmful interfer-
ence to radio or television reception, which can be determined by turning the equipment off and on, the user is encour-
aged to try to correct the interference by one or more of the following measures:

*  Reorient orrelocate the receiving antenna.

* Increase the distance between the equipment and the receiver.

*  Connect the equipment into an outlet on a circuit different from that used for the receiver.
*  Consult the dealer or an experienced radio/TV technician for help.

Changes or modifications not expressly approved by the manufacturer for compliance could void the user's authority
to operate the equipment. Shielded circular cables should be used for interfacing with the computer.

Cautions to the user:

* Any modifications without prior permission of Kyocera may cause harmful interference.

+ Ifany modifications or changes are made to this equipment without prior permission of Kyocera, Kyocera as the
manufacturer does not guarantee the compliance with the FCC Rules.

*  Theuse of equipment that does not comply with the FCC Rules is prohibited.

\"

Download from Www.Somanuals.com. All Manuals Search And Download.



Important Notes for Interface connectors

Be sure to power off the printer before connecting or disconnecting an interface cable. For protection against static
electricity discharge to the printer's internal electronics through the interface connector(s), cover any interface connec-
tor that is not in use with the protective cap supplied.

Use shielded interface cables.

Cautionary Labels

The printer bears any of the following labels.

CAUTION ACHTUNG __ ATTENTION _
HOT SURFACE HEISSE OBERFLACHE TEMPERATURE ELEVEE
ATTENCION  ATTENZIONE
EXTERIOR CALIENTE SUPERFICIE CHE SCOTIA

= == N
-_I'-E'I'-o—l =/m/ER

For Europe, Asia, For U.S.A. and
and other countries Canada

FS-C5016N 220-240v~ - 120V~
$-C5016 50/60Hz 4.5A FS-C5016N 60Hz 9.1A
KYOCERA MITA CORPORATION KYOCERA MITA CORPORATION
a8
UL 60050
@D Lt
Tesd To Conply
CAUTION ACNOU3E52444 FOR HOME OR OFFICE USE
REMOVE POWER CORD BEFORE SERVICE This device complies with Part 15 of the FCC Rules
AND FUGE WERLACEMENT. Operation is subjec to the fllowing two
conditions: (1) This device may not cause harmful
VORSICHT m(ev:erence, and (z]dxms dovice must accept any
YOR WARTUG UND SiHERUNGS- i i g narrne il
WECHSEL NETZSTECKER ZIEHEN. This Class B digital apparatus complies
ATTENTION with Canadian (CES-003.
| Cotapparei numériquo de Ia classo B ost
POUR PREVENIR LES CHOCS conforme a la norme NMB-003 du Canada.
ELECTRIQUES, COUPER L'ALIMENTATION CAUTION
AVANT DE REMPLACER LE FUSIBLE.
REMOVE POWER CORD BEFORE SERVICE
ATENCION AND FUSE REPLACEMENT.
DESENCHUFE EL CORDON
DE ALENTACION ANTED DEL SERVICIO Y A T ENTION o5 chocs
DEL REEMPLAZO DEL FUSIBLE. ELECTRIQUES, COUPER L'ALIMENTATION
PRECAUZIONE AVANT DE REMPLACER LE FUSIBLE.
PRIMA DI CAMBIARE | FIESIBILI O PRECAUZIONE
DI ESEGUIRE RIPARAZIONI, PRIMA DI CAMBIARE | FIESIBILI O
'STACCATE IL CADO DI ALIMENTAZIONE. DI ESEGUIRE RIPARAZIONI,
>ABS< MADE IN JAPAN S ATE 1L GO Dl A AN

Ozone concentration

The printers generate ozone gas (O3) which may concentrate in the place of installation and cause an unpleasant smell.
To minimize the concentration of ozone gas to less than 0.1 ppm, we recommend you not to install the printer in a
confined area where ventilation is blocked.

vi
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Declaration of Conformity for U.S.A.

Model name: Color Page Printer FS-C5016N

Trade name: Kyocera Mita

Responsible party: Kyocera Mita America, Inc.

Address: 225 Sand Road PO Box 40008 Fairfield, New Jersey 07004-0008, U.S.A.

Telephone: (973) 808-8444

Fax: (973) 882-6000

Manufacturer: Kyocera Mita Corporation Tamaki Plant

Manufacturer’s address: 704-19, Nojino, Tamaki-cho, Watarai-gun, Mie-ken 519-0497, Japan

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this
device may not cause harmful interference, and (2) this device must accept any interference received, including inter-
ference that may cause undesired operation.

The manufacturer and its merchandising companies retain the following technical documentation in anticipation of the
inspection that may be conducted by the authorities concerned.

User’s instruction that conforms to the applicable specifications.

Technical drawings.

Descriptions of the procedures that guarantee the conformity.

Other technical information.

Kyocera Mita America Inc.

CE Marking Directive

According to Council Directive 89/336/EEC and 73/23/EEC

Manufacturer: Kyocera Mita Corporation Tamaki Plant
Manufacturer’s address: 704-19, Nojino, Tamaki-cho, Watarai-gun, Mie-ken 519-0497, Japan

Declares that the product
Product name: Color Page Printer

Model number: FS-C5016N
(as tested with enhancement optional units; Duplex unit DU-300, Paper Feeder PF-60)

Conforms to the following product specifications:

EN55022: 1998 Class B
EN 61000-3-2: 1995
EN 61 000-3-3: 1995
EN 55024: 1998

EN 60 950: 2000

The manufacturer and its merchandising companies retain the following technical documentation in anticipation of the
inspection that may be conducted by the authorities concerned.

User’s instruction that conforms to the applicable specifications.
Technical drawings.

Descriptions of procedures that guarantee conformity.

Other technical information.

Vi
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Declaration of Conformity for Australia

Manufacturer: Kyocera Mita Corporation Tamaki Plant

Manufacturer’s address: 704-19, Nojino, Tamaki-cho, Watarai-gun, Mie-ken 519-0497, Japan
declares that the product

Product name: Color Page Printer
Model name: FS-C5016N

Description of devices: This Page Printer Model FS-C5016N is the 16 ppm (monochrome/color), A4 size and utilized
plane paper; dry toner; etc. The printer can be equipped with several enhancement optional units as a paper feeder as
PF-60, a duplex unit as DU-300.
conforms to the following product specifications:

AS/NZS 3548: 1995 (EN 55 022: 1998 Class B)

IEC60950 (EN 60 950): 1999
The manufacturer and its merchandising companies retain the following technical documentation in anticipation of the
inspection that may be conducted by the authorities concerned.

User’s instruction that conforms to the applicable specifications
Technical drawings

Descriptions of procedures that guarantee conformity

Other technical information

The manufacturer has been employed with ISO9001 scheme. JQA and BS have attested the manufacturer.

Kyocera Mita Australia Pty., Ltd.

6-10 Talavera Road, North Ryde, NSW 2113, Australia
Telephone: +61 2-9888-9999

Fax: +612-9888-9588

Canadian Department of Communications compliance statement

This Class B digital apparatus complies with Canadian ICES-003.

Avis de conformité aux normes du ministere des Communications du Canada

Cet appareil numérique de la classe B est conforme a la norme NMB-003 du Canada.

ISO 7779

Maschinenldrminformationsverordnung 3. GSGV, 18.01.1991: Der hochste Schalldruckpegel betrégt 70 dB (A) oder
weniger geméf ISO 7779.

Disclaimer

Kyocera Mita will not be liable to customers or any other person or entity for any loss or damage caused or alleged to
be caused directly or indirectly by equipment sold or furnished by us, including but not limited to, any interruption of
service, loss of business or anticipatory profits, or consequential damages resulting from the use or operation of the
equipment or software.

viii
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ENERGY STAR®

As an ENERGY STAR Partner, we have determined that this product meets the ENERGY STAR
/\Q guidelines for energy efficiency.

The basic objective of the ENERGY STAR Program is to reduce environmental pollution by
encouraging the manufacture and sale of equipment that uses energy more efficiently.

This printer is equipped with a sleep timer function that conforms with the standards of the ENERGY STAR Program.
This function makes it possible to reduce the amount of electrical power consumed by the printer. For maximum power
savings, turn off the printer’s power supply when not using the printer for extended periods of time.

For details on the sleep timer function and printer power consumption, refer to this manual.

Initial settings of the sleep timer function and power saved using the sleep timer function:

Initial sleep mode setting Power consumption in sleep mode

15 minutes (60 minutes) 21 W (45 W) [for U.S.A. and Canada]
24 W (45 W) [for Europe, Asia, and other countries]

(): ENERGY STAR program guideline

Group for Energy Efficient Appliances (GEEA)

The goal of GEEA is efficient use of energy. This product has a high-efficiency profile
and meets the criteria for receiving the GEEA-Label.

E N E Initial sleep mode setting Power Consumption
Power off Sleep mode
15 min. (60 min.) OW(1W) 24 W (30 W)

(): GEEA criteria

iX
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A Installation Precautions

Environment

A CAUTION

* Avoid placing the printer on or in locations which are unstable or not level. Such locations may
cause the printer to fall down or fall over. This type of situation presents a danger of personal ®
injury or damage t0 the PLANTET. ..........ccueeiriiiiiiiie e e

* Avoid locations with humidity or dust and dirt. If dust or dirt becomes attached to the power ®
plug, clean the plug to avoid the danger of fire or electrical shock. .........cccceeeiiiiiiiiiiiiiinnnn.

* Avoid locations near radiators, heaters, or other heat sources, or locations near flammable ®
items, to avoid the danger Of fire. ........ceeiiiiiiiiiiiii

* To keep the printer cool and facilitate changing of parts and maintenance, allow access space
as shown below. Leave adequate space, especially around the side cover, to allow air to be o
properly ventilated out 0f the Printer. ...........ooeiiiiiiiiiiiiiie e

Top: 75 cm
(29-1/2 inches)

Left: 40 cm Right: 25 cm  Rear: 25 cm Front: 60 cm
(15-3/4 inches) (10 inches) (10 inches) (23-5/8 inches)
([40 cm (15-3/4 inches)
when the optional face-up
output tray is installed]

Other Precautions

* Adverse environmental conditions may affect the safe operation and performance of the
printer. Install in an air-conditioned room (recommended room temperature: around 20 °C,
humidity: around 65 % RH) and avoid the following locations when selecting a site for the
printer.

* Avoid locations near a window or with exposure to direct sunlight.
* Avoid locations with vibrations.

* Avoid locations with drastic temperature fluctuations.

* Avoid locations with direct exposure to hot or cold air.

* Avoid poorly ventilated locations.

« If the floor is delicate against casters, when this product is moved after installation, the floor
material may be damaged.

X
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Power Supply/Grounding the Printer

A WARNING

* DO NOT use a power supply with a voltage other than that specified. Avoid multiple connec- ®
tions in the same outlet. These types of situations present a danger of fire or electrical shock...

* Plug the power cord securely into the outlet. If metallic objects come in contact with the prongs o
on the plug, it may cause a fire or electric ShOCK. .......c.eveeeiiiiiiiiiiiii e

electrical shock in case of an electric short. If an earth connection is not possible, contact your

* Always connect the printer to an outlet with a ground connection to avoid the danger of fire or
SCIVICE TEPTESCILATIVE. .iiiiiiuuiteiititeeeete et etaeaaaeeaeeaaaassaaaaaanasasesebbeeeeeeeeeeeaaaaaasaesanaaaaannnen 9

Other Precautions

* Connect the power plug to the closest outlet possible to the printer.

Handling of Plastic Bags

A WARNING

* Keep the plastic bags that are used with the printer away from children. The plastic may cling ®
to their nose and mouth causing SUffOCAtION. .......cccevverieriiriiriiriiiereeree e

Xi
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A Precautions for Use

Cautions when Using the Printer

A WARNING

* DONOT place metallic objects or containers with water (flower vases, flower pots, cups, etc.)
on or near the printer. This type of situation presents a danger of fire or electrical shock should ®
they Fall INSIAC. ....vviiiiiiiiiiie et

* DONOT remove any of the covers from the printer as there is a danger of electrical shock from ®
high voltage parts inside the Printer. .............coooiiiiiiiiiiii e

* DONOT damage, break or attempt to repair the power cord. DO NOT place heavy objects on
the cord, pull it, bend it unnecessarily or cause any other type of damage.These types of situa- ®
tions present a danger of fire or electrical ShoCK. ..........ccooiiiiiiiiiiiiii e

* NEVER attempt to repair or disassemble the printer or its parts as there is a danger of fire,
electrical shock or damage to the laser. If the laser beam escapes, there is a danger of it causing ®
BIIANESS. oottt e s

« If the printer becomes excessively hot, smoke appears from the printer, there is an odd smell,
or any other abnormal situation occurs, there is a danger of fire or electrical shock. Turn the
power switch OFF (O) immediately, remove the power plug from the outlet and contact your %
SCIVICE TEPIESCILALIVE. ....uuuirrrrtieettieeteteeaeeeeseeesaa s s s e bbb e er e ettt eeetereeeeeeesesesanaasnenenrnnnne

switch OFF (O) immediately. Next, remove the power plug from the outlet to avoid the danger
of fire or electrical shock. Then contact your service representative. ............ccccceeeeecveeeeeeeanne

* DO NOT remove or connect the power plug with wet hands, as there is a danger of electrical ®
SROCK. it e

* If anything harmful (paper clips, water, other fluids, etc.) falls into the printer, turn the power %

* ALWAYS contact your service representative for maintenance or repair of internal parts. ...... 0

A CAUTION

* DONOT pull the power cord when removing it from the outlet. If the power cord is pulled, the
wires may become broken and there is a danger of fire or electrical shock. (ALWAY'S grasp the ®
power plug when removing the power cord from the outlet.) .............ooccoiiiiiiiiniee.

* ALWAY S remove the power plug from the outlet when moving the printer. If the power cord is %
damaged, there is a danger of fire or electrical ShOCK. ..........cccveeiiiiiiiiiiiiiiiiee

OFF (O).Ifitwillnotbe used for an extended period of time (vacations, etc.), remove the power

« If the printer will not be used for a short period of time (overnight, etc.), turn the power switch
plug from the outlet for safety purposes during the time the printer is notin use. ................... %

* For safety purposes. ALWAY S remove the power plug from the outlet when performing clean- %
I OPETALIONS. .. eeetiiuieteeee ittt e e e ettt e e et e e e e ettt e e e e eabb et e e e e e aant b e ee e e e satbeeee e e naanneneeeeaan

* If dust accumulates within the printer, there is a danger of fire or other trouble. It is therefore
recommended that you consult with your service representative in regard to cleaning of internal
parts. This is particularly effective if accomplished prior to seasons of high humidity. Consult o
with your service representative in regard to the cost of cleaning the internal parts of the printer.

Xii
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Other Precautions
* DO NOT place heavy objects on the printer or cause other damage to the printer.
* DONOT open the top cover, turn off the main switch, or pull out the power plug during printing.

* During printing, some ozone is released, but the amount does not cause any ill effect to one's
health. If, however, the printer is used over a long period of time in a poorly ventilated room or
when printing an extremely large number of copies, the smell may become unpleasant. To
maintain the appropriate environment for print work, it is suggested that the room be properly
ventilated.

* DO NOT touch electrical parts, such as connectors or printed circuit boards. They could be
damaged by static electricity.

* DO NOT attempt to perform any operations not explained in this handbook.

* CAUTION: Use of controls or adjustments or performance of procedures other than those spec-
ified herein may result in hazardous radiation exposure.

« Ifthe printer will not be used for an extended period of time, remove the paper from the cassette,
return it to its original package and reseal it.

Cautions for Toner Handling

A cAUTION ®
* Do not incinerate toner and toner containers. Dangerous sparks may cause burn. ..................

* Never 0pen the tONEr CONTAINET. ......vueeeiiereeiee e et ee e ettt e et e e e e e e st e e e sneree s ®

» Make sure not to inhale the toner, and not to rub your eyes or touch your mouth with the hands ®
stained with the toner. And make sure not to stick to your skin. ...........ccceeeeevienienienienenenennnnn.

* For the disposal of old toner container, consult your dealer. Or dispose of the toner or toner ®
containers in accordance with Federal, State and Local rules and regulations. .......................

* Keep away the toNner CONTAINET. .......ceeiiieiieriie it e ettt e e ®

Xiii
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For More Information...

Item Description
Installation Guide Describes the printer setup procedure.
(paper manual)
Quick Reference Guide Describes common information about the printer such as load-
(paper manual) ing paper, understanding messages, etc.

The following documents are stored in the CD-ROM as PDF documents.

Operation Guide (this manual) Guides you through topics concerning the operations and main-
tenance of the printer.

KX Printer Drivers Operation Guide  Describes how to install and set the printer driver.

PRESCRIBE Command Technical PRESCRIBE is the native language of the Kyocera Mita

Reference printers. This Technical Reference contains the information
about how the printing is performed using the PRESCRIBE
commands as well as the font and emulation description. Also
included is a list of permanent parameters and their explanation
needed when customizing your printer.

PRESCRIBE Command Reference ~ Gives a detailed explanation of the PRESCRIBE command
syntax and parameters with the aid of print examples.

Guide to the Operation Guide

This Operation Guide has the following chapters:

Chapter 1 Introduction

This chapter explains printer features and the names of parts.

Chapter 2 Handling Paper

This chapter explains the types of paper that can be used with the printer.

Chapter 3 Using the Operator Panel

This chapter explains the message display, indicators and keys on the operator panel, and
how to make various settings from the operator panel.

Chapter 4 Troubleshooting

This chapter explains how to handle printer problems that may occur, such as paper jams.

Chapter 5 Maintenance

This chapter explains how to replace the toner container and how to care for your printer.

Appendix A Options

This appendix introduces the available options to be used with the printer.

Appendix B Computer Interface

This appendix explains the pin assignment and specifications for the printer’s parallel
interface, USB interface, and serial interface.

Appendix C Technical Specifications

This appendix lists the printer’s specifications.

Xiv
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Chapter 1 Introduction

Welcome to the professional color printer from Kyocera Mita. With the Ecosys Color
FS-C5016N, you can print out color or monochrome pages at a speed of 16 pages per minute
(A4 size) or 17 pages per minute (Letter and AS sizes).
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1.1 Features

1.1
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1.1.2

Features

General

Hardware

This section outlines the common major printer features of the FS-C5016N Ecosys color
page printer.

Components with an ultra-long product life

The main printer components such as the Advanced Beam Array, imaging drum,
development units, and fuser unit have an ultra-long product life.

USB (Universal Serial Bus) Interface

This printer supports Full-Speed USB 2.0. Connection to a computer with a USB interface
gives a higher communication speed than parallel interface connection.

High-speed printing

This printer supports print speeds of up to 16 pages per minute (A4 size) for both color and
monochrome printouts. (Actual time varies according to page complexity.)

Superb color printing quality
This printer prints the gray level of 4 bpp (bits per pixel).

Intelligent color calibration system

The intelligent color calibration system automatically optimizes colors every time the
printer is powered.

Variety of paper sizes and types

In addition to ordinary paper, you can use print media such as transparencies, labels, and
other special papers for printouts.

Sleep mode

Conserves energy while printing is in standby.

Advanced Performance Data Processing

A 400 MHz CPU, 96 MB of RAM, and the optional hard disk deliver ideal throughput for
wide varying printing applications.

1-2
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1.1.3

Software

1.1 Features

Expansion slot for hardware interfaces

This printer is equipped with an expansion slot for plugging in an optional network interface
card or a hard disk.

Standard bidirectional parallel interface

Ensures high-speed data transfer between the host computer and printer.

Memory card slot

You can select and read the data in a memory card set in this slot from the printer operator
panel.

Large-capacity paper cassette

The paper cassette can hold approximately 500 sheets of 80 g/m? paper which is 0.1 mm
thick. The printer also has a multipurpose tray that can hold approximately 100 sheets of
nonstandard size paper. Printed sheets can be stacked in the face-down output tray or an

optional face-up output tray.

Displaying printer messages in any of eight languages

Printer messages can be displayed in English, French, German, Italian, Dutch, Spanish, or
Portuguese.

e-MPS

‘e-MPS’ is an abbreviation for ‘enhanced-Multiple Printing System,” which is a
post-processing function that combines electronic sorting, job retention, and virtual
mailboxing.

When printing multiple copies of a document, the data is transferred from the computer to
the printer only for the first copy; the data is then stored on the printer’s hard disk. Copies of
the document are printed using the stored data.

Printing is performed faster with less computer spooling time and less network traffic.

Furthermore, printed data that is stored on the hard disk can be called up using job retention
functions, such as Quick Copy etc., allowing you to quickly print additional copies of a
document from the printer at any time, without needing to re-spool the document or start up
the computer system.

Printer control language PRESCRIBE

The printer uses PRESCRIBE, Kyocera Mita’s page printer control language with enhanced
color graphics capabilities. The simple commands of PRESCRIBE allow the programmers
to easily define pagination and device control.

1-3
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114

Networking

KPDL3 (Kyocera Printer Description Language 3)

The printer uses KPDL3, Kyocera’s implementation of the PostScript page description
language Level 3. The printer has 136 fonts that are compatible with Adobe PostScript
fonts. (The printer also has 80 PCL fonts.)

PDF417 two-dimensional bar codes

The printer has the built-in two-dimensional stacked bar codes of PDF 417 (Portable Data
File 417).

Account Management System

This printer comes equipped with an Account Management System function which records
the number of pages printed by each department. The administrator can preset the maximum
number of pages that each department will be allowed to print.

Built-in and external network interfaces

Because the network interface supports TCP/IP, IPX/SPX, NetBEUI and EtherTalk
protocols, network printing is possible with various environments including Windows,
Macintosh, UNIX and NetWare, etc.

Support for network printer monitor utility (KM-NET VIEWER)

Allows network wide management of printers. See the readme file in the CD-ROM
(supplied with the printer) for details.

1-4
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1.2 Parts and Functions

1.2 Parts and Functions

This section provides explanations and illustrations for you to determine the parts and their
functions. Try to be familiar with the names and functions of these parts for correct use and
optimal performance.

1.21 Front

Figure 1-1

1 Operator Panel
Used to specify printer functions and display the printer operating status.

2 Top Cover
When open, this cover gives you access to the internal component for replacing toner
containers.

3  Paper Cassette
The cassette holds up to 500 sheets of AS to Legal sizes (80 g/m?).

4  MP (Multi-Purpose) Tray
The MP tray holds up to 100 sheets of paper (80 g/m?). Transparencies, envelopes, etc.
must be fed using this tray.

1-5
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1.2 Parts and Functions

1.2.2

Left

Figure 1-2

Face-down Tray
This tray receives printouts face down.

Power Switch
This switch turns printer power on and off.

Left Cover
This cover needs to be opened when replacing the waste toner box or cleaning the main
charger units.

Waste Toner Box
This plastic box collects waste toner for later disposal. The box has a cap which is used
to seal the box opening when being disposed of.

Main Charger Units

The main charger units are electrical components included in each toner container and
are used to transfer toner onto the drum unit. Whenever you replace a toner container,
be sure to clean the corresponding main charger unit.

1-6
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1.2 Parts and Functions

1.2.3 Internal

B OON-

Figure 1-3

1 Magenta Toner Container
This container holds magenta (M) toner. You must replace the container when the toner
run out.

2 Cyan Toner Container
This container holds cyan (C) toner. You must replace the container when the toner run
out.

3  Yellow Toner Container
This container holds yellow (Y) toner. You must replace the container when the toner
run out.

4 Black Toner Container
This container holds black (K) toner. You must replace the container when the toner
run out.

5 Paper Transfer Unit
The paper transfer unit feeds paper from the cassette for printing.

1-7
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1.2 Parts and Functions

1.2.4 Rear

Figure 1-4

1 Vents
Air is purged through these vents to cool down the inside.

2 USB Interface Connector
This connector is a USB interface that conforms to the Full-Speed USB 2.0. Use a USB
cable between this connector and the USB port on a computer.

3  Memory Card Slot
This slot receives a memory card. A memory card can hold fonts, macros, forms, etc.,
that can be downloaded in the printer’s memory. For details, see Appendix A Options,
section A.3.1 Memory Card on page A-7.

4  Power Cord Connector
This connector accepts the power cord supplied with the printer.

5 Network indicators
These indicators light according to the communication status with the network.
Right: I0BASE-T/100BASE-TX indicator
Lights when you are connected to the network at 10 Mbps or 100 Mbps.
Left: Status indicator
Flashes during data communication.

6 Network Interface Connector
Connects to the network via a 10BASE-T/100BASE-TX network cable.

7  Parallel Interface Connector
This connector is for a standard Centronics parallel interface cable from the computer.
Connect this connector to the computer’s parallel port.

8  Option Interface Slot (Network/Serial)
This slot can be used to hold the optional network interface card, a hard disk or the
serial interface board kit. For details, see Appendix A Options.

1-8
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Chapter 2 Handling Paper

The printer can use a variety of media in various sizes. However, any media you will choose
to use with the printer must be in accordance with the guidelines and specifications in this
chapter. Use of paper not satisfying these guidelines and specifications may cause problems
such as frequent paper jams, poor quality printing, and possible damage to the printer
mechanism.

Even meeting the instructions provided in this chapter, special media such as transparencies,
labels, envelopes, non-standard-size paper must be fed directly from the printer’s MP
(multi-purpose) tray and delivered in the face-up tray in ‘straight path’ manner. For details
on use of MP tray, see Chapter 3 Using the Operator Panel, section 3.10.1 MP Tray Mode
on page 3-68.
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2.1
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21.2

General

The Ecosys Color FS-C5016N printer is designed for high-grade bond (copy) paper, like
those widely used for ordinary xerographic copiers. The printer will also support other types
of paper as long as they meet the standards explained in this chapter.

Selecting the right paper is very important. Use of unsuitable paper can cause paper jams,
misfeed, curling, poor print quality, and even worse, printer damage. This chapter shows
you how to use your printer in a way that will ensure efficient, error-free printing and
minimal printer damage. This practice will increase your office productivity.

Kyocera Mita will not be liable for any problems that may occur if you use
‘ ; paper that does not meet these standards.

Available paper types

The FS-C5016N printer can use almost any type of printer paper. This printer accepts paper
used for xerographic copiers as well.

Paper comes in three generic grades: economy, standard, and premium. The grades are
determined by how easily the paper can pass through the printer. This depends on the
smoothness, size, moisture content, and cutting of the paper. The higher the grade, the less
risk of problems (such as paper jams), and higher the print quality.

The differences in paper characteristics of different paper makers also affect the printer
performance. High-performance printer can produce high-quality results only when the
right types of paper are selected. Low-priced paper is not always economical, especially if it
ends up causing frequent printing problems.

Paper of the different grades is available in basis weights (explained later). The recommended
basis weights of paper for the printer are 16, 20, and 28 pounds. When expressed in grams per
square meter, the recommended basis weights range from 60 to 105 g/m?.

Paper specifications

Table 2-1 summarizes the basic paper specifications. Details are given on the subsequent
pages.

Item Values
Weight (basis weight) Cassette: 60 to 105 g/m? (16 to 28 Ib/ream)
MP tray: 60 to 200 g/m? (16 to 53 Ib/ream)
Thickness 0.086 t0 0.110 mm (3.4 to 4.3 mils)
Dimensions See Table 2-3.
Dimensional accuracy +0.7 mm (£0.0276 inches)
Squareness of corners 90+0.2°
Moisture content 4106 %
Table 2-1
2-2
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2.1 General

Item Values
Direction of grain Long grain
Pulp content 80 % or more

Table 2-1 (Continued)

21.3 Minimum and Maximum Paper Sizes

The minimum and maximum paper sizes are as follows. For non standard paper such as
cut-sheet, the MP (multi-purpose) tray must be used.

Paper cassette MP tray
A A A
Minimum 9 Minimum
Paper Size 5 Paper Size
] £
5 §2
£ Ps o &
Q N
f\_rl 5 I
© £
£ § <
N~ o~ |‘ ’l
N o <
” N = 7 cm
g2 2-13/16 inches
© £ —_
0O <
@ I< 14.8 cm »| Maximum
5-13/16 inches Paper Size
Maximum A4
Paper Size ¢
= 21.6 cm g
8-1/2 inches
vy
|« >
21.6 cm
8-1/2 inches

Figure 2-1

21.4 Recommended Paper

The following products are recommended for use with the printer for optimum performance.

Size Product Weight
Letter, Legal Hammermill LASER PRINT 90 g/m? (24 1b)
A4 NEUSIEDLER COLOR COPY 90 g/m?
Table 2-2

2-3
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2.2 Selecting the Right Paper

2.2 Selecting the Right Paper

Printer printing is a process involving light, electrostatic discharge, toner, and heat. In
addition, as the paper passes through the printer it undergoes considerable sliding, bending,
and twisting motions. A high-quality printing paper matching the printer's requirements
with-stands all these stresses, enabling the printer to turn out clean, crisp printed copy
consistently.

This section describes the major considerations for selecting the right printing paper.

2.2.1 Guidelines

Paper conditions

Do not use paper with folded edges, curls, warps, smudges, tears, or embossing. Also do
not use paper containing lint, clay, or paper debris. Using such paper may cause illegible
printing, misfeeds, paper jams, etc., and shorten the product life of the printer. Never use
paper with surface coating or other surface treatment. The paper surface should be as
smooth and even as possible.

Paper composition

Do not use paper with surface-coating or containing plastic or carbon. The heat of fusing
causes such paper to emit toxic fumes.

Bond paper should have at least an 80 % pulp content. The percentage of cotton and other
fibers should not exceed 20 %.

Paper sizes

Table 2-3 lists the standard paper sizes and dimensions. Note that certain paper sizes are
available only for MP tray feeding (as remarked) and face-up tray delivering. For details on
using MP tray, see Chapter 3 Using the Operator Panel, section 3.10.1 MP Tray Mode on
page 3-68.

The dimensional tolerances for these paper sizes are +0.7 mm (+0.0276 inches) for both
length and width of paper. The corner angles must be 90 +0.2°.

MP tray Size Cassette or Size

MP tray
Monarch 3-7/8 x 7-1/2 inches LegalT 8-1/2 x 14 inches
Business 4-1/8 x 9-1/2 inches Letter 8-1/2 x 11 inches
ISO A6 10.5x 14.8 cm ISO A4 21x29.7cm
ISODL 11 x22cm ISO A5 14.8x21 cm
Commercial 9 3-7/8 x 8-7/8 inches ISOC5 16.2x229cm
Commercial 6-3/4 3-5/8 x 6-1/2 inches ISO BS 17.6 x25cm
JISB6 12.8 x18.2cm JISBS 18.2x25.7cm
Statement 5-1/2 x 8-1/2 inches Executive 7-1/4 x 10-1/2 inches
Table 2-3
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2.2 Selecting the Right Paper

MP tray Size Cassette or Size
MP tray
Hagaki 10x14.8 cm Oficio I 8-1/2 x 13 inches
Ofuku-Hagaki 14.8 x20 cm Folio 21 x33cm
Youkei 2 11.4%x16.2cm 16 kai 19.7cm x27.3 cm
Youkei 4 10.5x23.5cm
Custom Cassette:
14.8t021.6cm x 21 t035.6 cm (5-13/16 to 8-1/2 inches x 8-1/4 to 14 inches)
MP tray:

7t021.6cm x 14.8t029.7 cm (2-13/16 to 8-1/2 inches x 5-13/16 to
11-11/16 inches)

Table 2-3 (Continued)

+  Only with the paper cassette feeding

2.2.2 Paper properties

Smoothness

Paper should have a smooth, uncoated surface. Paper with a rough or sandy surface can
cause gaps in printouts. However, paper with surfaces that are too smooth may cause
multiple-sheet feeding and fogging problems (fogging is a gray background effect).

Basis weights

Basis weight is the weight in pounds of 500 sheets (called a ream) of paper cut to the basic
size, which is 17 X 22 inches. The number of sheets in a ream and the basic paper size
relating to basis weights depend on paper classifications. In the metric system, the basis
weight is expressed in grams per square meter (g/m?).

Paper that is too heavy or too light may cause misfeeds, jams, and premature wear of printer
parts. Uneven weight of paper can cause multiple-sheet feeding, print defects, poor toner
fusing, blurring, and other print quality problems. The recommended basis weights for this
printer are between 60 and 105 g/m? (16 to 28 Ib per ream).

Paper Weight Equivalence Table

The paper weight is listed with expression in U.S. bond weight (Ib) and European metric
(g/m?). The shaded part indicates the standard weight.

U. S. Bond Weight (Ib) Europe Metric Weight (g/m?)

16 60
17 64
20 75
21 80
22 81
24 90
27 100
Table 2-4
2-5
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2.2 Selecting the Right Paper

U. S. Bond Weight (Ib) Europe Metric Weight (g/m?)

28 105
32 120
34 128
36 135
39 148
42 157
43 163
47 176
53 199

Table 2-4 (Continued)

Thickness (Caliper)

Thick paper is called high-caliper paper and thin paper is called low-caliper paper. Paper
used by the printer should be neither too thick nor too thin. If you encounter paper jam,
multiple-sheet feed, or too light printing problems, the paper may be too thin. If you
encounter paper jam or too heavy printing problems, the paper may be too thick. The
recommended thickness of a sheet for this printer is between 0.086 and 0.110 mm (from 3.4
to 4.3 mils).

Moisture content

Moisture content is the percentage of the weight of water in paper. Moisture affects the
appearance, feeding, curling, electrostatic properties, toner fusing of the paper.

The moisture content of paper varies with the relative humidity in the room. If the room is
too humid, paper will absorb more moisture. The edges will swell and the paper will
become wavy. If the room is too dry and the paper loses moisture, the edges shrink and
tighten, and the print contrast may be degraded.

Wavy or tight edges can cause paper misfeeds and misalignments. The recommended
moisture content is between 4 and 6 %.

To maintain the correct moisture content level, store the paper in an environment that allows
moisture control. These are tips for moisture control:

»  Store paper in a cool, dry place.

* Leave packages of paper wrapped as long as possible. Rewrap unused paper.

*  Return paper to its paper carton, whenever possible. Place the cartons on a pallet or
other furniture so that they are not in direct contact with the floor.

*  Before using paper stored for an extended period of time, condition it in the printer’s
environment for at least 48 hours.

* Do not expose paper to heat, direct sunlight, or damp.

Grain

Technically, grain is the direction of paper in the paper machine. Grain is parallel with the
direction of movement in the paper machine. Grain long means that the grain runs along the
length of the sheet, and grain short means that the grain runs along the width of the sheet.
Because grain short causes paper feed problems, always select grain long for the printer.

2-6
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2.2 Selecting the Right Paper

2.2.3 Other properties of paper

Porosity

The density of paper structure, which indicates the compactness of the fiber bonding. It is
also the characteristic that allows air to pass through paper (i.e., air permeability).

Stiffness

The ability of paper to resist deformation under stress. In the printer, limp paper can buckle
and too stiff paper can bind. Both conditions result in paper jams.

Curl

Most paper naturally tends to curl one way. To produce flat printouts, load the paper sheets
so that the upward pressure from the printer can correct their curling. When loading paper, it
is also important to distinguish between the front side and backside of the paper. Be sure to
follow the paper loading instructions printed on the paper carton.

Electrostatic discharge

During the printing process, paper is given an electrostatic charge to attract the toner.
Therefore, the paper must discharge the static electricity so that the printouts do not stick to
each other in the output tray.

Whiteness

The contrast of printed images depends on the whiteness of the paper. Whiter paper
produces sharper and clearer images.

Quality control

Uneven paper sizes, corners that are not square, jagged paper edges, irregularly cut sheets,
torn edges and corners, etc. can cause various printer troubles. Before purchasing paper, find
out whether the paper store always takes measures to prevent such problems in its products.

Packaging

Paper sheets should be shipped in strong cartons to protect them from damage during
transportation. Before purchasing paper, make sure the store ships its products in proper
packages.

2-7
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2.3 Loading Paper

2.3 Loading Paper

The following explains the procedure for loading paper in the cassette and the MP tray.

Fan the media (paper/transparencies), then tap it on a level surface to avoid
6 media jams or skewed printing.

\

S
\ g

Figure 2-2

2.3.1 Loading Paper into the Cassette
Perform the following procedure to load paper into the cassette.

1 Pull the paper cassette all the way out of the printer.

Paper Cassette

Figure 2-3

2-8
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2.3 Loading Paper

2 Push the bottom plate down until it locks.

N

=

-

Bottom Plate

ST

I
R T {\
0 )

E_/\_y

Figure 2-4

Standard paper sizes are attached to the inside of the paper cassette as shown in the
following figure.

[ LGL] AR B5][ As][ \J

—q
oo

LGL

Figure 2-5
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2.3 Loading Paper

Turn the paper size dial so that the size of the paper you are going to use appears in
the paper size window.

Paper Size Dial Paper Size Window

Figure 2-6

into the printer on the operator panel. See Chapter 3 Using the Operator

“Not Panel, section 3.10.4 Setting the Cassette Paper Size on page 3-72.
ote

0 When the paper size dial is set to OTHER the paper size must be set

4 Adjust the position of the paper guides located on the left and right sides of the paper

cassette. Pull the release lever on the left side guide and slide to the desired paper

size.
25‘5 2l =
— N
|l
t\ - -
J a [u]
| ]
0
Release Lever L j
! \
Paper Guides
Figure 2-7
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2.3 Loading Paper

5 Adjust the position of the paper stopper located at the rear of the paper cassette. Pull
the release lever and slide the paper stopper to the desired paper size. When shipped
from the factory, the paper cassette is set to A4 size.

When using non-standard size paper, move the paper guides and paper stopper all the
way out, insert the paper, then adjust the paper guides and paper stopper to the size of
the paper. Adjust them so that they are in light contact with the paper.

!

> Release Lever

Paper Stopper

Figure 2-8

6 Slide the paper into the paper cassette.

Figure 2-9

2-11
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2.3 Loading Paper

¢ Do not load more paper than will fit under the load limits on the
‘ i paper guides.

Note ¢ The paper cassette will hold approximately 500 sheets of paper
with a 80 g/m? (21 Ib.) basis weight, or with a thickness of 0.11

mm.
Load Limit Load Limit
— | —
N Y .
[\ 4
— ! —
/ ) —
W — =
O )|
=_ = /
Figure 2-10

7 Set the stack of paper so that it is under the clips as shown.

Figure 2-11
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2.3 Loading Paper

8 Insert the paper cassette into the slot in the printer. Push it straight in as far as it will
go.

Figure 2-12

There is a paper gauge on the right side of the front of the paper cassette to indicate
the remaining paper supply. When paper is exhausted, the pointer will go down to the

level of [L_] (empty).

=
L1
/]
@ ]l_— Paper Gauge

Figure 2-13
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2.3 Loading Paper

2.3.2 Loading Paper into the MP (Multi-Purpose) Tray

Perform the following procedure to load paper into the MP tray.

1 Pull the MP tray towards you until it stops.

Figure 2-14

2 Pull out the subtray.

Subtray

Figure 2-15

3 Adjust the position of the paper guides on the MP tray. Standard paper sizes are
attached to the MP tray. For standard paper sizes, slide the guides to the position
marked correspondingly.

Il5s IBs las

Paper Guide Paper Guide

Figure 2-16
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2.3 Loading Paper

4 Align the paper with the paper guides and insert as far as it will go.

Load Limit —— —— Load Limit

Figure 2-17

¢ Do not load more paper than will fit under the load limits on the inside of
‘ ? the MP tray.

Note e If the paper is considerably curled in one direction, for example, if the
paper is already printed on one side, try to roll the paper in the opposite
direction to counteract the curl. Printed sheets will then come out flat.

ﬁ

Collect =] S @

I=———| _.L =
Incollect =] (e :@/
__

=

|!E!| = ] ]

Set the MP tray paper size on the printer’s operator panel. Refer to Chapter 3 Using
the Operator Panel, section 3.10.2 Setting MP Tray Paper Size on page 3-69.
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2.4 Special Paper

24 Special Paper

Besides plain paper, this printer can use the following types of special paper:

Paper type to be used Paper type to be selected
Thin paper (60 to 64 g/m?) Vellum

Thick paper (90 to 200 g/m?) Thick

Colored paper Color

Recycled paper Recycle

Overhead projector transparencies Transparency

Postcards Cardstock
Envelopes Envelope
Label Labels
Table 2-5

You can assign one of these special paper type to a paper cassette or MP (multi-purpose)
tray by using the printer’s operator panel keys. Then, the printer can automatically select the
paper cassette or multi-purpose tray to feed the special paper from and internally adjust the
electrical parameters for optimum printing performance according to the special paper type.
For details, see Chapter 3 Using the Operator Panel, section 3.10.5 Setting the Cassette
Paper Type on page 3-76.

Note that some types of special paper do not allow feeding from the paper feeder cassette.

241 Selecting the Special Paper

Since special paper differs significantly in paper composition and quality, special paper is
more likely to cause problems than white bond paper during printing. When using special
paper, be sure that they are manufactured for photocopiers and/or page printers.

Before purchasing any special paper, make a test print using the printer and check whether
the results are satisfactory.

is caused by using special paper (e.g., fumes emitted from the special

g Kyocera Mita shall not be liable for any danger to a person or machine that
— paper).

Note

To avoid problems, stack transparencies, labels, postcards, envelopes, or thick paper on the
face-up tray (option).

Major considerations for each type of special paper are given below.
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2.4 Special Paper

Transparency

Transparencies for overhead projectors must withstand the heat of fusing during the printing
process. The recommended transparency product is as follows:

3M CG3700 (Letter, A4)

Transparencies must be placed on the MP (multi-purpose) tray with the long edge towards
the printer. To avoid problems, stack transparencies face up on the face-up tray.

MP Tray

Figure 2-18

When unloading transparencies (e.g., for clearing jams), hold them carefully by the edges to
avoid leaving fingerprints on them.

Adhesive-backed labels
Label paper must be fed manually.

For printing on labels, use extreme care so that the adhesive may not come in direct contact
with any part of the printer. Adhesives that stick to the drum or rollers will cause printer
damage.

Labels consist of three parts. Printing is done onto the top sheet (also called the face sheet).
The adhesive contains chemicals. The carrier sheet (also called the backing paper or liner)
bears the top sheet. This composition of labels can cause more problems than other print
forms during printing.

— Top sheet (white bond paper)

— Adhesive

— Carrier sheet

Figure 2-19

When using label paper, do not leave gaps between the arranged labels (i.e., top sheets).
Labels arranged with gaps in-between can easily be peeled off during printing, causing
serious jam problems.

2-17
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2.4 Special Paper

When the label paper has extra margin around the label’s outside edges that correspond to
the margins of the printable area, do not remove the extra top sheet from the carrier sheet
until printing is finished.

Allowed Not allowed

~&— Top sheet —‘

Carrier sheet —»

Figure 2-20

When selecting labels, make sure to use only those meeting the following requirements:

Item Value

Top sheet weight 44 to 74 g/m? (12 to 20 Ib)

Total weight 104 to 151 g/m? (28 to 40 1b)

Top sheet thickness 0.086t0 0.107 mm (3.9 to 4.2 mils)
Total thickness 0.115t0 0.145 mm (4.5 to 5.7 mils)
Moisture content 4 to 6 % (composite)

Table 2-6

Postcards

Fan the stack of postcards and align the edges before loading them in the MP tray. Make
sure the postcards you are going to set are not curled. Feeding curled postcards may cause
paper jams.

Some postcards have rough edges on the back (those are created when the paper is cut). In
this case, put the postcards on a flat place and rub the edges with, for example, a ruler to
smooth them.

!\,\,Q

Rough Edge

Rough Edge

Figure 2-21
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2.4 Special Paper

Envelopes

Envelopes should be fed in the face-up position, right edge first.

Figure 2-22

Since the composition of an envelope is more complex than that of ordinary paper, it is not
always possible to ensure consistent printing quality over the entire envelope surface.

Normally, envelopes have a diagonal grain direction. See section Grain on page 2-6. This
direction can easily cause wrinkles and creases when envelopes pass through the printer.
Before purchasing envelopes, make a test print to check whether the printer accepts the
envelope.

Other handling cautions follow:

* Do not use envelopes that have an encapsulated liquid adhesive.

* Avoid a long printing session for envelopes only. Extended envelope printing can cause
premature printer wear.

» If jams do tend to occur, try setting a lesser number of envelopes on the MP tray.

* To avoid jams caused by curled envelopes, stack the printed envelopes no higher than
10 on the output tray.

Thick Paper

Fan the stack of paper and align the edges before loading them in the MP tray. Some types
of paper have rough edges on the back (those are created when the paper is cut). In this case,
put the paper on a flat place and rub the edges once or twice with, for example, a ruler to
smooth them in the same way as described in Postcards on page 2-18. Feeding rough edged
paper may cause paper jams.

the MP tray with the leading edge raised up a few millimeters as shown in

p— the illustration.
Note

0 If the paper jams even after you smooth it out in such a way, set the paper in
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2.4 Special Paper

Colored paper

Colored paper should have the same specifications as the white bond paper listed. In
addition, the pigments in the paper must be able to withstand the heat of fusing during the
printing process (up to 200 °C or 392 °F).

Pre-printed paper

Pre-printed paper should basically be bond paper. The inks on the paper must be able to
withstand the heat of fusing during the printing process and must not be adversely affected
by silicon oil. Do not use paper with any kind of coating, such as calendar stock.

Recycled paper

Select recycled paper that has the same specifications as white bond paper. See Table 2-1 on
page 2-2. Recycled paper, however, does not have to be as white as white bond paper.

Before purchasing recycled paper, make a test using the printer and check
‘ ] whether the print quality is satisfactory.
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2.5

Paper Type

2.5 Paper Type

The printer is capable of printing under the optimum setting for the type of paper being

used.

Setting the paper type for the paper source from the printer’s operator panel will cause the
printer to automatically select the paper source and print in the mode best suited to that type

of paper.

A different paper type setting can be made for each paper source including the MP tray. Not
only can preset paper types be selected, but it is also possible for you to define and select
customized paper types. See Chapter 3 Using the Operator Panel, section 3.10.9 Creating

Custom Paper Type on page 3-81.
The following types of paper can be set.

Paper source
MP tray Paper Paper Duplex path
Cassette ~ Weight (MP tray available only in
Paper Type Cassette mode)
Plain Yes Yes Normal 2 Yes
Transparency Yes No Extra Heavy No
Preprinted Yes Yes Normal 2 Yes
Labels Yes No Heavy 1 No
Bond Yes Yes Normal 2 Yes
Recycled Yes Yes Normal 2 Yes
Vellum Yes No Light No
Rough Yes Yes Normal 2 Yes
Letterhead Yes Yes Normal 2 Yes
Color Yes Yes Normal 2 Yes
Prepunched Yes Yes Normal 2 Yes
Envelope Yes No Heavy 1 No
Cardstock Yes No Heavy 2 No
Coated Yes No Normal 2 No
Thick Yes No Heavy 1 No
High quality Yes Yes Normal 2 Yes
Custom 1 (to 8)T Yes Yes Normal 2 Yes

Table 2-7

Yes: Canbe stored No: Cannot be stored

+  This is a paper type defined and registered by the user. Up to eight types of user settings may be
defined. For details on Chapter 3 Using the Operator Panel, section 3.10.9 Creating Custom Pa-

per Type on page 3-81.
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Chapter 3 Using the Operator Panel

This chapter provides the information you need to configure the Ecosys Color printer. In
general you need to use the operator panel only to make default settings. You can make most
changes to the printer settings using the printer driver trough the application software.

Changes to printer settings made using a software application override
‘ ? changes made using the operator panel.

Note

You can also rely on other printer utilities such as Kyocera Mita PrintMonitor if you need to
change settings that are not available on the printer driver. It will allow you remotely access
to printer settings. Printer utilities are supplied in the CD-ROM supplied with the printer.

The chapter describes the operator panel in detail, including its menus and the procedures
for changing various printer settings.
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3.1 Understanding the Operator Panel

3.1 Understanding the Operator Panel

The operator panel on the top of the printer has a 2-line by 16-character liquid crystal
display (LCD), eight keys, and three indicators (LED).

MENU CANCEL

(=]
=2 DATA

INTERFACE  SIZE

[==]
(O READY

[}
L ATTENTION

Figure 3-1

Messages that appear on the display and functions of indicators and keys are explained in

the sections that follow.

3.1.1 Message Display

The message display on the operator panel shows:

»  Status information, the ten messages listed below which are displayed during normal

operation.

»  Error codes, when the printer requires the operator’s attention; as explained in

Chapter 4 Troubleshooting.

Status Information

Message

Meaning

Self test

The printer is performing self-diagnostics after power-up.

Please wait

The printer is warming up and is not ready.

When the printer is switched on for the first time, this message
will take several minutes.

Please wait
(Adding toner)

Toner is currently being replenished. This message may be dis-
played during continuous printing of a large volume of pages
which require a large amount of toner such as with photographs,
etc.

Please wait
(Calibrating)

The color calibration function is being performed automatically
as you powered on the printer.

You can also execute this function manually on the operator
panel. For details, see section 3.13.13 Color Calibration on page
3-104.

Ready

The printer is ready to print.

Processing

The printer is receiving data to print. This is also shown when the
printer is reading a memory card, hard disk or RAM disk.

Table 3-1
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3.1 Understanding the Operator Panel

Message

Meaning

Sleeping

The printer is in sleep mode. The printer wakes from sleep mode
whenever a key on the operator panel is pressed, the cover is
opened or closed, or a print job is received. The printer then
warms up and goes on-line. For details on sleep mode, see Sleep
Timer Timeout Time on page 3-92.

Cancelling data

Jobs inside the printer are being canceled. To cancel a job, see sec-
tion 3.1.3 Keys on page 3-6.

Waiting

The printer is waiting for the rest of print job before completing
the last page. Pressing the GO key allows you to obtain the last
page immediately. See below.

FormFeed TimeOut

The printer is printing the last page after a waiting period.

Table 3-1 (Continued)

Error codes

See Chapter 4 Troubleshooting.

3.1.2 Indicators in Message Display

Figure 3-2

o
Ready (QREADY
o
PAR A4 PLAIN | o O3
INTERFACE  SIZE TYPE =]
= h O I aTTENTION

Interface Indicator (INTERFACE)

The interface indicator shows the interface that is currently in use:

PAR
usB
SER
NET
OPT

Parallel interface is in use.

USB interface is in use.

Serial (RS-232C) interface is in use. (option)

Network interface is in use.

Network interface is in use. (option)

No interface is in use.

Each interface has a timeout time of 30 seconds during which the other interface should wait
to receive a print job. Even a print job has been complete on the interface, you should wait
for this period until the other interface begins printing the job.

3-3
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3.1 Understanding the Operator Panel

Paper Size Indicator (SIZE)

This indicator indicates:

*  While the printer is in standby, the paper size of the current cassette. The default paper
cassette is determined by the operator panel keys. For details, see section 3.10 Paper
Handling on page 3-68.

*  While the printer is printing, the paper size used to format the document to print by the
application software.

The abbreviations used to indicate the paper sizes and their dimensions are as follows:

Ad ISO A4 (21 x29.7 cm)

A5 ISO A5 (14.8 x 21 cm)

A6 ISO A6 (10.5 x 14.8 cm)’

BS JISBS5 (18.2 x 25.6 cm)

B6 JISB6 (12.8 x 18.2 cm)’

LT Letter (8-1/2 x 11 inches)

LG Legal (8-1/2 x 14 inches)

MO Monarch (3-7/8 x 7-1/2 inches)Jr

BU Business (4-1/8 inches)Jr

DL ISODL (11 x 22 cm)’

C5 ISOC5(16.2 x22.9 cm)

b5 ISOB5(17.6 x 25 cm)

EX Executive (7-1/4 x 10-1/2 inches)

#6 Commercial 6-3/4 (3-5/8 x 6-1/2 inches)T
#9 Commercial 9 (3-7/8 x 8-7/8 inches)Jr
HA Japanese Postcard (10 x 14.8 cm)*
OH Return Postcard (20 x 14.8 cm)T

02 Oficio IT (8-1/2 x 13 inches)

16K 16 kai (19.7 x 27.3 cm)

ST Statement (5-1/2 x 8-1/2 inches)*

FO Folio (21 x 33 cm)

Y2 Yokei2 (11.4 % 16.2 cm)'

Y4 Yokei 4 (10.5 x 23.5 cm)'

CU Custom Size (14.8 x 21 cmto 21.6 x 35.6 cm)

i Only with MP tray feeding

3-4
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3.1 Understanding the Operator Panel

Paper Type Indicator (TYPE)

This indicator shows the paper type defined for the current paper casette. The paper type can
be manually defined using the operator panel. For more information, see section 3.10 Paper
Handling on page 3-68.

The following abbreviations are used:

(none) Auto LETTERHEA Letterhead

PLAIN Plain paper COLOR Colored paper

TRNSPRNCY TransparencyT PREPUNCH Pre-punched paper

PREPRINTE Pre-printed paper ENVELOPE EnvelopeT

LABELS Labels’ CARDSTOCK Card stock"

BOND Bond paper COATED Coated paperJr

RECYCLED  Recycled paper THICK Thick paperJr

VELLUM Vellum® HIGH QUAL High-quality paper for color printing
ROUGH Rough paper CUSTOML (to8) Custom 1 (to8)

+  Only with MP tray feeding

READY, DATA, and ATTENTION Indicators

The following indicators light during normal operation and whenever the printer needs
operator’s attention. Depending on the status of lighting, each indicator has the following
meaning:

Indicator Description
— Flashing. Indicates an error that you can recover by yourself, such as
O READY the loose top cover. For details, see Chapter 4 Troubleshooting, section

4.3 Error Messages on page 4-7.

On. Indicates that the printer is ready and on-line. The printer prints the
data it receives.

Off. Indicates that the printer is off-line. Data can be received but will
not be printed until the printer is on-line by pressing the GO key. Also,
indicates when printing is automatically stopped due to the occurrence
ofanerror. For details see Chapter 4 Troubleshooting, section 4.3 Error
Messages on page 4-7.

(. Flashing. Indicates that a data is being received from the computer.
"@l DATA On. Indicates either that data received is being processed before print-
ing starts, or that data received is being written to a memory card, hard
disk or RAM disk.
= Flashing. Indicates that the printer requires maintenance or is warm-
| ATTENTION ing up.

On. Indicates the occurrence of a problem or an error. For details, see
Chapter 4 Troubleshooting, section 4.3 Error Messages on page 4-7.

Table 3-2

3-5

Download from Www.Somanuals.com. All Manuals Search And Download.



3.1 Understanding the Operator Panel

3.1.3

Keys

The operator panel keys are used to configure the printer operation. Note that certain keys
have the secondary function.

Configuration to the printer settings made with these keys affect only one of

a The printer has a parallel, serial, and an optional network interface.
— these interfaces that is currently active (indicated by the INTERFACE

Note indicator on the message display). See Interface Indicator (INTERFACE) on
page 3-3.
GO Key
GO

The GO key switches the printer between on-line and off-line. Use this key to:

» Toggle the printer’s on-line and off-line states. You can temporarily stop the print job by switching
the printer off-line.

* Print and feed out one page when the printer displays Waiting.

» Recover from certain errors.

* Recover from the Sleep mode.

CANCEL Key
CANCEL

O

This key is used to:

* Cancel a printing job.
+ Stop the alarm sound.
» Reset numeric values or cancels a setting procedure while using menu system.

To cancel a printing job:

1 While the printer displays Processing, press the CANCEL key.

Print Cancel? appears on the message display followed by the interface which
the job to cancel is on. The interface is indicated by one of the following message:

Parallel

USB

Network

Serial (option serial interface)
Option (option network interface)

2 Press the ENTER key. Cancelling data appears on the message display and
printing stops after the current page is printed.

3-6
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3.1 Understanding the Operator Panel

MENU Key
MENU

O

The MENU key lets you enter the menu system to change the setup and printing
environment of the printer.

Pressing this key during a menu selection will terminate the selection and return the printer
to the normal operation.

Arrow Keys

®
®_®s
®

The four arrow keys are used in the menu system to access a desired item or enter numeric
values.

The arrow key with the question mark (@) may be pressed when the paper jam message has
appeared on the message display. Then a help message will appear to facilitate jam clearing
in the location.

ENTER Key

O

ENTER
This key is used to:

+ Finalize settings of numeric values and other selections.
+  Set the paper source when Use alternative? isshown in the message display.

shown on this printer, the AdministrationID menu will be displayed. This
menu is the setting menu for administration under the Account Management
System and is normally not used. Press the MENU key to return to the
Ready display.

0 If you hold down the ENTER key and press the MENU key when Ready is

Note
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3.2 Using the Menu Selection System

3.2 Using the Menu Selection System

3.21 Menu Selection System

This section explains how to use the menu selection system. The MENU key on the operator
panel allows you to use the menu to set or change the printer environment such as the
number of copies to print, emulation, etc., to your specific needs. Settings can be made

when Ready is indicated on the printer message display.

The printer obeys the most recently received printer settings sent from the application
software, or from the printer driver, which take priority over operator panel settings.

Entering the Mode Selection Menu

Press the MENU key when Ready is indicated on the printer message display.

The mode selection menu is displayed.

Ready
PAR A4 PLAIN

‘ f Press O key.

Mode Selection Menu

Press key.
ENTER

A | Print |
V |_Menu Map Press Ig% key.
A | Print
Press
V |_Status Page O key.
| | ENTER
[ ] |
- > | A
% ’ Paper Handling > M >M(P3a§£&el¥tl\e40de h
<V [ Firs.t
|
A’ >Type Adjust > > >>Paper Weight
I \V4 = < Normal 1
! =
| I [ ]

|

‘ Press O key.
ENTER

Sub-menu —
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3.2 Using the Menu Selection System

Selecting a Menu
The mode selection menu is hierarchical. Press the A or V key to display the desired menu.

» If the selected menu has a sub-menu, > is displayed after the menu.

Paper Handling >

Indicates that there is a sub-menu

Press the > key to move to the sub-menu or <] key to go back.

* > isdisplayed before the sub-menu.

Indicates that this is the sub-menu

T
>Type Adjust > |

Indicates that there is another sub-menu

Press the > key to move to another sub-menu or <[ key to go back.

* >>isdisplayed before the second sub-menu.

Indicates that this is the second sub-menu

PR

.'>>‘,Paper Weight

‘Normal 1

Setting a Menu
Select the desired menu and press the ENTER key to set or change the configuration.

Press the A or V key to display the desired item and the ENTER key to finalize the value
or selections set.

Cancelling Menu Selection

If you press the MENU key when selecting a menu, the message display returns to Ready.

Settings that are received from application software and the printer driver
‘ i will take priority over settings made in the operator panel.

Note
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3.2 Using the Menu Selection System

3.2.2 Menu System Road Map

The following is the hierarchy diagram of the menu selection system of the printer.

For details about menu selection operations, see page 3-8.

Ready
PAR A4 PLAIN

MENU Key
Print
Menu Map
Print
Status Page

e-MPS >H>Quick Copy '|-|

>Private/Stored

| |
>Print VMB Data

>List of VMB

| |
>List of
Code JOB

|
>e-MPS > >>Quick Copy
Configuration 32
|

>>Temp. Code JOB
Size 1550MB
|

>>Perm. Code JOB
Size 1550MB

>>VMB Size
1550MB

Continued on the next page
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Continued

Interface >
Parallel
Interrace

| USB
|interrace

Network
|Lnterrace

Serial
Tnterrace
Option

Emulation
PCL 6
Fmulation
KPDL
Emulation
KPDL (AUTO)

Continued on the next page

3.2 Using the Menu Selection System

>Parallel I/F

Nibble (high) n
II
>NetWare
Off
NetWare >>NetWare Frame
| on Auto
| =
>TCP/IP
Off
TCP/IP >>DHCP
| On Off
| On
>EtherTalk |
Off >>IP Address
| On 000.000.000.000
|
>Network Status |_ >>Subnet Mask
Page Off 000.000.000.000
| Page Oon
>>Gateway
000.000.000.000
>Baud Rate
9600
II
||
>Data Bits
8
||
>Stop Bits
1
||
>Parity
None
|
>Protocol
DTR (pos.) &XON
II
>NetWare
Off
NetWare >>NetWare Frame
| Oon Auto
II
>TCP/IP
Off
TCP/IP >>DHCP
| On Off
|| | ©On
>EtherTalk
Off >>TIP Address
| ©On 000.000.000.000
>0Opt. StatusPage| >>Subnet Mask
On 000.000.000.000
| Off

>Print KPDL errs
Off

| ©On

>>Gateway
000.000.000.000

>Alt.
PCL 6

Emulation

>Print KPDL errs
Off

| ©On
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3.2 Using the Menu Selection System

Continued

>| 4>Copies

>Orientation

Portrait

Landscape

>Page Protect
Auto

Oon

>LF Action

LEF only

>CR Action

CR only

>Wide A4

Off

On

Print Quality

> >Gloss Mode
Low

High

Opt. ROM >HRead Data
>List of

Partitions

Hard Disk > >Read Data

RAM Disk Mode
Off

>Write Data |

>Delete Data |

>Format

>List of
Partition

REM
Oon

Disk Mode

>RAM Disk Size |

>Read Data |

>Write Data |

>Delete Data

>List of
Partition

Memory Card

>Read Fonts |

Continued on the next page

>Write Data |

>Write Data |

>Delete Data

>Format

>List of
Partition

Font > >Font Select > >> I000
Internal
| Font select | |
Option >>Courier
| | Regular
>Code Set [ Dark
IBM PC-8
T I >>Letter Gothic
>List of Regular
Internal Fonts [ Dark
>List of >>Size .
Option Fonts 012.00 f@lnt(s)
>>Pitch
10.00 cpi
Page Set
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3-12




3.2 Using the Menu Selection System

Continued

Paper Handling > >MP Tray Mode
Cassette

| First

>MP Tray Size
A4

>MP Tray Type
Plain

>Cassette Size
A4

>>Unit
mm

| inch

[ Custom

>Cassette Type
Plain

>>X Dimension
216 mm
|

>>Y Dimension
356 mm

||
>Feed Select
Cassette
|
>Duplex Mode
None

I—" = L= :i?:f — = L1
v

| |
>Stack Select |
Face-down tray

| Face-up tray

>Override A4/LT
Off

| On

>Type Adjust > >>Paper Weight
Custom 1 Normal 1

| |
>Reset Type >>Duplex Path
Adjust Enable
| Disable

Color Mode
Color

Monochrome

Life Counters > >Total Print
0123456
||

>New Toner [C]
Installed
| |

>New Toner [M]
Installed

>New Toner [Y]
Installed
|

>New Toner [K]
Installed

Continued on the next page
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3.2 Using the Menu Selection System

Continued

Others

—

>MSG Language
English

>Form Feed
Time Out 030sec

>Sleep Timer
015 min

e

>>Sleep Mode
On

>Print HEX-DUMP

>Printer Reset

>Resource Prot.
Off

>Buzzer
Oon

[ ot

>Auto Continue
Mode Off

[ ozt

Auto Contlinue

e

>>Auto Continue

Mode On Timer 030sec.
>Finishing > >>Duplex
Error Off
| _©On
>Color >>Print

Registration

—

Regist Chart

>>Adjust
L= H=

Cyan
R=

>>Adjust Magenta
L= H= R=

>>Adjust
L= H=

Yellow
R:

>Service

—

>>Print Status
Page

>>Color
Calibration

>>Print
Test Page

>>Maintenance

>>Drum
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3.3 Menu Map and Status Pages

3.3 Menu Map and Status Pages

This section explains the procedure for printing the printer’s internal information using the
menu selection system. The menu map is usefull as a reference to guide yourself through the
menu selection system.

The status page is a list of parameters and settings for most basic printer configurations. You
may be required to produce a status page when requesting service to the printer.

3.3.1  Printing a Menu Map

The printer prints a full list of menu selection system — Menu Map. Note that menus shown
in the list may vary depending on which optional units installed in the printer.

1 Press the MENU key.

2 Press the A or V key repeatedly until Print Menu Map appears.

Print
Menu Map

3 Press the ENTER key. A question mark (?) appears.

Print
Menu Map ?

4 Press the ENTER key. The message Processing appears and the printer prints a
Menu Map.

3-15
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3.3 Menu Map and Status Pages

(3 KYOCERE
~Jmita_ Ecosrs\ rs.cso16n Page Printer

Figure 3-3
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3.3 Menu Map and Status Pages

3.3.2 Printing a Status Page

You can check the printer’s current status, including available memory space and option
settings by printing a status page.

1 Press the MENU key.

2 Press the A or V key repeatedly until Print Status Page appears.

Print
Status Page

3 Press the ENTER key. A question mark (?) appears.

Print
Status Page ?

4 Press the ENTER key again. The message Processing appears and the printer
prints a status page.

For a sample status page and its full description, see Understanding the Status Page
on page 3-18.
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3.3 Menu Map and Status Pages

Understanding the Status Page

The numbers in the following diagram refer the items explained below the diagram. The
items and values on the status page may vary depending on the printer’s firmware version.

o KYOCERA
i
—_— Ecosrs*) rs.csoisn Page Printer

STATUS PAGE

Firmware version. Relcased: L 1
Hardware Information N ( Memory )
Page Information Installed Options 5
J/
~
Network Status 7
|\ J
(I 8
\_. <Z
4 \
J Consumable Status
———
|\ J

Figure 3-4

1 Software Version

This item shows the version and release date of the printer firmware.

2  Hardware Information
This item shows various printer settings for hardware-related items:

e MP tray paper size and type
*  Paper cassette size and type
*  Buzzer control

*  Host buffer size

e Sleep time timeout time

*  Formfeed timeout time

3-18
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3.3 Menu Map and Status Pages

3 Memory
This item shows:

*  Standard memory in the printer (96 MB)

*  Option memory slot status (Slots 1 and 2) in megabytes
*  Total memory in the printer

*  Current status of the RAM disk

4 Page Information
This item shows the page related items:

e Number of copies, from 1 to 999
*  Total page count

5 Installed Options
This item shows the options installed in the printer:

*  Hard disk
*  Option ROM
*  Memory card

6 Network Status
This item shows the IP address, subnet mask address, and default gateway address for
the network interface card in the printer.

7  Emulation

This item shows all available emulations of the printer. The PCL 6 emulation is set as
default when the printer is shipped from the factory. The emulations are:

« PCL6
« KPDL3
8 ErrorLog

This item shows the last three instances of the following types of errors, listing them in
the order of occurrence:

*  KPDL (PostScript) errors
*  Memory overflow

*  Print overrun

*  File-not-found

The most recent error is displayed on the topmost line of Error Log. Error information
is cleared when the printer is powered off.

The error log information is intended for service purpose.

9 Consumable Status
This item shows the approximate level of remaining toner. When the value is 100, the
toner container is full. The closer to 0, the smaller the amount of remaining toner.

10 Interface Information

This information shows the emulation and the default font for all interfaces installed in
the printer.
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3.4 e-MPS

3.4

e-MPS

e-MPS is an abbreviation for ‘enhanced-Multiple Printing System’” which implements the
following functions that are available from the printer driver:

» Job Retention

+ Job Storage

In either job mode, when printing a document, the print data is transferred from the
computer to the printer then stored on the printer’s hard disk. Since copies of the document
are printed using the stored data, printing is performed faster with less computer spooling
time and less network traffic.

To use the e-MPS system, an optional hard disk must be installed in the
printer. For details, see Appendix A Options.

The RAM disk may also be used in the Proof-and-Hold and Private Print

modes. See Using the RAM Disk on page 3-66 for details on RAM disk
setup.

Job Retention

Job Retention has four modes as summarized below. These modes are selected when you
choose on the printer driver through the application software:

Quick Copy Proof-and-Hold Private Print Stored Job
Primary function  To later print addi- To proofthe first ~ To hold the docu-  To electronically
tional copies copy before print- mentin printerto  store documents
ing multiple copies prevent unautho-  such as fax cover
rized access pages
Start storing by Printer driver Printer driver Printer driver Printer driver

On terminating

Prints simulta-

Prints one copy

Does not print

Does not print

print setting from  neously simultaneously
application soft-
ware
Retrieved by Operator panel Operator panel Operator panel Operator panel
Default number of Same as storing One less Same as storing One
copies printed at (canbe changed) (canbechanged) (canbechanged) (canbe changed)
retrieval
Maximum number 32, expandableto 32, expandableto Depends on the Depends on the
of jobs stored 50 50 hard disk capacity hard disk capacity
(Private jobs are
deleted automati-
cally once it is
retrieved.)
PIN security No No Yes Yes (if necessary)
Data after printing  Stored Stored Deleted Stored
Data at power off  Deleted Deleted Deleted Stored
Hard disk required Yes No No Yes
Table 3-3

T Jobs in excess will cause the earlier ones to be deleted.
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3.4 e-MPS

Job Storage

Job storage stores print jobs either temporarily or permanently, or in virtual mailboxes, as
you click an appropriate radio button on the printer driver when printing from a computer.

Virtual Mailbox

Virtual mailbox is part of Job Storage, which stores print jobs on the hard disk without
printing. It enables you to retrieve jobs later from the operator panel or the KM-NET
Printer Disk Manager utility in the CD-ROM.

Each mailbox may be used by an individual who desires to share the printer in this mode.
By default, each mailbox is numbered from ‘Tray 001,” ‘Tray 002,” ... etc. To “post’ a job in
one of these mailboxes, you assign a numbered or named mailbox on the printer driver
when printing.

To retrieve the stored job for printing, see Retrieving Jobs from Virtual Mailbox (VMB) on
page 3-28.

0 The virtual mailbox can be used in PCL 6 emulation only.

Note

3.41 Using Quick Copy

This mode enables you to print the requested number of copies of a job, simultaneously
storing the job on the hard disk. When additional copies are required, you can reprint the
required number of copies from the printer operator panel. To print a job as a quick copy
job, see KX Printer Drivers Operation Guide.

The default number of print jobs that can be stored on the hard disk is 32. This value can be
increased to up to 50 from the e-MPS Configuration menu. For details, see Changing the
Maximum Number of Quick Copy/Proof-and-Hold Jobs on page 3-30. When the number of
jobs reaches the limit, the oldest job will be overwritten by the new one.

When the printer is turned off, all stored jobs will be deleted.
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3.4 e-MPS

Printing Additional Copies using Quick Copy

To print additional copies of a job stored in the printer:

1
2

H W

o ®

10

Press the MENU key.

Press the A or V key repeatedly until e-MPS > appears.

e-MPS >

Press the D> key.

Press the A or V key repeatedly until >Quick Copy appears followed by the user
name (Harold, in this example). The user name is assigned at printing using the
printer driver.

>Quick Copy
Harold

Press the ENTER key. A blinking question mark (?) appears before the user name.

fguick Copy

?Harold
/|\

Press the A or V key to display the desired user name, Arlen, in this example.

>Quick Copy
?Arlen

Press the ENTER key. The job name entered in the printer driver (Report, in this
example) appear with a blinking question mark (?) before the letters.

fArlen
A\,

?Report
1S

Press the A or V key to scroll to the desired job title.

Press the ENTER key. The number of copies to be printed can be set. To increase the
copy count, press the A key; to decrease the copy count, press the V key.

>Report

|
Copies 0017
1N

Press the ENTER key to finalize the copy count. The printer prints the specified
number of copies for the job.
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3.4 e-MPS

Deleting a Quick Copy Job
All quick copy jobs are automatically deleted when the printer is turned off. If you desire to

explicitly delete a stored quick copy job, proceed as follows:

1 Follow steps 1 through 8 in the above section to let the title of the job to be deleted
displayed.

2 When the title of the job to be deleted is displayed, e.g. Report, below, press the
ENTER key. The cursor below the copy count starts to blink.

>Report
. N
Copies 001
VY

3 Press the V key repeatedly until De lete appears below the title.

>Report

1
Delete N

™

4 Press the ENTER key. The stored quick copy job is deleted.

3.4.2 Using Proof-and-Hold

When you print multiple copies, this mode first prints one copy so that you can proof it
before continuing to print the remaining copies. Since you can proof the printouts before
printing the remaining copies, wastage of paper can be reduced.

The printer prints one copy and, at the same time, saves the print job on the hard disk/ RAM
disk. You can also change the number of copies when resuming printing from the operator
panel.

When the printer is turned off, all stored jobs will be deleted.

Printing Remaining Copies of a Proof and Hold Job

Printing a Proof-and-Hold job on the operator panel is similar to printing a quick copy job.
See Printing Additional Copies using Quick Copy on page Chapter 3-22.
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3.4 e-MPS

3.4.3 Printing a Private Print/Stored Job

In private printing, you can specify that a job is not printed until you release the job from the
operator panel. At sending the job from the application software, you can specify a 4-digit
access code in the printer driver. The job is released for printing by entering the access code
on the operator panel. Thus, this function ensures confidentiality of the print job.

In the stored job mode, access codes are not mandatory, but can be set on the printer driver if
printing with the PIN security is required. Then, the access code must be entered on the
operator panel to print a stored job. Print data will be stored in the hard disk after printing.
See KX Printer Drivers Operation Guide for the driver settings.

Releasing a Private/Stored Job

1 Press the MENU key.

2 Press the A or V key repeatedly until e-MPS > appears.

e-MPS >

Press the [> key.

(7

Press the A or V key repeatedly until >Private/Stored appears. The name
entered in the printer driver (Harold, in this example) also appears.

i

>Private/Stored
Harold

5 Press the ENTER key. A blinking question mark (?) appears before the user name.

?frivate/Stored
\

?Harold

/l\

6 Press the A or V key to display the desired user name (Arlen, in this example).

>Private/Stored
?Arlen

7 Press the ENTER key. The user name and the job name (Agenda, in this example)
entered in the printer driver appear with a blinking question mark (?).

\f,Arlen

?
,I.\Agenda

8 Press the A or V key to display the desired job title.
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3.4 e-MPS

9 Press the ENTER key. The ID input line appears. Enter the four-digit access code
entered in the printer driver and press the ENTER key.

>Agenda
ID 000b
N

To enter the ID, press the <] or I> key to move the cursor to the number to be
changed and then enter the correct number by pressing the A or V key.

10 You can set the number of copies to be printed. To increase the copy count, press the
A\ key; to decrease the copy count, press the V key.

>Agenda

|
Copies 0017
71N

1 1 Press the ENTER key to finalize the copy count. The printer prints the specified
number of copies for the job.

Deleting a Private/Stored Job

You can individually delete stored jobs by performing the following procedure. Jobs saved
using Private Print will be automatically deleted if you turn the power off after printing, but
jobs saved using Stored Job will not be deleted automatically.

1 Follow steps 1 through 8 in the above section.

2 When the title of the job to be printed is displayed (Agenda, in this example), press
the ENTER key. Enter the four-digit access code entered in the printer driver and

press the ENTER key.
>Agenda
. 1,
Copies 001
1>

3 Press the V key repeatedly until Delete appears for the number of copies.

>Agenda

1
Delete i

D

4 Press the ENTER key. The private job is deleted from the hard disk.
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Printing a Code Job

Install the KM-NET Job Manager software from the CD-ROM supplied with the printer. To
do this, from the CD-ROM Main Menu, sclect Printer Utilities > Install KM-NET Job
Manager.

1 Browse through Windows Start > Programs > KYOCERA MITA > KM-Net >
Job Manager.

2 Enter the password for the software. Job Manager will start.

3 Click the Add printer icon (below). Select the Local or Network port.

that the printer driver is set to print to a local port. To check this out,
click the Details tab of the printer Properties, and note the Print to the
following port setting.

g If you use the local parallel port to connect to the printer, make sure

[S=ES]

Add printer
icon

G Ry

4 Follow the wizard until the Select printer dialog box is reached. When the printer
is found in the Printer List, click (highlight) it, then Finish.

5 Double click Model Name on the list. The jobs currently stored in the printer are
shown. To print the job, right click Job name and then click Print on the drop
down list that appears.

It is possible to select more than one job at a time by left clicking a job one by one
while pressing the Ctrl key on the computer keyboard.

i KM-NET Job Manager, EEx
Fle View Prner Ops Help
& .

=k a
@) o /308 205 J

108 203

< 3|« >
G Ry

The job remains intact even after printing. To permanently delete the job in the hard disk,
right click the job name on Job Manager, then click Delete on the drop down list that
appears.
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Printing a List of Code Jobs

If you select Permanent Job Storage on the printer driver, you can have a List of Code Job
printed using the operator panel.

1 Press the MENU key.

2 Press the A or V key repeatedly until e-MPS > appears.

e-MPS >

Press the > key.

()

Press the A or V key repeatedly until >List of Code JOB appears.

H

>List of
Code JOB

5 Press the ENTER key. A question mark (?) appears.

>List of
Code JOB ?

6 Press the ENTER key again. The printer prints a Code Job list as shown in
Figure 3-5 below.

03 KYOCERT /\
Jmita_ ECOS}S FS-C5016N Page Printer

Figure 3-5
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3.44 Retrieving Jobs from Virtual Mailbox (VMB)

To retrieve the jobs posted in the virtual mailbox, proceed as follows.

1 Press the MENU key.

2 Press the A or V key repeatedly until e-MPS > appears.

e—-MPS >

Press the [> key.

(%)

Press the A or V key repeatedly until >Print VMB Data appears. The virtual
mailbox number will also appear.

B

>Print VMB Data
Tray001:

If you have named the virtual mailbox with an alias on the printer driver, the alias
(Richard, in this example) will follow the number:

>Print VMB Data
Tray00l:Richard

5 Press the ENTER key. A blinking question mark (?) appears.

>Print YMB Data
TrayOOl°Rlchard

6 Press the ENTER key. The document in the mailbox is printed and automatically
deleted from the mailbox.

Printing a List of VMB

A Virtual Mailbox list includes the jobs currently stored in the mailboxes.

1 Press the MENU key.

2 Press the A or V key repeatedly until e-MPS > appears.

e-MPS >

3 Pressthe > key.
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3.4 e-MPS

4 Press the A or V key repeatedly until >List of VMB appears.

>List of VMB

5 Press the ENTER key. A question mark (?) appears.

>List of VMB ?

6 Press the ENTER key again. The printer prints a list of jobs currently posted in the
virtual mailboxes as shown in Figure 3-6 below.

03 KYOCERT /\
Jmita_ ECasts FS-C5016N Page Printer

VIRTUAL MAIL BOX LIST

Figure 3-6
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3.4 e-MPS

3.4.5 Changing e-MPS Configuration

You can change the following parameters for e-MPS operation:

*  Maximum number of Quick Copy/Proof-and-Hold jobs
*  Maximum space assigned to temporary code jobs

*  Maximum space assigned to permanent code jobs

+  Maximum space assigned to virtual mailboxes

The total amount of storage areas specified must not exceed the total size of
‘ i the hard disk. Otherwise, you may only be able to accommodate print jobs

T of a smaller amount of print jobs than specified.
ote

Changing the Maximum Number of Quick Copy/Proof-and-Hold Jobs

This changes maximum number of Quick Copy/Proof-and-Hold jobs from 0 to 50. The
default is 32.

1 Press the MENU key.

2 Press the A or V key repeatedly until e-MPS > appears.

e—-MPS >

Press the D> key.

(%)

Press the A or V key repeatedly until >e-MPS Configuration > appears.

B

>e-MPS >
Configuration

Press the D> key.

G

Press the A or V key repeatedly until >>Quick Copy appears.

>>Quick Copy
32

7 Press the ENTER key. A blinking cursor (_) appears.

>>Quick Copy
3%

T

8 Press the A or V key to increase or decrease the value at the blinking cursor. The
value can be set between 0 and 50. Use the [> and < keys to move the cursor right
and left.

9 When the desired maximum number of jobs is set, press the ENTER key.
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3.4 e-MPS

10 Press the MENU key. The display returns to Ready.

Maximum Space Assigned to Temporary Code Jobs

This changes the hard disk space that holds temporary code jobs. You can change the
maximum space from 0 to 9999 (megabytes). The actual maximum size depends on the size
of free hard disk space, however. The default size is 1/6 of the total hard disk space, rounded
off in unit of 50 MB. For example, if the total hard disk space is 10 GB, the default size is
1550 MB.

1
2

h @

o O

Press the MENU key.

Press the A or V key repeatedly until e-MPS > appears.

e—-MPS >

Press the > key.

Press the A or V key repeatedly until >e-MPS Configuration > appears.

>e-MPS >
Configuration

Press the > key.

Press the A or V key repeatedly until >>Temp. Code JOB Size appears.

>>Temp. Code JOB
Size 1550MB

To change the maximum disk space, press the ENTER key. A blinking cursor ()
appears.

>>Temp. Code JOB

Size 153&@13
1S

Press the A or V key to increase or decrease, respectively, the value at the blinking
cursor. Use the [> and <] keys to move the cursor right and left.

When the desired size is displayed, press the ENTER key.

10 Press the MENU key. The display returns to Ready.
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Maximum Space Assigned to Permanent Code Jobs

This changes the hard disk space that holds permanent code jobs. You can change the
maximum space from 0 to 9999 (megabytes). The actual maximum size depends on the size
of free hard disk space, however. The default size is 1/6 of the total hard disk space, rounded
off in unit of 50 MB. For example, if the total hard disk space is 10 GB, the default size is
1550 MB.

1 Press the MENU key.

2 Press the A or V key and select e-MPS >,

e-MPS >

Press the D> key.

(7

Press the A or V key and select >e-MPS Configuration >.

i

>e-MPS >
Configuration

Press the D> key.

a

Press the A or V key and select >>Perm. Code JOB Size.

>>Perm. Code JOB
Size 1550MB

7 Press the ENTER key, the message display shows a blinking cursor (_).

>>Perm. Code JOB

Size 153btB
R

8 Press the A or V key to increase or decrease, respectively, the value at the blinking
cursor. Use the [>and <] keys to move the cursor right and left.

9 When the desired size is displayed, press the ENTER key.

10 Press the MENU key and the display returns to Ready.

3-32

Download from Www.Somanuals.com. All Manuals Search And Download.



3.4 e-MPS

Maximum Space Assigned to Virtual Mailboxes (VMB)

This changes the hard disk space for virtual mailboxes. You can change the maximum space
from 0 to 9999 (megabytes). The actual maximum size depends on the size of free hard disk
space, however. The default size is 1/6 of the total hard disk space, rounded off in unit of 50
MB. For example, if the total hard disk space is 10 GB, the default size is 1550 MB.

1
2

Hh @

o O

10

Press the MENU key

Press the A or V key and select e-MPS >,

e-MPS >

Press the > key.

Press the A or V key and select >e-MPS Configuration >.

>e-MPS >
Configuration

Press the > key.

Press the A or V key and select >>VMB Size.

>>VMB Size
1550MB

To change the maximum size, press the ENTER key. The message display shows a
blinking cursor ().

>>VMB Size

15508

71>

Press the A or V key to increase or decrease, respectively, the value at the blinking
cursor. Use the [> and <I keys to move the cursor right and left.

When the desired size is displayed, press the ENTER key.

Press the MENU key to exit the menu selection.
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3.5

3.5.1

Changing the Interface Parameters

The printer is equipped with both a parallel and USB interfaces. Optional serial interface
board kit and network interface card can also be installed. Various printing environment
parameters such as the default emulation can be changed independently on different
interfaces by using the printer’s menu selection system. Select the interface to apply the
changes in the procedure described below.

data will be received from. The printer automatically selects an interface

— data to be received.
Note

g This interface selection described below does not select which interface

Changing Parallel Interface Mode

The parallel interface supports a bi-directional/high-speed mode according to IEEE
standards. Normally, this interface is used under the default setting Auto. For details, see
Appendix B Computer Interface. After setting the interface, be sure to reset the printer or
turn the power off at least once. The new setting will be enabled thereafter. You can select
from the following:

* Auto (default)

* Nibble/high speed
* High speed

* Normal

1 Press the MENU key.

Press the A or V key repeatedly until Interface > appears.

N

If the interface is other than parallel, press the ENTER key. A blinking question
mark (?) appears.

(7

Fnterface
s\,

? Serial
/|\

4 Press the A or V key repeatedly until Parallel appears.

Fnterface
N

? Parallel
/l\

Press the ENTER key again. The question mark disappears.

G

To change the parallel interface mode, press the [> key. The current communication
mode appears.
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7 To change the communication mode, press the ENTER key. A blinking question
mark (?) appears.

?Parallel I/F

Nl
? Nibble (high
R ibble (high)

8 Press the A or V key to scroll through the following communication modes:
Nibble (high)
Auto
Normal
High Speed
9 When the desired communication mode is displayed, press the ENTER key.

10 Press the MENU key to exit the menu selection.

3.5.2 Changing Serial Interface Parameters

This section applies to the printer having the optional serial interface board
‘ i kit (IB-11) installed.

Note

You can confirm or change the serial interface parameters including baud rate, data bits,
stop bits, parity, and protocol. These parameters must match those of the computer’s serial
interface.

1 Press the MENU key.
2 Press the A or V key repeatedly until Interface > appears.

3 If the interface is other than serial, press the ENTER key. A blinking question mark
(?) appears.

}nterface

\Iy
? Parallel
/|\

4 Press the A or V key repeatedly until Serial appears.

}nterface
\I,

? Serial
/l\

Press the ENTER key again.

a

Press the [> key. One of the following serial parameters is indicated (Baud rate
for example).

o
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Pressing the A or V key toggles through the serial parameters as follows. To change
the serial parameter, press the ENTER key. Use the A or V key to change the value
or selection.

>Baud Rate

9600

v 4

>Data Bits

8

v 4

>Stop Bits

1

v 4

>Parity

None

v 4

>Protocol
DTR (pos.) &XON

Range

1200,2400,4800, 9600 (Default), 19200,

38400,57600,115200

7 or 8 (Default)

1 (Default) or 2

None (Default), 0dd, Even,or Ignore

DTR (pos.) & Xon (Default), DTR (positive),
DTR (negative), XON/XOFF,or ETX/ACK

For example, to change baud rate from 9600 to 115200, display the baud rate
menu following the above procedure. When the display shows baud rate, 9600
(bps), press the ENTER key. A blinking question mark (?) appears.

)

fBaud Rate
s\,

9600

71

Press the A or V key to scroll through values. When 115200 is displayed, press the
ENTER key. Press the MODE key to exit the menu selection.

Note

Some computers may not be able to handle a baud rate of 115200 bps. If you
set the baud rate to 115200 and encounter communication problems, select

a lower baud rate.
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3.5.3 Changing Network Interface Parameters

This printer supports TCP/IP, NetWare and EtherTalk protocols. In addition, you can install
the optional network interface card in the option interface slot.

Using the operator panel, you can:

Activate or deactivate TCP/IP, NetWare, and AppleTalk

Activate or deactivate DHCP

Enter IP address, subnet mask address, and default gateway address
Determine whether to print a network status page when the printer is turned on

To confirm or change network card parameters, proceed as follows:

1

Press the MENU key.
Press the A or V key repeatedly until Interface > appears.

If the current interface is other than network, press the ENTER key. A blinking
question mark (?) appears.

}nterface >

sy
? Parallel
/|\

If the optional network interface card is installed in the printer, Option will be
displayed. The setting procedure is basically the same even in this case.

Press the A or V key repeatedly until Network appears.

}nterface >
\

V4
? Network
/|\

Press the ENTER key again.
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Press the > key. One of the following menus is indicated. To change settings for the
item, press the ENTER key. Use the A or V key to change the value or selection.

>NetWare >

On

v 4

>TCP/IP >

On

v 4

>EtherTalk
Off

v 4

>Network Status
Page Off

Range

Set this item to On when you connect to a network
using NetWare. In submenu (>), frame mode can be
selected from Auto, 802.3,Ethernet I1I,
802.2,and 802.3SNAP.

Set this item to On when you connect to a network
using TCP/IP. Submenu (>) has items including
DHCP, IP address, subnet mask address, and gate-
way address. To resolve IP address for the network
card, see 3.5.4 Resolving IP Address below.

EtherTalk must be activated (On) for networking
with Macintosh computers.

When the item is set to On, the printer prints out a net-
work status page when it prints the printer status. See
Printing a Network Interface Status Page on page
3-40.

Activate the appropriate protocol that is required to connect the printer to the
network. To activate a protocol, let the protocol displayed, press the ENTER key,
press the A or V key to change from Of £ to On, and press the ENTER key.

Press the MENU key. The display returns to Ready. You can print a network status
page to confirm that the IP address, subnet mask address, and the gateway address
have been properly set. To print a network status page, see Printing a Network
Interface Status Page on page 3-40 which follows.
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3.5.4 Resolving IP Address

To connect the printer to the network using TCP/IP protocol, you must set the IP address on
the printer. The IP address must be unique to the printer and should be obtained from your
network administrator.

1

0 N o6 bh

Activate TCP/IP protocol in the manner described above.

>TCP/IP >
On

Enter the submenu by pressing the [> key. Each time you press the A or V key, the
selection changes as shown below.

>>DHCP
Off

v 4

>>IP Address
000.000.000.000

v 4

>>Subnet Mask
000.000.000.000

v 4

>>Gateway
000.000.000.000

When >>IP Address is displayed, press the ENTER key. A blinking cursor ()
appears at the last digit.

>>TP Address

000.000.000.0007
21N

Press the A or V key to increase or decrease, respectively, the value at the blinking
cursor. Use the [> and <] keys to move the cursor right and left.

When the IP address is entered, press the ENTER key.

Press the A or V key to move to Subnet Mask. Perform the same procedure to
complete entering the subnet mask address.

Then, press the A or V key to move to Gateway. Perform the same procedure to
complete entering the subnet mask address.

Press the MENU key. The display returns to Ready. You can print a network status
page to confirm that the IP address, subnet mask address, and the gateway address
have been properly set. To print a network status page, see Printing a Network
Interface Status Page which follows.
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Printing a Network Interface Status Page

You can have your printer print out a network status page when the printer prints the status
page. The network status page shows the network addresses, and other information under
various network protocols about the network interface card. The default setting is Of £
(print disable).

optional network interface card. For details, see the manual for the network

— interface.
Note

g Printing out a network interface status page may not be possible with the

A sample network status page is shown on Figure 3-7 on page 3-41.

1 Press the MENU key.

2 Press the ENTER key repeatedly until Interface > appears.

Interface >
Parallel

3 If the interface is other than network, press the ENTER key. A blinking question
mark (?) appears.

Fnterface

\
7 Parallel
1

4 Press the A or V key repeatedly until Network appears. Press the ENTER key.

}nterface

\I,
? Network
/|\

5 Press the > key and then press the A or V key repeatedly until the display shows
>Network Status Page.

>Network Status
Page Off

6 The default setting is O£ £. If it is set to On, press the ENTER key. A blinking
question mark (?) appears.

>NetwoFk Status
s\,
Page ? Off

l|\

7 Press the A or V key to select On.

>NetwoFk Status

Page 7 On
1S
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3.5 Changing the Interface Parameters

8 Press the ENTER key again.

Press the MENU key. The display returns to Ready. The printer prints a network
status page as an example shown in Figure 3-7 below.

W KYOCERA

\”Ii’a/ m FS-C5016N Page Printer
NETWORK STATUS PAGE

Figure 3-7
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3.6 Making Default Settings

Using the operator panel, you can set the default for the following items. Note default
settings made using the operator panel may be overridden by the printer driver settings and
application software.

3.6.1 Default Emulation

You can change the emulation mode and character code set for the current interface. The
printer is capable of the following emulation modes:

HP PCL 6 (HP Color LaserJet 8550)
KPDL3 (PostScript 3)

The printer can automatically switch between HP PCL 6 and KPDL3 depending on the print
job that is received from the computer. To do this, select KPDL. (AUTO) in the following
procedure.

1
2

o G A~

Press the MENU key.

Press the A or V key repeatedly until Emulation > appears on the message
display. One of the emulation modes appears, indicating the emulation currently in
use.

PCL 6 (default)
KPDL
KPDL (AUTO)

To change the default emulation, press the ENTER key. A blinking question mark
(?) appears.

mulation

\Nog
?PCL 6
/|\

Press the A or V key repeatedly until the desired emulation mode is displayed.
Press the ENTER key.

Press the MENU key. The display returns to Ready.
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3.6.2 Alternative Emulation for KPDL Emulation

The auto KPDL [KPDL (AUTO) ] emulation enables the printer to automatically change
the emulation mode according to the print job received. The emulation mode the printer
switches alternatively can be selected using the operator panel. The default alternative
emulation is HP PCL 6.

1
2

© 0O N

Press the MENU key.

Press the A or V key repeatedly until Emulation > appears.

Emulation >
PCL ©

Press the ENTER key. A blinking question mark (?) appears.

?mulatlon
\ly

?PCL 6
/|\

Press the A or V key repeatedly until KPDL, (AUTO) appears. Press the ENTER
key.

Emulation
?KPDL (AUTO)

Press the [> key. Press the A or V key until >A1t. Emulation is displayed. The
alternative emulation currently selected also appears — PCL 6 or KC-GL.

To change the alternative emulation, press the ENTER key. A blinking question
mark (?) appears.

fAlt. Emulation

Vi
?PCL 6
\

\
4|

Press the A or V key until the desired alternative emulation appears.
Press the ENTER key.

Press the MENU key. The display returns to Ready.
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3.6.3 Printing KPDL Errors

The printer can print error descriptions when printing error occurs during KPDL emulation.
The default is Of £ — the printer does not print KPDL errors.

1 Press the MENU key.

2 Press the A or V key repeatedly until Emulation > appears.

Emulation >
PCL ©

3 Press the ENTER key. A blinking question mark (?) appears.

?mulation
\T,

?PCL 6
l|\

4 Select KPDL or KPDL (AUTO) using the A or V key.

mulation

\le
?KPDL
71

Press the ENTER key.

G

Press the D> key. Press the A or V key until >Print KPDL Errs (errors)
appears.

>Print KPDL Errs
Off

Press the ENTER key. A blinking question mark (?) appears.

~

8 Select On using the A or V key. Press the ENTER key.

fPrint KPDL Errs

Ny
? Off
1N

9 Press the MENU key. The display returns to Ready.
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Default Font

3.6 Making Default Settings

You can select the default font for the current interface. The default font can be one of the
internal fonts or a font that is downloaded to the printer memory or stored on memory card
or hard disk.

In this menu, you can also set the type and pitch for Courier and Letter Gothic; as well as to
print a font list.

1 Press the MENU key.

2 Press the A or V key repeatedly until Font > appears.

Font >

3 Press the [> key. Press the A or V key until >Font Select > appears.

>Font Select >
Internal

4 To select an internal font, make sure that Internal is displayed and press the >
key. The display changes as shown below. If Internal is not displayed, press the
ENTER key, then press the A or V key until it appears.

>> T000

To select an optional font, press the ENTER key while >Font Select >is
displayed. Press the A or V key repeatedly until Option appears and then press
the ENTER key. Press the [> key next to display the font selection shown above.
You can perform this operation only when optional fonts are installed in the printer.

The letter before the number indicates the location of the font, as shown below:

Internal font

Soft (downloaded) font

Fonts in optional memory card

Fonts in RAM disk or optional hard disk
Fonts in optional ROM (API)

o =- K »nn H

5 Press the ENTER key. A blinking question mark (?) appears.

]
>337000
l|\

6 Press the A or V key repeatedly until the desired font number appears. For font
numbers of the internal fonts, see Printing Lists of Fonts on page 3-50.

When the desired font is displayed, press the ENTER key.

n]

Press the MENU key. The display returns to Ready.
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Selecting Regular or Dark Courier/Letter Gothic

Courier or Letter Gothic font thickness can be selected as Regular or Dark. In the
procedure below, it is assumed that Courier is selected. The procedure is the same for Letter
Gothic.

1 Press the MENU key.

2 Press the A or V key repeatedly until Font > appears.

Font >

3 Press the > key. Press the A or V key until >Font Select > appears.

>Font Select >
Internal

Make sure that Internal is displayed and press the > key.

i

Press the A or V key repeatedly until >>Courier appears. If you are selecting the
thickness of the Letter Gothic font, choose >> Letter Gothic here instead.

G

>>Courier
Regular

6 Press the ENTER key. A blinking question mark (?) appears.

>>Courier

Y 04
? Regular
71

Select Regular or Dark using the A or V key.

~

Press the ENTER key.

Press the MENU key. The display returns to Ready.

©
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Changing the Default Font Size

You can change the size of the default font. If you selected a proportional font, the character
size can also be changed.

1
2

a b

Press the MENU key.

Press the A or V key repeatedly until Font > appears.

Font >

Press the [> key. Press the A or V key until >Font Select > appears.

>Font Select >
Internal

Make sure that Internal is displayed and press the > key.

Press the A or V key repeatedly until >>Size appears.

>>Size
012.00 point (s)

Press the ENTER key. A blinking cursor (_) appears.

>>Size

012. Ob’point (s)
T

Press the A or V key to increase or decrease the value at the blinking cursor. The
font size can be set between 4 and 999.75 points, in 0.25-point increments. Use the
> or < key to move the cursor right and left.

When the desired size is displayed, press the ENTER key.

Press the MENU key. The display returns to Ready.

3-47

Download from Www.Somanuals.com. All Manuals Search And Download.



3.6 Making Default Settings

Character Pitch for Courier/Letter Gothic

You can set the character pitch for fixed fonts when the default font is Courier or Letter
Gothic.

1
2

S

o ®

Press MENU key.

Press the A or V key repeatedly until Font > appears.

Font >

Press the > key. Press the A or V key until >Font Select > appears.

>Font Select >
Internal

Make sure that Internal is displayed and press the > key.

Press the A or V key repeatedly until >>Pitch appears.

>>Pitch
10.00 cpi

Press the ENTER key. A blinking cursor (_) appears.

>>Pitch

10.0Y cpi
N

Press the A or V key to increase or decrease the value at the blinking cursor. The
character pitch can be set between 0.44 and 99.99 characters per inch, in 0.01
character-per-inch increments. Use the [> or <] key to move the cursor right and left.

When the desired size is displayed, press the ENTER key.

Press the MENU key. The display returns to Ready.
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Setting the Code Set

You can change the character code set. Available character code sets vary depending on the
current font. (The default is IBM PC-8.)

1
2

Hh @

O ~NO®

Press the MENU key.

Press the A or V key repeatedly until Font > appears.

Font >

Press the > key.

Press the A or V key repeatedly until >Code Set appears.

>Code Set
IBM PC-8

Press the ENTER key. A blinking question mark (?) appears.

>Code Set
s,
?IBM PC-8
/|\

Press the A or V key until the desired character code set appears.
Press the ENTER key.

Press the MENU key. The display returns to Ready.
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Printing Lists of Fonts

To help you decide in selecting a font, you can printout lists of the internal fonts or the
optional fonts including downloaded fonts. Samples for font lists are shown in Figure 3-8
on page 3-51.

1
2

H W

Press the MENU key.

Press the A or V key repeatedly until Font > appears.

Font >

Press the D> key.

Pressthe A or V key repeatedly until >List of Internal Fontsor>List
of Option Fonts appears.

>List of
Internal Fonts

Press the ENTER key. A question mark (?) appears.

>List of
Internal Fonts?

Press the ENTER key again. Processing appears, then Ready. The printer prints
out a list of fonts with a sample and font ID (number) for each of them. Sample lists
of fonts are shown in Figure 3-8 on the next page.
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| | Font Name | [scalable/Bitmap Password Selection  [FSET] Font ID
anEannl anEannl L1111 NNNNNENENEEED [ L11]
(111}
[11]]
|_ _| e
Font Name | scalablelemag Password Selection __[FSET] Font ID
(L1 1] [ L11]

Figure 3-8
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3.7 Pagination

In Page Set menus, you can set the number of copies, page orientation, and other settings
regarding pagination.

3.7.1  Number of Copies

You can set the number of copies of each page to be printed for the current interface. The
number of copies can be set between 1 and 999.

1 Press the MENU key.

2 Press the A or V key repeatedly until Page Set > appears.

Page Set >

Press the D> key.

(7

Press the A or V key repeatedly until >Copies appears.

i

>Copies
001

5 Press the ENTER key. A blinking cursor (_) appears.

>Copies '
0817
TS

6 Press the A or V key to increase or decrease, respectively, the value at the blinking
cursor. Use the [> and <] keys to move the cursor right and left.

When the desired size is displayed, press the ENTER key.

~

Press the MENU key. The display returns to Ready.
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3.7.2 Print Orientation

You can select portrait (upright) or landscape (sideways) page orientation.

Portrait Orientation Landscape Orientation

>

|>

Figure 3-9

1 Press the MENU key.

2 Press the A or V key repeatedly until Page Set > appears.

Page Set >

Press the > key.

W

Press the A or V key repeatedly until >Orientation appears.

H

>Orientation
Portrait

5 Press the ENTER key. A blinking question mark (?) appears.

fOrientation

v .
? Portrait
l|\

N\

Select Portrait or Landscape using the A or V key.

o

Press the ENTER key.

~

Press the MENU key. The display returns to Ready.
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3.7.3 Page Protect Mode

The Page Protect Menu does not normally appear, however, Page Protect will be
forcibly set to On if a print overrun error occurs because the print job is too complex. When
this has happened, be sure to reset Page Protect to Auto (default) in order to maintain
the optimum use of printer memory.

1
2

A W

® N

Press the MENU key.

Press the A or V key repeatedly until Page set > appears.

Page set >

Press the D> key.

Press the A or V key repeatedly until >Page Protect appears.

>Page Protect
On

Press the ENTER key. A blinking question mark (?) appears.

Page Protect
0,29

? On
/l\

Press the A or V key repeatedly until Auto appears.

Page Protect
\?/ 9

? Auto
/|\

Press the ENTER key.

Press the MENU key. The display returns to Ready.
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3.74 Linefeed (LF) Action

This procedure instructs the printer what to do when it receives a linefeed code (0AH).
e LF only: Linefeed is performed (Default).

* CR and LF: A linefeed and carriage return are performed.
* Ignore LF: The linefeed is ignored.

1 Press the MENU key.

2 Press the A or V key repeatedly until Page Set > appears.

Page Set >

Press the > key.

()

Press the A or V key repeatedly until >LF Action appears.

H

>LF Action
LF only

5 Press the ENTER key. A blinking question mark (?) appears.

fLF Action

\ls
? LF only
71>

Press the A or V key repeatedly until the desired linefeed action appears.

o

When the desired action is displayed, press the ENTER key.

~

8 Press the MENU key. The display returns to Ready.
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3.7.5 Carriage-Return (CR) Action

This procedure instructs the printer what to do when it receives a carriage-return code
(ODH).

* CR only: A carriage-return is performed (Default).

* CR and LF: A linefeed and carriage return are performed.
* Ignore CR: The carriage-return is ignored.

Press the MENU key.

=

2 Press the A or V key repeatedly until Page Set > appears.

Page Set >

Press the D> key.

(7

Press the A or V key repeatedly until >CR Action appears.

i

>CR Action
CR only

5 Press the ENTER key. A blinking question mark (?) appears.

fCR Action
s\,
? CR only
/l\

Press the A or V key repeatedly until the desired carriage-return action appears.

When the desired action is displayed, press the ENTER key.

~

Press the MENU key. The display returns to Ready.
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3.7.6  Wide A4 Pitch

Turn this to On to increase the maximum number of characters that can be printed in a line
for A4 page (78 characters at 10 pitch) and Letter size page (80 characters at 10 pitch). This
setting is effective in only PCL 6 emulation.

1 Press the MENU key.

2 Press the A or V key repeatedly until Page set > appears.

Page Set >

Press the > key.

W

Press the A or V key repeatedly until >Wide A4 appears.

H

>Wide A4
Off

5 Press the ENTER key. A blinking question mark (?) appears.

>Wide A4
\l,

? Off
/|\

Select On or Of £ using the A or V key.

o

Press the ENTER key.

n]

Press the MENU key. The display returns to Ready.
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3.8

3.8.1

Setting Print Quality

Gloss Mode

The printer features the Print Quality menu which lets you select the intensity of the gloss
mode (Low or High).

The gloss mode, when set to High, increases the effect of glossiness in printing by reducing
the printing speed by half. The gloss mode is not available when Transparency is
selected as the paper type setting.

Depending on the paper used, printing in gloss mode may cause wrinkle in
‘ i paper. To reduce wrinkle, try using thicker paper.

Note

The default gloss mode is Low. To confirm or change the gloss mode, proceed as follows:

1 Press the MENU key.

2 Press the A or V key repeatedly until Print Quality > appears.

Print Quality >

Press the D> key.

(7

Press the A or V key repeatedly until >Gloss Mode appears.

i

>Gloss Mode
Low

5 To change the gloss mode, press the ENTER key. A blinking question mark (?)
appears.

fGloss Mode
\l,

? Low
/|\

Press the A or V key to change from Low to High.

Press the ENTER key to finalize the selection.

~

Press the MENU key. The display returns to Ready.
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3.9 Operating the Storage Device

The printer supports three types of storage device; memory card, optional hard disk, and
RAM disk. The memory card and optional hard disk are installed into the dedicated slots of
the printer. The RAM disk is an allocated part of the printer’s memory. If the optional hard
disk is installed in the printer, the e-MPS function will be available. For details, see e-MPS
on page 3-20.

The basic operations of each storage device are the same. This section mainly explains the
operation of the memory card.

3.9.1 Using the Memory Card

The printer is equipped with a slot for a memory card. By inserting a memory card into the
printer, the following operations become available.

* Reading Font Data

* Reading Data

*  Writing Data

*  Deleting Data

*  Formatting Memory Card

*  Printing a List of Data Names

For details about the handling of the memory card, see Appendix A Options, section A.3.1
Memory Card on page A-7.

Reading Font Data

In case of a memory card if a memory with the font data card is already inserted into the slot
when the printer is turned on, the fonts are automatically read into the printer. To read fonts
into the printer from a memory card, proceed as follows.

1 Press the MENU key.

2 Press the A or V key repeatedly until Memory Card > appears.

Memory Card >

Press the > key.

W

Press the A or V key repeatedly until >Read Fonts appears.

H

>Read Fonts

5 Press the ENTER key. A question mark (?) appears.

>Read Fonts ?
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Press the ENTER key. Processing appears and the reading of data from the
memory card starts. When completed, Processing disappears.

>Read Fonts
Processing

7 Press the MENU key. The display returns to Ready.

Reading Data

You can print out the data in the memory card. To read the data saved on the memory card
and print it out, proceed as follows.

1 Press the MENU key.

2 Press the A or V key repeatedly until Memory Card > appears.

Memory Card >

Press the D> key.

(7

Press the A or V key repeatedly until >Read Data appears (Report, in this
example).

B

>Read Data
Report

5 Press the ENTER key. A blinking question mark (?) appears before the data name.

fRead Data
sy

?Report
l|\

Press the A or V key to display the desired data name.

7 Press the ENTER key. Processing appears and the reading of data from the
memory card starts.
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Writing Data

Data can be written to a memory card until no space is left for storing. When writing to a
memory card, a name is assigned to the file automatically. You can use the procedure
explained in the section Printing a List of Data Names (Partitions) on page 3-64 to print a
list of data names for confirmation.

To write data to a memory card, proceed as follows.

>Write Data message to be explained below will not be shown on the
message display. If the memory card inserted in the memory card slot is not
formatted, the >Format will automatically appear on the message display.
Format the memory card. See Formatting a Memory Card on page 3-63.

g First check that the memory card is properly formatted. Otherwise, the

1 Press the MENU key.

2 Press the A or V key repeatedly until Memory Card > appears.

Memory Card >

Press the > key.

W

Press the A or V key repeatedly until >Write Data appears.

H

>Write Data

5 Press the ENTER key. A question mark (?) appears.

>Write Data ?

Press the ENTER key. Processing appears, then Waiting.

o

In this state, send the file from the computer to the printer.

n]

As the printer receives data, the message display changes to Processing, then
when the end of the data is received, the message display changes to Waiting.

8 Check that the message display has changed to Waiting, then press the GO key. This
writes the file to the memory card and instructs the printer to automatically print out
a memory card write information page as shown below.
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The file is written onto the memory card given a destination name (also referred to as
a partition name) which the printer automatically assigns one after another as
follows: DataS001 (first data), DataS002 (second data), DataS003 (third data)...

0} KYOCERA

mita__ m FS-C5016N Page Printer
WRITE INFORMATION

Figure 3-10

Partition Type: Type of data written (currently only type 2 is supported).
Partition Name: The destination name of data written to the card.

Write Partition Length: The size of the written data on the memory card.
Others: Error information.

When the memory card write information page is printed, the display returns to
Ready.

Repeat above steps until you have transferred all data (files) that you want to write to
the memory card. Each time you finish writing data, a memory card write
information page is printed from the printer showing the information, but pertaining
only to the data just written. To see all data contained in the memory card at once,
print a list of data names as explained. See Printing a List of Data Names
(Partitions) on page 3-64.

Deleting Data

It is possible to use the printer to delete data from a memory card one by one.

To delete data from a memory card, proceed as follows. Check that the memory card
contains data. Otherwise, the >Delete Data menu will not appear on the message
display.

1
2

3

Press the MENU key.

Press the A or V key repeatedly until Memory Card > appears.

Memory Card >

Press the D> key.
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4 Press the A or V key repeatedly until >Delete Data appears. The data name
also appears (Report, in this example).

>Delete Data
Report

5 Press the ENTER key. A blinking question mark (?) appears before the data name.

fDelete Data
sy

?Report

/|\

Press the A or V key to display the desired data name.

o

Press the ENTER key. Processing appears and the data is deleted from the
memory card. The display returns to Ready.

~

Formatting a Memory Card

A new memory card must be formatted before it can be used in the printer. Formatting
allows data to be written to the memory card.

* Formatting will destroy any existing data on a storage device including
‘ i a used memory card.

Note ¢ Formatting of the memory card must be executed from the printer.

To format a memory card, proceed as follows. When a new memory card is inserted in the
printer's slot, Format error Memory card will appear on the message display.

1 Press the MENU key.

2 Press the A or V key repeatedly until Memory Card > appears.

Memory Card >

Press the > key.

()

Press the A or V key repeatedly until >Format appears.

H

>Format

5 Press the ENTER key. A question mark (?) appears.

>Format °?
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Press the ENTER key. Processing appears and formatting of the memory card
starts.

When the formatting is successfully completed, the printer automatically prints out a
format information page, which allows you to check the memory card for proper
formatting.

Ol KYOCERA

Jmita_ m FS-C5016N Page Printer
FORMAT INFORMATION

Figure 3-11

Format information page includes the following items:

Capacity: The total size of the memory card.
Used Space: The size the printer uses for its system.
Free Space: The size remaining in the memory card for storing data.

When the memory card format information is printed, the display returns to Ready:.

Printing a List of Data Names (Partitions)

The printer prints a list of all data names (referred to as partitions) stored in a memory card
for reference. (Printing a list is also available for a font card.)

To print a list of data names for the memory card, proceed as follows.

1
2

H W

Press the MENU key.

Press the A or V key repeatedly until Memory Card > appears.

Memory Card >

Press the D> key.

Press the A or V key repeatedly until >List of Partitions appears.

>List of
Partitions
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5 Press the ENTER key. A question mark (?) appears.

>List of
Partitions ?

6 Press the ENTER key. Processing appears and the printing of the list starts.

4 K':IE'IEEREI /\
~Jmita_ ECasm FS-C5016N Page Printer

PARTITION LIST

Device Information

Partition Information |

Figure 3-12

The printout (example above) includes the following information:

Device Name/Number: MEMORY CARDY/A is indicated for the memory card.

Capacity: The total capacity of the memory card in bytes.
Used Space: The total size of the data stored in the memory card in bytes.
Free Space: The size of the capacity remaining in the memory card for stor-

ing further data, including the amount of memory that the
printer uses for its system.

Partition Name: The name of the written data assigned automatically by the
printer.

Partition Size: The size of the written data in bytes.

Partition Type: The type of the written data i.e., whether it is host data (Data)
or font data (Font).

When the list of file names (partition list) for the memory card is printed, the display
returns to Ready.
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3.9.2 Using the Optional Hard Disk

Installing the optional hard disk into the printer allows you to perform the following
operations on the hard disk.

* Reading data

*  Writing data

* Deleting data

*  Formatting hard disk

» Printing a list of data names (partitions)

When an optional hard disk is inserted into the printer for the first time, it must be formatted
before use. If the optional hard disk is not formatted, the >Format menu will automatically
appear on the message display.

The operations of the optional hard disk are the same as those of the memory card. See the
relevant sections in section 3.9.1 Using the Memory Card on page 3-59.

When data is written to the hard disk, the name automatically given to the corresponding
file will be DataHO0O1 (for the 1st file), DataH002 (for the 2nd file), DataH003 (for the 3rd
file), etc.

3.9.3 Using the RAM Disk

The RAM disk is a memory space shared within the printer memory that can temporarily
store print jobs. The RAM disk can be used only for electronic sorting. The stored print job
can then be used to print multiple copies of the job reducing the total amount of time
required to print the whole job. It acts similar to the hard disk except that the data is
effective only during the printer is powered up. By default, the RAM disk is not activated
(Of1).

To use the RAM disk, activate and enter the desired size of the RAM disk in the manner
described below. The maximum RAM disk size can be calculated as follows:

Maximum RAM disk size = Total printer memory -36 MB

For example, if the total memory installed in your printer is 256 MB, you can set 224 MB of
RAM disk. If you attempt to set the RAM disk size beyond this restriction, the printer
automatically round it down so that the size is always 36 MB less than the total printer
memory. Once the RAM disk size is set, the printer must be reset.

To activate RAM disk in the printer's memory, first you must set the RAM disk mode to On
and set the desired data size for the RAM disk as described in the following section. This
allows you to perform the following operations on the RAM disk.

* Reading data

*  Writing data

*  Deleting data

*  Printing a list of data names (partitions)

The operations of the RAM disk are the same as those of the memory card. See the relevant
sections in section 3.9.1 Using the Memory Card on page 3-59. When data is written to the
RAM disk, the name automatically given to the corresponding file will be DataH001 (for
the 1st file), DataH002 (for the 2nd file), DataH003 (for the 3rd file), etc.
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0 * The RAM disk can not be used when an optional hard disk is installed.

¢ The RAM disk stores data only temporarily. When the printer is reset or
Note turned off, the stored data will be erased.

* The RAM disk is allocated within the printer's memory available to
users. If the size of the RAM disk is set too large, the printing speed may
decrease or the memory may become insufficient.

To confirm the RAM disk size or activate the RAM disk, proceed as follows:

Setting the RAM Disk Size

1 Press the MENU key.

2 Press the A or V key repeatedly until RAM Disk Mode appears.

RAM Disk Mode
Off

3 Press the ENTER key. A blinking question mark (?) appears. Press the A or V key
to select On. Press the ENTER key.

]IRAM Disk Mode
\l,

? On
/l\

4 Press the [> key. Press the A or V key repeatedly until >RAM Disk Size
appears. The data size also appears.

>RAM Disk Size
0119 MByte

5 Press the ENTER key. A blinking cursor (_) appears. Press the A or V key to
display the desired size. Definable RAM disk size is 0001 to 1024.

>RAM Disk Size

1
0119" MByte
l|_\

This range varies depending on the total memory size of the printer. The setting
exceeding this range is automatically adjusted to the maximum RAM disk size.

When the desired RAM disk size is displayed, press the ENTER key.

o

Press the MENU key. The display returns to Ready. Then, turn off the printer and on
again. The selected RAM disk size is activated after the printer is restarted.

n]
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3.10 Paper Handling

3.10.1

MP Tray Mode

This section explains how to change mode for the MP (multi-purpose) tray, the paper size
and type for each paper source, and how to select the paper source and paper destinations.

The MP tray can be used in either of two modes — Cassette or First. The MP tray
feed paper differently depending on the mode:

*  Cassette Mode (default)

The MP tray acts in the same manner as other paper source. The printer can correctly
feed paper from any paper source as you command on the printer driver. The cassette
mode provides a faster printing speed than the first mode.

»  First Mode
The MP tray automatically feeds paper placed on the MP tray overriding another paper
source that is selected on the printer driver. After all paper sheets in the MP tray have
been used up (approximately 100 sheets [A4 size, 0.11 mm thickness]), paper will be
fed from the paper source originally selected. This mode is convenient to feed paper of
special size or type without reloading the current paper source. However, the MP tray
must be kept empty if you desire to feed paper from the intended paper source.

To switch the MP tray to First mode, proceed as follows:
1 Press the MENU key.

2 Press the A or V key repeatedly until Paper Handling > appears.

Paper Handling >

Press the D> key.

(7

Press the A or V key repeatedly until >MP Tray Mode appears.

i

>MP Tray Mode
Cassette

5 Press the ENTER key. A blinking question mark (?) appears.

MP Tray Mode
\f/ Y

? Cassette
/|\

Press the A or V key to change Cassette to First.

Press the ENTER key. The MP tray mode is changed.

~

To exit the menu selection, press the MENU key.
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3.10.2 Setting MP Tray Paper Size

When you use the MP tray in cassette mode, you should set the MP tray size to the paper
size that is used to format the job to print. If the sizes do not match, printing will not be
performed on the correct size paper. The default setting is Let ter size for the U.S. and
Canada and A4 for other countries.

For more information about the paper sizes that you can feed from the MP tray, see Chapter
2 Handling Paper.

Feeding the paper having a paper size which does not match the current
‘ ; paper size from the MP tray can cause paper jam.

Note

Press the MENU key.

= 3

2 Press the A or V key repeatedly until Paper Handling > appears.

Paper Handling >

Press the > key.

()

Press the A or V key repeatedly until >MP Tray Size appears. In this example,
the current MP tray paper size is A4.

H

>MP Tray Size
A4

5 To change the paper size, press the ENTER key. A blinking question mark (?)
appears.
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6 Press the A or V key to display the desired paper size. The message display toggles
through the following paper sizes:

A4
Executive
Letter
Legal
Custom
Oficio II
Statement
Folio
Youkei 2
Youkei 4
16K
Hagaki
Oufukuhagaki
Monarch
Business
Comm. #9
Comm. #6 3/4
DL

C5

A6

B6

A5

B5

ISO BS

7 When the desired paper size is displayed, press the ENTER key. The paper size is set
for the MP tray.

8 To exit the menu selection, press the MENU key.
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3.10 Paper Handling

By setting a paper type (plain, recycled, etc.) to the MP tray, you can select the paper on the
MP tray according to the paper type you command on the printer driver. The default setting
is plain paper.

For more information about paper types that can be fed from the MP tray, see Chapter 2
Handling Paper.

1
2

Hh @

Press the MENU key.

Press the A or V key repeatedly until Paper Handling > appears.

Paper Handling >

Press the > key.

Press the A or V key repeatedly until >MP Tray Type appears.

Plain

>MP Tray Type

To change paper type, press the ENTER key. A blinking question mark (?) appears.

? Plain
/l\

MP Tray Type
\f, y 1lyp

Press the A or V key to display the desired paper type. The message display toggles

through the following paper types:

Plain
Transparency
Preprinted
Labels

Bond
Recycled
Vellum

Rough
Letterhead
Color
Prepunched
Envelope
Cardstock
Coated

Thick

High quality
Custom 1(to 8)

When the desired paper type is displayed, press the ENTER key. The paper type is

set to the MP tray.

To exit the menu selection, press the MENU key.
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3.10.4 Setting the Cassette Paper Size

To set the standard sizes A5, A4, B5, Letter, and Legal size for the paper cassette, use the
following procedure to set the paper size dial of the paper cassette.

If you use a non-standard size, see Custom Paper Size.

Properly set the paper into the paper cassette. For details about the adjustment of the paper
guides and paper stopper inside the paper cassette, see Chapter 2 Handling Paper, section
2.3 Loading Paper on page 2-8.

1 Turn the paper size dial so that the size of the paper you are going to use appears in
the paper size window.

Paper Size Dial Paper Size Window
Figure 3-13

2 Adjust the paper guides and paper stopper inside the paper cassette to the size of the
paper to be used and load the paper into the cassette.

The paper size setting for the paper cassette is completed.

Custom Paper Size

In addition to the standard sizes A5, A4, B5, Letter, and Legal size for the paper cassette,
paper of other sizes can be fed. When placing paper of sizes other than A5, A4, B5, Letter,
or Legal into the paper cassette, set the size of the paper to be used into the printer by
following the procedure given below. If an optional paper feeder (PF-60) is installed,
custom sizes for its paper cassette can be set using the same procedure.

This menu appears when the paper size dial of the paper cassette is set to OTHER.

Properly set the paper into the paper cassette. For details about the adjustment of the paper
guides and paper stopper inside the paper cassette, see Chapter 2 Handling Paper, section
2.3 Loading Paper on page 2-8.
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Setting Paper Size Dial

Use the following procedure to set the paper size dial to OTHER.

1

2

Pull out the paper cassette from the printer and turn the paper size dial to OTHER.
See step 1 in Setting the Cassette Paper Size.

Adjust the paper guides and paper stopper inside the paper cassette to the size of the
paper to be used and load the paper into the cassette.

When using non-standard size paper, read the next section to set the paper size from
the operator panel.

Setting a custom size from the Operator Panel

Set the size of the paper loaded in the paper cassette into the printer from the printer
operator panel.

1
2

h @

Press the MENU key.

Press the A or V key repeatedly until Paper Handling > appears.

Paper Handling >

Press the > key.

Press the A or V key repeatedly until >Cassette Size > appears.

If optional paper feeders are added, Cassette 1 Size will appear for the
standard paper cassette and Cassette 2 Size,Cassette 3 Size,and
Cassette 4 Size will appear for the optional paper feeders.

>Cassette Size >
Custom

Press the ENTER key. A blinking question mark (?) appears.

fCassette Size
\l,

? Custom
/l\
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Press the A or V key to display the desired paper size. The message display toggles
through the following paper sizes:

Custom
Oficio II
Folio

16K

C5

A5

B5

ISO BS

A4
Executive
Letter

When the desired paper size is displayed, press the ENTER key. The paper size is set
for the paper cassette.

If you selected Custom in step 6, be sure to set the unit of measurement and the
dimensions of the paper as described in the following sections.

Selecting the Unit of Measurement

Then, use the following procedure to set the unit of measurement.

1
2

G A

Press the D> key.

Press the A or V key repeatedly until >>Unit appears. The unit of measurement
can be selected between millimeters and inches. The current unit of measurement is
displayed (the default setting is mm).

>>Unit
mm

Press the ENTER key. A blinking question mark (?) appears.

S .
\f’ Unit

? mm
/|\

Select mm or inch using the A or V key.

Press the ENTER key.

Set the dimensions of the paper as described in the next section.
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Entering the Width and Length

Then, use the following procedure to set the paper size.

Enter the paper size for X Dimensionand Y Dimension as shown in the figure.

\ _—7r)
m
(0]
e
[S]
5 c<
2 €S
o o<
5 85
> 2 N~
o
148 to 216 mm X Dimension e
(5.83 to 8.5 inches) i .
\
] — -
I [HEEHL ]
J /)

Figure 3-14

1

a b

O ~NO®

When the unit of measurement is set, press the V key.
>>X Dimension appears as shown below (the paper width setting).

>>X Dimension
216 mm

Press the ENTER key. A blinking cursor (_) appears.

>>X Dimension

226 mm
21N

Press the A or V key to increase or decrease the value of the figure where the cursor
is blinking and display the desired width. The width can be set between 148 and
216 mm (5.83 to 8.5 inches). You can use the <] or [> key to move the cursor
right and left.

Display the paper width and press the ENTER key.

When the width is set, press the key. >>Y Dimension appears (the paper length
setting). Set the desired length in the same way as the width. The length can be set
between 210 and 356 mm (8.27 to 14. 02 inches).

Display the paper length, press the ENTER key.

Press the MENU key. The display returns to Ready.

To print using the custom size set above, define the same custom size on the printer
driver. For details, see KX Printer Drivers Operation Guide.
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3.10.5 Setting the Cassette Paper Type

By setting a paper type (plain, recycled, etc.) to the paper cassette, you can automatically
select the paper in the paper cassette according to the paper type you command on the
printer driver. The default setting is plain paper for all paper cassettes.

For more information about paper types that you can feed from the paper cassette, see
Chapter 2 Handling Paper.

1
2

A W

® N

Press the MENU key.

Press the A or V key repeatedly until Paper Handling > appears.

Paper Handling >

Press the D> key.

Press the A or V key repeatedly until >Cassette Type appears.

If optional paper feeders are added, Cassette 1 Type will appear for the
standard paper cassette and Cassette 2 Type, Cassette 3 Type, and
Cassette 4 Type will appear for the optional paper feeders.

>Cassette Type
Plain

To change paper type, press the ENTER key. A blinking question mark (?) appears.

Cassette Type
\f S yp

? Plain
/|\

Press the A or V key to display the desired paper type. The message display toggles
through the following paper types:

Plain
Preprinted
Bond
Recycled
Rough
Letterhead
Color
Prepunched
High quality
Custom 1 (to 8)

When the desired cassette type is displayed, press the ENTER key.

To exit the menu selection, press the MENU key.
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3.10.6 Selecting the Paper Feed Source

You can select the paper source using the operator panel, from which the printer feeds paper
as the default. If an optional paper feeder(s) is installed, it is also available for the default
paper source.

1
2

h @

0 N

Press the MENU key.

Press the A or V key repeatedly until Paper Handling > appears.

Paper Handling >

Press the > key.

Press the A or V key repeatedly until >Feed Select appears.

>Feed Select
Cassette 1

To change the current paper feed source, press the ENTER key. A blinking question
mark (?) appears.

fFeed Select
\l,

? Cassette 1
/l\

Press the A or V key to display the desired paper feed source. The message display
toggles through the following paper feed sources, depending on the installed optional
paper feeders (from the top most paper cassette to the bottom paper cassette):

MP tray
Cassette
Cassette
Cassette
Cassette

DSw N

Cassettes 2, 3 and 4 are available for selection when the optional paper feeders
are installed.

When the desired paper source displayed, press the ENTER key.

To exit the menu selection, press the MENU key.
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3.10.7 Duplex Printing

Using the optional duplexer (DU-300), you can automatically print on both sides of the
paper. The duplexer is mounted underneath the printer.

Duplex printing is available for the following paper types:

Plain
Preprinted
Bond
Recycled
Rough
Letterhead
Color
Prepunched
High quality

Activating the duplexer on the operator panel is done by selecting either short edge or long
edge binding mode.

a ¢ To use this function, the optional duplexer must be installed on the
printer.

Note *  Duplex printing can be also performed from the MP tray. When the MP
tray is set to First Mode (First), the paper size and paper type will be
the same as those of the paper cassette currently set at the paper feed
source. If the paper to be fed from the MP tray does not match the paper
size and paper type of the current paper feed source cassette, a paper
jam may occur.

Binding Modes

Binding refers to the manner in which printed pages of paper are joined together (by gluing,
stitching, etc.) in book form. The two possible types of binding are: long-edge binding, in
which pages are joined together along their long edge; and short-edge binding, in which
they are joined together along their short edge. In selecting a binding type, you must also
consider the orientation of the printed page. You can use long-edge or short-edge binding
with either landscape or portrait printing.

Depending on the binding type and print orientation, the duplexer provides four types of
binding. These are: (1) portrait, long-edge, (2) portrait, short edge, (3) landscape, long-edge,
and (4) landscape, short-edge. The figure below shows these binding methods.

(1) (2) 2 —— Portrait,
short-edge
Portrait,
long-edge: — 3
2 5
3 A Landscape
( ) 2 s— short-edge

Landscape
long-edge L (‘1) ///,,l,

3 3H
L7 2 °

Figure 3-15
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3.10 Paper Handling

To select duplex printing and binding setup from the operator panel, proceed as follows.
This procedure can only be performed when the optional duplexer (DU-300) is installed.

1
2

Hh @

7

Press the MENU key.

Press the A or V key repeatedly until Paper Handling > appears.

Paper Handling >

Press the > key.

Press the A or V key repeatedly until >Duplex Mode appears.

>Duplex Mode
None

To activate duplex printing, press the ENTER key. A blinking question mark (?)
appears.

Duplex Mode
Jp0P

?None
/l\

Press the A or V key to display the desired binding mode. The message display
toggles through the following:

None (default)
Long edge bind
Short edge bind

When the desired binding mode is displayed, press the ENTER key. The binding
mode is set.

To exit the menu selection, press the MENU key.

Note on Duplex Printing from the MP Tray

You cannot select the MP tray, when it is set to ‘cassette’ mode, to perform duplex
printing. To perform duplex printing, select a paper cassette.

It is possible to duplex-print using the MP tray if it is set in ‘first’ mode. (See Section
3.10.1 MP Tray Mode on page 3-68.) However, be sure to set the MP tray paper size
and paper type to the same paper size and paper type as those of the current paper
cassette. If the paper size or type differs, a paper jam may occur.
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3.10 Paper Handling

3.10.8 Overriding Difference between A4 and Letter

When the Override A4/LT is turned on using the operator panel, the printer ignores the
difference between A4 and Letter paper sizes. Printing is performed without an error
message even if the actual paper size in the current cassette differs from the paper size
formatting the job.

By default, this feature is off. To confirm and turn on the Override A4/LT, proceed as
follows:

1 Press the MENU key.

2 Press the A or V key repeatedly until Paper Handling > appears.

Paper Handling >

Press the D> key.

(%)

Press the A or V key repeatedly until >Override A4/LT appears.

B

>Override A4/LT
Off

5 To change overriding mode, press the ENTER key. A blinking question mark (?)
appears.

fOVerride A4 /LT
\

4
? Off
71>

Press the A or V key to change Of £ to On.

Press the ENTER key. The overriding mode is set.

~

To exit the menu selection, press the MENU key.
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3.10.9 Creating Custom Paper Type

3.10 Paper Handling

The following describes the procedure used to set a user-defined paper type for the printer.
Eight custom user settings may be registered. After having been set, any of these may be

called up when setting the paper type for a paper source.

The paper weight and duplex path can be set (see Setting the Paper Weight on page 3-82,
and Setting the Duplex Path on page 3-83) after selecting the paper type to be customized as
follows. For how to reset the customized settings, see section 3.10.10 Resetting the Custom

Paper Type on page 3-84.

1
2

h @

Press the MENU key.

Press the A or V key repeatedly until Paper Handling > appears.

Paper Handling >

Press the > key.

Press the A or V key repeatedly until >Type Adjust > appears.

>Type Adjust
Custom 1

Press the ENTER key. A blinking question mark (?) appears.

4|

Type Adjust
\f,yp Ju
?\Custom 1

Press the A or V key to display the desired paper type. The display changes as

shown below.

Custom 1 (to 8)
Plain
Transparency
Preprinted
Labels

Bond
Recycled
Vellum

Rough
Letterhead
Color
Prepunched
Envelope
Cardstock
Coated

Thick

High quality

When the paper type to be customized is displayed, press the ENTER key.
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3.10 Paper Handling

Press the > key and proceed to Setting the Paper Weight.

Setting the Paper Weight

You can set the paper thickness for your custom paper type to be customized.

1

2

o 0

Display the custom paper type (see section 3.10.9 Creating Custom Paper Type on
page 3-81) and press the > key.

Press the A or V key repeatedly until >>Paper Weight appears.

>>Paper Weight
Normal 1

Press the ENTER key. A blinking question mark (?) appears.

f>Paper Weight

s\,
? Normal 1
/|\

Press the A or V key to display the desired paper thickness. The display changes as
shown below. For details of the default setting for each paper type, see Chapter 2
Handling Paper, section 2.5 Paper Type on page 2-21.

Light
Normal 1
Normal 2
Normal 3
Heavy 1
Heavy 2
Heavy 3
Extra Heavy

When the desired paper thickness displayed, press the ENTER key.

Press the MENU key. The display returns to Ready.

If the optional duplexer is installed on the printer, duplex printing can be enabled and
disabled. See Setting the Duplex Path on the following page.
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3.10 Paper Handling

Setting the Duplex Path

0 To use this function, the optional duplexer must be installed on the printer.

Note

If the optional duplexer is installed on the printer, you can set whether or not to enable
duplex printing as follows. The default setting is Enable.

1 Display the custom paper type (see section 3.10.9 Creating Custom Paper Type on
page 3-81) and press the > key.

2 Press the A or V key repeatedly until >>Duplex path appears.

>>Duplex path
Enable

3 Press the ENTER key. A blinking question mark (?) appears.

f>Duplex path

\
? Enable
/|\

4 Select Enable or Disable using the A or V key. For details of the default setting
for each paper type, see Chapter 2 Handling Paper, section 2.5 Paper Type on page
2-21.

Press the ENTER key.

a

Press the MENU key. The display returns to Ready.

o

The custom paper type setting is completed.
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3.10.10 Resetting the Custom Paper Type

If you want to reset all custom paper type settings to the factory default, proceed as follows:

1
2

A W

Press the MENU key.

Press the A or V key repeatedly until Paper Handling > appears.

Paper Handling >

Press the [> key.

Press the A or V key repeatedly until >Reset Type Adjust appears.

>Reset Type
Adjust

To reset all custom paper types, press the ENTER key. A question mark (?) appears.

>Reset Type
Adjust ?

Press the ENTER key. All customized paper types will be reset to the default. The
display returns to Ready.
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3.10 Paper Handling

3.10.11 Selecting the Output Stack

The Stack Select menu on the operator panel allows you to select either the face-down tray
or the face-up tray for the output stack.

1
2

h @

0 N

Press the MENU key.

Press the A or V key repeatedly until Paper Handling > appears.

Paper Handling >

Press the > key.

Press the A or V key repeatedly until >Stack Select appears.

>Stack Select
Face-down tray

To change the output stack, press the ENTER key. A blinking question mark (?)
appears.

fStack Select
\

’
? Face-down tray
1S

Press the A or V key to toggle through the following output stacks:

Face-down tray
Face-up tray

When the desired output stack is displayed, press the ENTER key.

To exit the menu selection, press the MENU key.
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3.11 Selecting Monochrome or Color Printing

3.11 Selecting Monochrome or Color Printing

You can use the Color Mode menu on the operator panel to select the Monochrome or Color
printing mode. By default, the printer is set to print in color mode. To change it to
monochrome mode, proceed as follows:

1 Press the MENU key.

2 Press the A or V key repeatedly until Color Mode appears.

Color Mode
Color

3 To change color mode, press the ENTER key. A blinking question mark (?) appears.

?olor Mode
\ls

? Color
/|\

Press the A or V key to change color mode — Color or Monochrome.

B

When the desired color mode is displayed, press the ENTER key. Color mode is
changed.

a

6 To exit the menu selection, press the MENU key.
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3.12 Reading Life Counters

You can display the total number of pages printed by your printer whenever it is necessary.
The total number of printed pages can also be checked on the status page. See section 3.3.2
Printing a Status Page on page 3-17. For proper maintenance scheduling, you need to reset
the toner counter using this menu each time a new toner container is installed.

3.12.1 Displaying the Total Printed Pages

This procedure displays the total number of printed pages. You cannot change the displayed
value.

1 Press the MENU key.

2 Press the A or V key repeatedly until Life Counters > appears.

Life Counters >

Press the > key.

()

Press the A or V key repeatedly until >Total Print appears and the latest total
print count is shown.

H

>Total Print
0123456

5 To exit the menu selection, press the MENU key.
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3.12 Reading Life Counters

3.12.2 Resetting the Toner Counter

The toner containers must be replaced when the printer displays the Low toner or
Replace toner message which will be given depending on the color of toner. The Low
toner message will be shown as a pre-warning that the toner is running out and the printer
will soon stop, at that time showing Replace toner. If you replace the toner container
before Replace toner is displayed, you must manually reset the toner counter as
explained below.

Note that if you reset the toner counter before the toner container is replaced, the subsequent
toner warnings will not be indicated correctly.

1

ON

S

® N

Replace the toner container according to the message given on the message display.
To replace the toner containers, see Chapter 5 Maintenance, section 5.1 Toner
Container Replacement on page 5-2.

Press the MENU key.

Press the A or V key repeatedly until Life Counters > appears.

Life Counters >

Press the D> key.
Press the A or V key repeatedly until the message display shows the toner container
of the color you replaced — [Clyan, [M]agenta, [Y ]ellow, or blac[K]. For example,

to reset the Cyan toner counter, display >New Toner [C] Installed.

Press the ENTER key. A question mark (?) appears.

>New Toner [C]
Installed ?

Press the ENTER key. The toner counter is reset.

To exit the menu selection, press the MENU key.
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The following modes can be accessed in the Others submenu:

Message Language

Automatic Form Feed Timeout Setting
Sleep Timer Setting

Received Data Dumping

Printer Resetting

Resource Setting

Alarm (Buzzer) Setting

Auto Continue Setting

Duplex Printing Error Detection Setting
Color Registration

Service Menu (for service personnel)
Color Calibration

3.13.1 Selecting the Message Language

3.13 Other Modes

You can select the language of the messages on the message display by following the
procedure given below. You can optionally download messages in other languages. Contact
your Kyocera Mita dealer for information.

1
2

Hh @

Press the MENU key.

Press the A or V key repeatedly until Others > appears.

Others >

Press the [> key.

Press the A or V key repeatedly until >MSG Language appears. The default

message language is English.

>MSG Language
English

To change the language, press the ENTER key. A blinking question mark (?)

appears.

fMSG Language

s )
? English
71
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~

Press the A or V key. The display cycles through the available selection in the
following order:

English
Francais
Deutsch
Italiano
Nederlands
Espafiol
Portugués

Press the ENTER key.

Press the MENU key. The display returns to Ready.

3.13.2 Automatic Form Feed Timeout Setting

If the printer receives no data for a certain period, it will time out and release the current
interface. It prints whatever data it has in its buffer and feeds out the page. The default form
feed timeout time is 30 seconds. You can adjust the time-out time as follows:

1
2

A W

~

Press the MENU key.

Press the A or V key repeatedly until Others > appears.

Others >

Press the D> key.

Press the A or V key repeatedly until >Form Feed Time Out appears.

>Form Feed
Time Out 030sec.

To change the timeout time, press the ENTER key. A blinking cursor (_) appears.

>Form Feed

Time Out O3‘O'sec .
RS

Press the A or V key to increase or decrease the value at the blinking cursor and set
the desired time. The timeout time can be between 0 and 495 seconds, in 5-second
increments. Use the [> and <] keys to move the cursor right and left.

When the desired timeout time is displayed, press the ENTER key.

To exit the menu selection, press the MENU key.
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3.13.3 Setting the Sleep Timer

The printer has a sleep timer that is used to conserve power when the printer is not printing,
processing, or receiving data. You can turn off or on the sleep timer function using the
following procedure.

1 Press the MENU key.

2 Press the A or V key repeatedly until Others > appears.

Others >

Press the > key.

W

Press the A or V key repeatedly until >Sleep Timer > appears.

H

>Sleep Timer >
015 min.

5 Press the > key and display >>Sleep Mode.

>>Sleep Mode
On

6 To turn off the sleep timer, press the ENTER key. A blinking question mark (?)
appears.

>Sleep Mode
N St

? On
71N

7 Press the A or V key to change On to Of£.

f>Sleep Mode

\ly
? Off
1S

Press the ENTER key. The sleep timer is turned off.

To exit the menu selection, press the MENU key.
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Sleep Timer Timeout Time

You can adjust the timer timeout time, the length of time the printer waits before entering
sleeping mode in the absence of data. The default sleep timer timeout time is 15 minutes.

The printer reverts to normal operation mode when the printer receives a print job, the
operator panel is operated, or one of the exterior covers is opened.

Color calibration is automatically executed before the printer reverts to
‘ ; normal operation mode.

Note

To confirm and change the timeout time, proceed as follows:

1 Press the MENU key.

2 Press the A or V key repeatedly until Others > appears.

Others >

Press the D> key.

(%)

Press the A or V key repeatedly until >Sleep Timer > appears.

B

>Sleep Timer >
01l5min.

5 To change the timeout time, press the ENTER key. A blinking cursor (_) appears.

>Sleep Timer
015fin.
s

6 Press the A or V key to increase or decrease the value at the blinking cursor and set
the desired time. The timer can be set between 5 and 240 min, in 5-minute
increments. Use the [> and <] keys to move the cursor right and left.

When the desired timeout time is displayed, press the ENTER key.

~

To exit the menu selection, press the MENU key.
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3.13.4 Received Data Dump

You can print data received by the printer as hexadecimal code for debugging programs and
files.

1 Press the MENU key.

2 Press the A or V key repeatedly until Others > appears.

Others >

Press the > key.

W

Press the A or V key repeatedly until > Print HEX-DUMP appears.

H

>Print HEX-DUMP

5 Press the ENTER key. A question mark (?) appears.

>Print HEX-DUMP?

6 Press the ENTER key again. The message Processing appears for a second,
followed by Waiting.

Processing

v

Waiting

7 While the message display is indicating Waiting (for 30 seconds by default), send
data to be hex-dumped to the printer. The message display indicates Processing
while the data is being received.

You can cancel printing of any more dump data by pressing the GO key and then the
CANCEL key.

8 Once all data has been received, the message Waiting will appear. Press the GO
key to finish hex-dump printing.

3-93

Download from Www.Somanuals.com. All Manuals Search And Download.
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3.13.5 Printer Resetting

The procedure described below resets the printer’s temporary conditions, such as the current
page orientation, font, etc., set by commands to their default values. Downloaded fonts and
macros are deleted from the printer’s memory.

1 Press the MENU key.

2 Press the A or V key repeatedly until Others > appears.

Others >

Press the D> key.

(%)

Press the A or V key repeatedly until >Printer Reset appears.

B

>Printer Reset

5 To reset the printer, press the ENTER key. A question mark (?) appears.

>Printer Reset ?

6 Press the ENTER key again. Self test appears while the printer is resetting
itself, followed by Please wait and then Ready.

Self test

) 4

Please wait

\ 4

Ready
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3.13.6 Resource Protection

By default, when you switch from the PCL 6 emulation to another, all downloaded fonts and
macros will be lost. Resource protection preserves these PCL resources in memory so that
they remain intact even when you have switched back in PCL 6.

Resource protection requires extra memory to store the downloaded fonts
‘ i and macros. The total size of the printer memory recommended for using
— the resource protection option is affected by several factors. See Appendix

Note A Options.

By default, resource protection is deactivated. To activate resource protection, proceed as
follows:

1 Press the MENU key.

2 Press the A or V key repeatedly until Others > appears.

Others >

Press the > key.

W

Press the A or V key repeatedly until >Resource Prot. appears.

H

>Resouce Prot.
offt

5 Press the ENTER key. A blinking question mark (?) appears.

fResouce Prot.
\l,

? Off
71>

6 Press the A or V key to select Permanent or Perm / Temp (Permanent/
Temporary) for resource protection.

When the desired resource protection is displayed, press the ENTER key.

n]

8 To exit the menu selection, press the MENU key.
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3.13.7 Alarm (Buzzer) Setting

You can set an alarm sound in addition to the message displayed when the paper supply is
exhausted, or when paper jamming occurs. This setting is useful, for example, when the
printer is located some distance from the user.

The audio alarm is set to On when leaving the factory. If the alarm is set to Of £, it will not
sound.

1 Press the MENU key.

2 Press the A or V key repeatedly until Others > appears.

Others >

Press the D> key.

(%)

Press the A or V key repeatedly until Buzzer appears.

B

>Buzzer
On

5 Press the ENTER key. A blinking question mark (?) appears.

\f}%uzzer

? On
/l\

Select On or Of £ using the A or V key.

Press the ENTER key.

~

To exit the menu selection, press the MENU key.
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3.13.8 Auto Continue Setting

If an error that still allows you to continue printing occurs (Memory overflow Press
GO, Print overrun Press GO,KPDL error Press GO,File not found
Press GO,RAM disk error Press GO,MemoryCard err Press GO, Hard
disk err Press GO, and Duplex disabled Press GO), the next received data
is automatically printed after a set period of time elapses. For example, if the printer is
shared over a network as a network printer and one person causes one of the above errors,
after the set period of time elapses, the data sent from the next person is printed. The default
setting is Of £ (Auto Continue disabled).

0 For setting the auto continue recovery time, see the next section.

Note

1 Press the MENU key.

2 Press the A or V key repeatedly until Others > appears.

Others >

Press the > key

()

Press the A or V key repeatedly until Auto Continue > appears.

H

>Auto Continue >
Mode Ooff

5 Press the ENTER key. A blinking question mark (?) appears.

>Auto ?ontinue

\Iy
Mode ? Off
/|\

Select On or Of f using the A or V key.

o

Press the ENTER key.

n]

To exit the menu selection, press the MENU key. The display returns to Ready.
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3.13.9 Setting the Auto Continue Recovery Time

Follow the procedure given below to change the recovery time for Auto Continue.

1
2

A W

o ®

Press the MENU key.

Press the A or V key repeatedly until Others > appears.

Others >

Press the D> key.

Press the A or V key repeatedly until Auto Continue Mode > appears.

>Auto Continue >
Mode On

Press the > key and display >> Auto Continue Timer. The default setting is
30 seconds.

>>Auto Continue
Timer 030sec.

Press the ENTER key. A blinking cursor (_) appears.

>>Auto Continue

Timer O?é’sec.
1N

Press the A or V key to increase or decrease the value at the blinking cursor and set
the desired time. The time must be set between 000 and 4 95 seconds, in 5-second
increments. If set to 000, printing will be continued immediately without any time
interval. You can use the [> and < keys to move the cursor right and left.

Display the desired time and press the ENTER key.

Press the MENU key. The display returns to Ready.
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3.13.10 Duplex Printing Error Detection Setting

If the error detection setting for duplex printing has been turned On, and you attempt to print
onto a paper size and paper type that cannot be used for duplex printing, the Duplex
disabled Press GO error message will be displayed and printing will stop. To print
onto one-side of the paper only when this message is displayed, press the GO key. The
default setting is Of £.

1 Press the MENU key.

2 Press the A or V key repeatedly until Others > appears.

Others >

Press the > key.

W

Press the A or V key repeatedly until >Finishing Error > appears.

H

>Finishing >
Error

5 Press the [> key and display >>Duplex.

>>Duplex
Off

6 Press the ENTER key. A blinking question mark (?) appears.

>Duplex
JPuP

? Off
71N

7 Press the A or V key to change Of £ to On.

>Dupl
\f, uplex

? On
l|\

Press the ENTER key.

To exit the menu selection, press the MENU key.
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3.13.11 Color Registration

When using the printer for the first time after set-up or after having moved it, or if printout
of any color (cyan, magenta or yellow) is skewed, use this mode to correct the color
registration on the operator panel.

1
2

A W

o O

Press the MENU key.

Press the A or V key repeatedly until Others > appears.

Others >

Press the D> key.

Press the A or V key repeatedly until >Color Registration > appears.

>Color >
Registration

Press the D> key.

Press the A or V key repeatedly until >>Print Regist Chart appears.

>>Print
Regist Chart

Press the ENTER key. A question mark (?) appears.

>>Print
Regist Chart ?
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3.13 Other Modes

Press the ENTER key. Processing appears and a color registration correction

chart is printed out. There are left (L), horizontal (H) and right (R) registration charts
for each color (cyan, magenta and yellow) included on the color registration

correction chart.
Color Registration Correction Chart
A -1
-7 —7
-6—— —-6
-5—— —-5
i —-2
-3—— —3
o= ==
o— L —0
+1 +1
+2 +§
b
Ii Cyan +4
+5 "‘g
e H ]
= L] A
A VINFMNMANHOAXV~VINHIMANHOHNMANWOSOANOHNM IO~ N
HeHAAAAAAAA L *++r et rrivdci e
LI T A U B I B S A A o T o
-
a——
o
Y
<y
i
- J—
it
o— L
+1
+2
4
s Magenta
i3 H
S= L] UL
i is At SRS St dnb b pals T i R i
L T T R I R I B § +++4+++++++
ik Color registration procedure =
-7 — —-7
-6— —6
—g _— 1. For each color of the diagrams, identify the colored line which is most closely aligned —-5
:% = with the black line for L, H, and R. ::%
:i s 2. Enter the figure of L, H, and R using the Color Registration menu ::%
0— L onthe operator panel keys. — 0
+1=— =l
:% e Refer to the Operation Guide. ::g
s Yellow wtd
s H 1
+8— ._+g
— —+
* LLELEEEL UL L L il bt ol el Ol e o
Dy e T T F R TR 033325533
LI T T O O A I +++++++++ 4+
Figure 3-16

>>Ad]j
1=

ust Cyan
H= R=

10

flash under the left (L) value.

Press the A or V key repeatedly until >>Adjust Cyan appears.

Press the ENTER key. 0 or 00 will be displayed for each value and the cursor will

>>Adjust Cyan
L=‘E’H= 00 R= 0
21N
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1 1 Look at the left chart (L) in the cyan portion of the color registration correction chart.
Find the two lines that most seem to overlap as a single straight line and note the
number value listed there. In the example below the value would be -2. (Be careful of
plus [+] and minus[-] numbers.)

9——
8 —
-7 —
-6 ———
5
S/ Q—

§<
0o—— L

+1 —
+2——
+3—
+4 —
+5—
+6 —
+7—
+8—
+9—

Color Registration Correction Chart

[LATATLTALALULY

SRR

[HTTHU Y

WL

Figure 3-17

1 2 Press the A or V key until that value is displayed.

>>Adjust Cyan
L=-2 H= 00 R= 0

13 Use the [> and <] keys to move the cursor right and left. Perform the same operation
as you did for the left (L) value in order to find the horizontal (H) and right (R) values
for cyan in the color registration correction chart, and select those values on the
operator panel as well.

1 4 Press the ENTER key. OK? and each of the entered values will be displayed. If the
displayed values are correct, press the ENTER key.

OK?
L=-2 H= 00 R=+1

1 5 Press the V key. >>Adjust Magenta will be displayed and, once you complete
the settings for that color, >>Adjust Yellow will be displayed as well. Perform
the same operation as you did for the cyan chart in order to find the values for
magenta and yellow in the color registration correction chart, and perform those
settings in the same way.

16 Once you have completed the settings for all 3 colors, press the MENU key. The
display returns to Ready:.

If the problem of skewed-color printout still persists even after
6 correcting the color registration, call for service.

3-102

Download from Www.Somanuals.com. All Manuals Search And Download.



3.13 Other Modes

3.13.12 Printing the Service Status Page

The service status page contains printer settings information that is more detailed than the
standard status page and is therefore mostly for service purposes. However, since there is a
great deal of information on the service status page that may be useful to you, the procedure
for printing it out is given below.

1 Press the MENU key.

2 Press the A or V key repeatedly until Others > appears.

Others >

Press the > key.

W

Press the A or V key repeatedly until >Service > appears.

H

>Service >

Press the > key.

A

Press the A or V key repeatedly until >>Print Status Page appears.

o

>>Print
Status Page

7 Press the ENTER key. A question mark (?) appears.

>>Print
Status Page ?

8 Press the ENTER key. The display indicates Processing and printing starts.
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3.13 Other Modes

3.13.13 Color Calibration

This printer contains a calibration function that automatically makes adjustments in
compensation for secular changes that occur over time due to variations in the ambient
temperature and humidity. So that the highest quality color printing can be maintained, this
color calibration operation is carried out automatically each time the power to the printer is
turned on. The color calibration operation may be carried out automatically during recovery
from the Sleep mode or during printing.

To manually carry out the color calibration operation, perform the following procedure.

1
2

A W

o 0

Press the MENU key.

Press the A or V key repeatedly until Others > appears.

Others >

Press the D> key.

Press the A or V key repeatedly until >Service > appears.

>Service >

Press the D> key.

Press the A or V key repeatedly until >>Color Calibration appears.

>>Color
Calibration

To let the printer perform color calibration, press the ENTER key. A question mark
(?) appears to let you confirm the execution of calibration.

>>Color
Calibration ?

Press the ENTER key. The message display shows Please wait
(Calibrating) and calibration will start.

Please wait
(Calibrating)

When calibration is finished, the display returns to Ready.
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Chapter4 Troubleshooting

This chapter explains how to handle printer problems that may occur. If a problem cannot be
corrected, contact your Kyocera Mita dealer. This chapter explains the following topics:

*  General Guidelines

*  Print Quality Problems
e Error Messages

*  Clearing Paper Jams
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4.1 General Guidelines

4.1 General Guidelines

The table below provides basic solutions for problems you may encounter with the printer.
We suggest you consult this table to troubleshoot the problems before calling for service.

Symptom Check Items Corrective Action

Print quality isnot ~ See Section 4.2 Print Quality Problems on page 4-3.
good.

Paperis jammed.  See Section 4.4 Clearing Paper Jams on page 4-12.

Nothing lights on ~ Check that the power cord is properly Turn off the printer’s power, plug in the

the operator panel  plugged into the power outlet. power cord securely, and try turning on
even when power is the printer’s power again.
turned on and th? Check that the power Set the power switch to the On position.
fan makes no noise. N

switch is in the On (])

position.

The printer prints a Check the printer cable or the interface Connect both ends of the printer cable
status page, but cable. securely. Try replacing the printer cable
does not print jobs or the interface cable.

from the computer. Check program files and application ~ Try printing another file or using another

software. print command. If the problem occurs
only with a specific file or application,
check the printer driver settings for that
application.

Table 4-1

411 Tips

Printer problems may be solved easily by following the tips below. When you have
encountered a problem that following the above guidelines will not solve, try the following:

*  Turn the printer power off and wait for several seconds. Then, turn on the printer.
*  Reboot the computer which sends the print jobs to the printer.

*  Obtain and use the latest version of the printer driver. The latest versions of printer
drivers and utilities are available at: http://www.kyoceramita.com/download/.

*  Make sure that the procedures for printing are correctly followed in the application
software. Consult the documentation supplied with the application software.

» If the printer prints garbage characters or stalls when the computer is turned on,
particularly when the printer is connected to the computer under Windows 98 via the
parallel port, rename device driver file drvwppqt.vxd. This file may be located in
Windows\System\losubsys or Arcada\System folder. For technical details, visit
Microsoft web site for the device driver.
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4.2 Print Quality Problems

Print Quality Problems

The tables and diagrams in the following sections define print quality problems and the
corrective action you can conduct to solve the problems. Some solutions may require

cleaning or replacing parts of the printer.

If the suggested corrective action will not solve the problem, call for service.

Printed Results

Corrective Action

Completely blank printout

Check the toner containers.

Open the printer top cover and check that the toner
containers are correctly installed in the printer. For
more information on installing the toner containers,
see Chapter 5 Maintenance, section 5.1 Toner Con-
tainer Replacement on page 5-2.

Check that the application software is correctly
operated.

Full single-color printout

Check the charger unit.

Open the left cover and check that the charger unit
is correctly installed.

Check the advanced beam array lens cleaners.

Open the left cover and make sure that the lens
cleaners are securely pushed all the way into the
printer. For full details, see Chapter 5 Maintenance,
section 5.3.3 Cleaning the Advanced Beam Array
Lenses on page 5-17

Dropouts, horizontal streaks, stray dots

ABC
123

123

ABC
123

Clean the main charger units.

Open the left cover. Slowly pull the green wire
cleaner knob to each of the main charger units in
and out a few times. For full details, see Chapter 5
Maintenance, section 5.3.1 Cleaning the Main
Charger Unit on page 5-11.

Table 4-2

4-3
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4.2 Print Quality Problems

Printed Results

Corrective Action

Black or white vertical streaks

ABC
123

ABC
123

Direction
of Paper
Feed

Check the operator panel for toner.

Ifthe Toner low (C/M/Y/K) message is dis-
played with color description, install a new toner kit
for the color. To replace the toner container, see
Chapter 5 Maintenance, section 5.1 Toner Con-
tainer Replacement on page 5-2.

Clean the main charger units.

Open the left cover. Slowly pull the green wire
cleaner knob to each of the main charger units in
and out a few times. For full details, see Chapter 5
Maintenance, section 5.3.1 Cleaning the Main
Charger Unit on page 5-11.

Clean the advanced beam array lenses.

Open the left cover. Slowly pull the green lens
cleaner knob in and out 2 times. For full details, see
Chapter 5 Maintenance, section 5.3.3 Cleaning the
Advanced Beam Array Lenses on page 5-17.

Faint or blurred printing

ABC
123

A
123

ABC
123

Clean the main charger units.

Open the left cover. Slowly pull the green wire
cleaner knob to each of the main charger units in
and out a few times. For full details, see Chapter 5
Maintenance, section 5.3.1 Cleaning the Main
Charger Unit on page 5-11.

Clean the advanced beam array lenses.

Open the left cover. Slowly pull the green lens
cleaner knob in and out 2 times. For full details, see
Chapter 5 Maintenance, section 5.3.3 Cleaning the
Advanced Beam Array Lenses on page 5-17.

Make sure the paper type setting is correct the paper
being used. See Chapter 3 Using the Operator
Panel, section 3.10.5 Setting the Cassette Paper
Type on page 3-76.

Conduct color calibration either by switching the
printer off then on or using the printer operator
panel. For full details, see Chapter 3 Using the
Operator Panel, section 3.13.13 Color Calibration
on page 3-104.

Try adjusting the color control settings using the
printer driver.

Check the operator panel. If the Toner low (C/
M/Y/K) message is displayed with color descrip-
tion, install a new toner kit for the color. To replace
toner, see Chapter 5 Maintenance, section 5.1
Toner Container Replacement on page 5-2.

Table 4-2 (Continued)
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4.2 Print Quality Problems

Printed Results Corrective Action

Grey background Clean the main charger units.

Open the left cover. Slowly pull the green wire
cleaner knob to each of the main charger units in
and out a few times. For full details, see Chapter 5
Maintenance, section 5.3.1 Cleaning the Main
Charger Unit on page 5-11.

Check the charger units installation.

Open the left cover and check that the charger units
are correctly installed and seated as far as it will go.
See Chapter 5 Maintenance, section 5.3 Cleaning
the Printer on page 5-11.

Conduct color calibration either by switching the
printer off then on or using the printer operator
panel. For full details, see Chapter 3 Using the
Operator Panel, section 3.13.13 Color Calibration
on page 3-104.

Dirt on the top edge or back of the paper  Check the paper chute and the ramp.

Pull out the paper transfer unit and check for toner
on the paper ramp. Clean the paper ramp using a
soft, dry, lint-free cloth. For details, see Chapter 5
Maintenance, section 5.3.2 Cleaning the Paper
Transfer Unit on page 5-16.

Clean the main charger units.

Open the left cover. Slowly pull the green wire
cleaner knob to each of the main charger units in
and out a few times. For full details, see Chapter 5
Maintenance, section 5.3.1 Cleaning the Main
Charger Unit on page 5-11.

Clean the parts in the paper paths—such as the
paper cassette, etc.

Check the transfer roller.

If the transfer roller is dirty with toner, try printing
several pages.

Table 4-2 (Continued)
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4.2 Print Quality Problems

Printed Results

Corrective Action

Printing incomplete or out of position

ABC

139

Check that the application software is correctly
operated.

See 4.1.1 Tips on page 4-2.

Skewed-color printout

ABC

Conduct color registration using the printer opera-
tor panel. For full details, see Chapter 3 Using the
Operator Panel, section 3.13.11 Color Registration
on page 3-100.

Table 4-2 (Continued)
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Error Messages

4.3 Error Messages

The following table lists errors and maintenance messages that you can be dealt with by
yourself. If Call service appears, turn off the printer, disconnect the power cord, and
contact your Kyocera Mita dealer.

Some errors cause the alarm sound to sound. To stop the alarm sound, press the CANCEL
key to stop the alarm sound.

Message

Corrective Action

Add paper MPTray

The paper has run out in the paper source displayed. Supply paper according
to the paper source displayed (paper cassettes, MP tray, optional paper feed-
ers, or optional envelope feeder).

This message is displayed alternately with messages indicating the printer
status, such as, Ready, Please wait, Processing,Waiting,and
Form Feed Time Out. Ifthenumber of copies to printis 2 or more,
only the Add paper message is displayed.

Call service
Fé#i#t:

F##4# represents a controller error (#=0, 1, 2, ...). Call for service. The
printer does not operate when this message is displayed.

Call service
####:0123456

## # # represents a mechanical error (#=0, 1, 2, ...). Call for service. The
printer does not operate when this message is displayed. The total number of
pages printed is also indicated, e.g. 01234 56.

Call service
Person FO

This message means an error in data communications between the printer
controller and the operator panel. Call for service.

Cassette #
not loaded

The corresponding paper cassette is not installed. Install the cassette. The
cassette number can be 1 (topmost) to 4 (bottom).

Check waste
toner box

This message warns following two cases. Install the new waste toner box.

*  The waste toner box is not installed.
*  The waste toner box is almost full.

Clean printer
Press GO

Please clean the inside of the printer. See Chapter 5 Maintenance, section
5.3 Cleaning the Printer on page 5-11.

This message will be displayed when replacing the toner container after the
message Replace toner C, M, Y, Kisdisplayed. After cleaning the
inside of the printer, press the GO key and the printer will be ready for print-
ing.

If Auto Continue is set to On, printing will be automatically resumed after a
preset period of time. For details on Auto Continue, refer to Chapter 3 Using
the Operator Panel, section 3.13.8 Auto Continue Setting on page 3-97.

Close duplexer
rear unit

The rear unit of the optional duplexer is open. Close the duplexer rear unit.

Close duplexer
top cover

The top cover of the optional duplexer is open. Close the duplexer top cover.

Close paper
transfer unit

The paper transfer unit is open. Close the paper transfer unit.

Table 4-3
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4.3 Error Messages

Message

Corrective Action

Close
left cover

The left cover of the printer is open. Close the left cover.

Close
rear cover

The rear cover of the printer is open. Close the printer rear cover.

Close
top cover

The top cover of the printer is open. Close the printer top cover.

Duplex disabled
Press GO

You attempted to print with a paper size and paper type that cannot be used
for duplex printing. Press the GO key to print onto one-side of the paper
only.

Face-down tray
paper full

The face-down tray has become full (approx. 250 pages). You must remove
all printed pages from the face-down tray. When the printer detects that the
face-down tray is empty again, the printer will continues printing into the
face-down tray.

File not found
Press GO

Youhave attempted to print a job that is not contained in the specified virtual
mailbox, or the specified virtual mailbox is not found.

If Auto Continue is set to On, printing will be automatically resumed after a
preset period of time. For details on Auto Continue, refer to Chapter 3 Using
the Operator Panel, section 3.13.8 Auto Continue Setting on page 3-97.

Format error
Hard disk

The hard disk installed in the printer is not formatted, and therefore cannot
be read or written. To format the hard disk, follow the procedure in the
Installation Guide of the hard disk.

Format error
Memory card

The memory card inserted in the printer is not formatted, and therefore can-
not be read or written. To format a memory card, follow the procedure in
Chapter 3 Using the Operator Panel, section Formatting a Memory Card
on page 3-63.

Hard disk err ##
Press GO

A hard disk error has occurred. Look at the error code given in place of ##
and refer to Storage Error Codes on page 4-11. To ignore the hard disk error,
press the GO key.

I/F occupied

This message is displayed when you attempt to use the printer’s operator
panel to change the environmental settings on the interface from which data
are presently being received.

ID error

Theuser ID entered for a private job, or a stored job is not correct. Check the
user ID that you specified on the printer driver.

Insert the same
memory card

Youhave inserted the wrong memory card when the Insert again mes-
sage was displayed. Remove the wrong memory card from the printer’s
memory card slot and insert the correct memory card. The printer again
reads it from the beginning of the data.

Install MK

Replace Maintenance Kit which is displayed on the message display.
Replacement of the maintenance kit is necessary at every 200,000 images of
printing and requires professional servicing. Contact your Kyocera Mita
dealer.

KPDL error ##
Press GO

Current print processing cannot continue because of occurrence of KPDL
error which is categorized by ##. To print out an error report, display >
Print KPDL err(s)from the menu system, and select On. Press the GO
key to resume printing. You can abandon printing by the CANCEL key.

If Auto Continue is set to On, printing will be automatically resumed after a
preset period of time. For details on Auto Continue, refer to Chapter 3 Using
the Operator Panel, section 3.13.8 Auto Continue Setting on page 3-97.

Table 4-3 (Continued)
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4.3 Error Messages

Message

Corrective Action

Load Cassette #
(a4)/(pLAIN)T

The paper cassette matching the paper size and paper type of the print job is
empty. Load paper into the paper cassette as displayed in place of #. Press
the GO key to resume printing.

If you want to print from a different paper source, press the A or V key to
display Use alternative andyou canchange the source for paper
feeding. After selecting a paper source and pressing the MENU key, Paper
Handling > appears. By pressing the A key, the paper type settings menu
appears. After setting the correct paper type, press the ENTER key and
printing starts. For details, see Chapter 3 Using the Operator Panel, section
3.10.6 Selecting the Paper Feed Source on page 3-77.

Load EF
(a5)/(PLAIN)

There is no paper cassette installed in the printer that matches the paper size
and paper type of the print job. Set paper in the envelope feeder. Press the
GO key to resume printing. (Note that feeding the paper having a paper size
which does not match the current paper size from the envelope feeder can
cause paper jam.)

If you want to print from a different paper source, press the A or V key to
display Use alternative andyoucanchange the source for paper feed-
ing. After selecting a paper source and pressing the MENU key, Paper
Handling >appears. By pressing the A key, the paper type settings menu
appears. After setting the correct paper type, press the ENTER key and
printing starts. For details, see Chapter 3 Using the Operator Panel, section
3.10.6 Selecting the Paper Feed Source on page 3-77.

Load MP Tray
(a4)/(PLAIN)T

There is no paper cassette installed in the printer that matches the paper size
and paper type of the print job. Set paper in the MP tray. Press the GO key
to resume printing. (Note that feeding the paper having a paper size which
does not match the current paper size from the MP tray can cause paper jam.)

If you want to print from a different paper source, press the A or V key to
display Use alternative and you canchange the source for paper
feeding. After selecting a paper source and pressing the MENU key, Paper
Handling > appears. By pressing the A key, the paper type settings menu
appears. After setting the correct paper type, press the ENTER key and
printing starts. For details, see Chapter 3 Using the Operator Panel, section
3.10.6 Selecting the Paper Feed Source on page 3-77.

Memory card err
Insert again

The memory card is accidentally removed from the printer’s memory card
slot during reading. If you continue reading the memory card, insert the
same memory card into the slot again. The printer again reads it from the
beginning of the data.

Alsosee Tnsert the same memory card.

Memory overflow
Press GO

The total amount of data received by the printer exceeds the printer’s inter-
nal memory. Try adding more memory. Press the GO key to resume print-
ing. You can abandon printing by the CANCEL key.

If Auto Continue is set to On, printing will be automatically resumed after a

presetperiod of time. For details on Auto Continue, refer to Chapter 3 Using
the Operator Panel, section 3.13.8 Auto Continue Setting on page 3-97

MemoryCard err##
Press GO

A memory card error has occurred. Look at the error code given in place of
## and refer to Storage Error Codes on page 4-11. To ignore the memory
card error, press the GO key

Missing
duplex drawer

The duplex drawer is either not installed or incorrectly inserted. Insert the
duplex drawer securely.

Paper jam

idaddssaasddssdi

A paper jam has occurred. The location of the paper jam is indicated in place
of the #’s. For details, see Section 4.4 Clearing Paper Jams on page 4-12.

Table 4-3 (Continued)
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4.3 Error Messages

Message

Corrective Action

Paper path error

There is no paper cassette in the feeder, or the cassette is not inserted prop-
erly. After reinserting the paper cassette, you should be able to print. When
two or more optional feeders are installed and the lowest one is selected, the
same message will appear if any of the upper paper feeder and the printer
cassette is improperly installed.

Print overrun'f
Press GO

The print job transferred to the printer was too complex to print on a page.
Press the GO key to resume printing. (A page break may be automatically
inserted in some places.).

You can abandon printing by the CANCEL key.

If Auto Continue is set to On, printing will be automatically resumed after a
preset period of time. For details on Auto Continue, refer to Chapter 3 Using
the Operator Panel, section 3.13.8 Auto Continue Setting on page 3-97

RAM disk error##
Press GO

A RAM disk error has occurred. Look at the error code given in place of # #
and refer to Storage Error Codes on page 4-11. To ignore the RAM disk
error, press the GO key.

Replace toner
c,M,Y, K

v 4

Replace toner
Clean printer

Two message items are displayed alternately. Toner has run out in the toner
container(s). Replace the toner container using a new toner kit for the partic-
ular color. The printer does not operate when this message is displayed.

Forexample,ifReplace toner C,Kisdisplayed, replace the cyan and
the black toner containers.

Set paper
Press GO

The MP tray is out of paper. Load paper and press the GO key. (Note that
feeding the paper having a paper size which does not match the current
paper size from the MP tray can cause paper jam.)

Toner low
c,M,Y,K

Replace the toner container using a new toner kit. Color of the toner con-
tainer that needs to be replaced is represented by C (Cyan), M (Magenta), Y
(Yellow), and K (Black).

Virtual mailbox
full

The storage area in the hard disk for the virtual mailboxes is full. Print out
accumulated jobs in the virtual mailboxes.

Warning
low memory

The printer’s internal memory is running low due to too many numbers of
fonts and macros downloaded. Try deleting unnecessary fonts and macros.

Table 4-3 (Continued)

T Messages separated by ‘()/( )’ are displayed alternately.

+1  After this error has happened, page protect mode will be automatically turned on. To maintain op-
timum use of memory during printing, we recommend you manually turn off page protect mode.
See Chapter 3 Using the Operator Panel, section 3.7.3 Page Protect Mode on page 3-54.
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4.3 Error Messages

Storage Error Codes

Hard Disk Errors

Code Meaning

01 Hard disk format error. If this error recurs even if the power has been turned off and then on,
reformat the hard disk.

02 The disk system is not installed. Recheck the requirements for using the system and the
devices.

04 There is no available hard disk space. Delete unnecessary files, etc., in order to free up space.

05 The specified file does not exist in the hard disk.

06 There is no memory available to the hard disk system. Increase the available memory.

10 Formatting is not possible because host data is being spooled on the hard disk. Wait until the

hard disk is ready, and then format.

85 VMB: Alias error. The alias setting was lost, or the virtual tray corresponding to the alias
does not exist. Set the alias again.

97 The number of permanent code jobs that can be stored reached the limit value, and no more
can be saved. Either delete some unnecessary jobs, etc., or increase the limit.

98 Anunreadable page was found in a job (The job is damaged.).
99 A print job for the specified ID does not exist in the hard disk.
Table 4-4

Memory Card Errors

Code Meaning

01 The printer does not support the memory card inserted. The memory card must meet the
requirements described in Appendix A Options, section A.3.1 Memory Card on page A-7.

02 The memory card is not installed.

04 The memory card is full and cannot hold further data. Purge unnecessary files or use a new
memory card.

05 Specified file is not on the memory card.

06 Insufficient printer memory to support the memory card system. Expand printer memory.

Table 4-5

RAM Disk Errors

Code Meaning

01 Format error. Try turning the power off and on again.
02 RAM disk mode is Of £. Turn RAM disk mode On from the operator panel.
04 No disk space. Purge unnecessary files.
05 Specified file is not on disk.
06 Insufficient printer memory to support the RAM disk system. Expand printer memory.
Table 4-6
4-11
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4.4 Clearing Paper Jams

Clearing Paper Jams

If the paper jammed in the paper transport system, or no paper sheets were fed at all, the
Paper Jjam message appears and the location of the paper jam (the component where the
paper jam has occurred) is also indicated. The printer automatically goes off-line when this
message is displayed. Remove jammed paper. After removing jammed paper, the printer

will re-start printing.

Possible Paper Jam Locations

The figure below explains the printer’s paper paths including the options. The locations
where paper jams might occur are also shown here, with each location explained in
Table 4-7 below. Paper jams can occur in more than one component on the paper paths.

Face-up Tray
PT-300

-

S ———— =

Duplex Unit | N N\
DU-300 Sy g -
Paper Feeder
- PF-60
Figure 4-1
Paper jam message Paperjam Description Reference
location page
Paper jam A Paper is jammed at the paper cassette. 4-14
Cassette 1
Paper jam B Paper is jammed at the optional paper 4-14
Cassette 2 (to 4) feeder’s cassette.
Paper jam C Paper is jammed inside the printer. 4-15
Printer 4-16
Table 4-7
4-12
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4.4 Clearing Paper Jams

Paper jam message Paperjam  Description Reference
location page
Paper jam D Paper is jammed at the MP tray or optional 4-17
MP Tray envelope feeder (if installed).
Paper jam
EF
Paper jam E Paper is jammed inside the rear cover of the 4-17
Duplexer optional duplexer or at the duplexer
drawer.
Table 4-7

4.4.2 General considerations for clearing jams

Bear in mind the following considerations when attempting jam removal:

are difficult to remove and may be easily overlooked, deterring the jam

J9 When pulling the paper, pull it gently so as not to tear it. Torn pieces of paper

recovery.

« Ifpaper jams occur frequently, try using a different type of paper, replace the paper with
paper from another ream, flip the paper stack over, or rotate the paper stack 180
degrees. Selection of paper is fully discussed in Chapter 2 Handling Paper on page 2-1.
The printer may have problems if paper jams recur after the paper was replaced.

*  Whether or not the jammed pages are reproduced normally after printing is resumed
depends on the location of the paper jam.

Utilizing Online Help Messages

Online help messages are available in the printer’s message display to provide simple
instructions for clearing jams. Press the (@) key when the paper jam message has appeared.
Then a help message will appear to facilitate jam clearing in the location.

4-13
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4.4 Clearing Paper Jams

44.3 Jam at the Paper Cassette

Paper is jammed at the paper cassette or inside the printer. Remove the jammed paper using
the procedure given below.

1 Pull out the paper cassette and remove the jammed paper.

Figure 4-2

2 If paper is jammed at the standard paper cassette (Cassette 1), open and close the
paper transfer unit (the paper jam error will be reset).

4-14
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4.4 Clearing Paper Jams

44.4 Jam at the Paper Transfer Unit

While pulling the green paper transfer unit release lever, pull out the paper transfer

unit.
Paper Transfer Unit
Release Lever
Paper Transfer Unit
Figure 4-3

2 If paper is jammed as shown in A, remove the paper by pulling the center up. If paper
is jammed as shown in B, remove the paper by pulling the edge.

Registration Roller

Figure 4-4

3 Push the paper transfer unit back in.
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4.4 Clearing Paper Jams

445 Jam at the Rear Cover

3

While pulling the green paper transfer unit release lever, pull out the paper transfer
unit.

Paper Transfer Unit
Release Lever

Paper Transfer Unit
Figure 4-5

Open the rear cover and then the fuser cover, and remove the jammed paper.

If the optional face-up tray is installed on the printer, remove that tray
‘ i first before attempting to remove the jammed paper.

Figure 4-6

The fuser unit inside the printer is hot. Do not touch it with your hands
6 as it may result in burn injury. Remove jammed paper carefully.

Push the paper transfer unit back in and close the fuser cover and rear cover.
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4.4 Clearing Paper Jams

44.6 Jam at the MP Tray

Paper is jammed at the MP tray. Remove the jammed paper using the procedure given
below.

1 Remove the paper jammed at the MP tray.

Figure 4-7

2 Open and close the paper transfer unit (the paper jam error will be reset).

4.4.7 Jam at the Optional Envelope Feeder
Paper is jammed at the optional envelope feeder. Remove the jammed paper using the same

procedure as for a jam at the MP Tray. Then, open and close the paper transfer unit. For
details, refer to the User’s Manual for the envelope feeder.

44.8 Jam at the Optional Duplexer

Paper is jammed inside the rear cover of the optional duplexer or at the duplexer drawer.
Refer to the Operation Guide for the duplexer and remove the jammed paper.
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Chapter 5 Maintenance

This chapter describes basic maintenance tasks you can perform on the printer. You can
replace the following component according to the printer’s display:

¢ Toner Kits
¢« Waste Toner Box

Also, the following parts need periodic cleaning:

*  Paper Transfer Unit
*  Main Charger Units
*  Advanced Beam Array Lenses
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5.1 Toner Container Replacement

5.1 Toner Container Replacement

5.1.1 Frequency of toner container replacement

The life of the toner containers depends on the amount of toner required to accomplish your
printing jobs. When 5 % coverage (a typical business document) of individual toner colors
is assumed for A4 or letter size paper in landscape orientation:

*  The black toner container lasts an average of 8,000 monochrome pages.
» The cyan, magenta, and yellow toner containers last an average of 8,000 color images.

You can print a status page to check how much toner remains in the toner container. For
details, see Chapter 3 Using the Operator Panel, section 3.3.2 Printing a Status Page on
page 3-17. The Toner Gauge section on the status page shows a progress bar for each color,
which roughly represents how much toner is left in the toner container.

Starter Toner Containers

The toner containers packed with the new printer are starter toner containers. The black
starter toner container lasts an average of 4,000 monochrome pages. The cyan, magenta, and
yellow starter toner containers last an average of 4,000 color images for each.

Toner Kits

It is strongly recommended to use the new Kyocera Mita Toner Kit supplied from Kyocera
Mita to prevent printer troubles and ensure a long printer life.

The toner kits are supplied in 4 different colors: cyan, magenta, yellow and black.

A new toner kit for each color contains the following items:

»  Toner Container

*  Cleaning cloth

*  Grid cleaner for main charger cleaning

» Plastic waste bags for old toner container and old waste toner box
*  Waste toner box

* Installation Guide

Do not remove the toner container from the carton until you are ready to
‘ i install it in the printer.

Note

5-2
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5.1 Toner Container Replacement

5.1.2 Understanding Messages Requesting Toner Container Replacement

The printer displays messages for individual colors at two stages of toner usage. This
message is automatically alternated with the other printer message (such as Ready):

*  When the printer becomes low on toner, for example in the cyan container, the printer
displays the message Toner low C, M, Y, K as the first caution. Note the replacement
is not always necessary at this stage.

» Ifyouignore the above message and continue printing, the printer displays the message
Replace Toner — just before the toner is used up. The toner container must be
replaced immediately. Clean the separate charger wires, etc. After the cleaning is
finished, however, the message does not automatically change to Ready. To restart
printing, you must press the GO key and make the printer ready.

In either case, to replace the toner container, see section 5.1 Toner Container Replacement
on page 5-2.

5-3
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5.1 Toner Container Replacement

5.1.3 Replacing the Toner Container

During toner container replacement, temporarily put storage media and
‘ i computer supplies (such as floppy disks) away from around the toner

Tt container. This is to avoid damaging media by the magnetism of toner.
ote

This section explains how to replace the toner containers. When replacing the toner
container of any color, always replace the waste toner box at the same time. If this box is
full, the printer may be damaged or contaminated by the waste toner that may spill over the
box.

Any data that may be under printing process in the printer will be deleted if

— you turn printer power off.
Note

0 You do not have to turn printer power off before starting the replacement.

To replace the toner container, first make sure of the color of the toner container requiring
replacement. In this example, it is assumed that you are replacing the black toner container.

1 Open the top cover.

Magenta (M)
Cyan (C)
Yellow (Y)
Black (K)

Top Cover

Figure 5-1

2 Pull the blue lock lever on the toner container forward towards the unlocked symbol

().
1 1
: i ahpy,
i
c—e {1 f
| o o o
L@ “° o ﬂ Lock Lever
Figure 5-2

5-4
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5.1 Toner Container Replacement

3 Carefully remove the old toner container from the printer.

1

—

2

Ed=i

Figure 5-3

Put the old toner container in the plastic bag (contained in the toner kit) and discard it
later according to the local code or regulations for waste disposal.

Plastic Bag

Figure 5-4

Take the new toner container out of the toner Kkit.

a

Shake the new toner container 5 or 6 times as shown in the figure in order to
distribute the toner evenly inside the container.

o

Figure 5-5

5-5
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5.1 Toner Container Replacement

7 Set the new toner container in the printer as shown in the figure below.

Figure 5-6

8 Push down on the top of the toner container to install it firmly in place.

Figure 5-7

5-6
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5.1 Toner Container Replacement

Pull the blue lock lever on the toner container back towards the locked symbol ( g )
as far as it will go.

o o o
[e)(e]
© Og Lock Lever

Figure 5-8

To replace the other color toner containers, use the same procedure above.

10 Close the top cover.

Figure 5-9

Proceed to the next section and replace the waste toner box.

5-7
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5.2 Replacing the Waste Toner Box

5.2 Replacing the Waste Toner Box

Replace the waste toner box each time you replace the toner container. A new waste toner
box is included with the toner kit. The printer will not operate without replacing the waste
toner box.

1 Open the left cover.

Left Cover Old Waste Toner Box
Figure 5-10

2 While holding the waste toner box, press the lock lever and then gently remove the
waste toner box.

Lock Lever

Figure 5-11

scatter the toner inside. Do not let the opening of the waste toner box

— face downward.
Note

g Remove the waste toner box as gently as possible so as not to

5-8
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5.2 Replacing the Waste Toner Box

3 Close the cap to the old waste toner box after removing the box from the printer.

(> oo

Old Waste Toner Box

Figure 5-12

4 To prevent toner from spilling, put the old waste toner box in the plastic bag
(contained in the toner kit) and discard it later according to the local code or

regulations for waste disposal.

Plastic Bag A
/\‘\.’)
Figure 5-13

5 Open the cap of the new waste toner box.

New Waste Toner Box

Figure 5-14

5-9
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5.2 Replacing the Waste Toner Box

6 Insert the new waste toner box as shown in the figure below. When the box is set
correctly, it will snap into place.

Figure 5-15

7 Make sure that the waste toner box is correctly inserted and close the left cover.

Figure 5-16

After replacing the toner containers and the waste toner box, clean the main charger units
and the paper transfer unit. For instructions, see section 5.3 Cleaning the Printer on page
5-11.

5-10
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5.3 Cleaning the Printer

5.3 Cleaning the Printer

As discussed earlier, the following parts must be cleaned each time the toner container and
waste toner box are replaced:

*  Main charger wire
*  Main charger grid
* Registration roller

In addition to this, it is recommended that the main charger wire and registration roller are
cleaned periodically at least once a month.

If lines, etc., appear on printed copies, the printouts appear dirty, or faint or blurred printouts
are produced, clean the advanced beam array lenses.

5.3.1 Cleaning the Main Charger Unit

The main charger units need to be cleaned periodically as they get contaminated with
dioxide after long usage. Each main charger unit is comprised of two main parts — the wire
and the grid — which should be separately as explained below.

There are 4 main charger units, one for each toner container. When performing the cleaning
procedure, be sure to clean the main charger unit that corresponds to color of the toner
container that was replaced. The following example explains the procedure to clean the
main charger unit for the black toner container.

Main Charger Units

oogooooog
go0000000

Figure 5-17
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5.3 Cleaning the Printer

1 Open the left cover.

Left Cover
Figure 5-18

2 First clean the main charger wire. Grasp the green wire cleaner knob. Gently pull the
wire cleaner knob out and push it back in. Repeat this 2 to 3 times. After cleaning,
make sure you restore the wire cleaner knob to its home position.

Wire Cleaner Knob

Figure 5-19

If the wire cleaner knob is not restored to its home position, a band
‘ ? will print along the length of the page.

5-12
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5.3 Cleaning the Printer

Next, clean the main charger grid. Take the grid cleaner out of the toner kit. Take the
grid cleaner out of the protective bag and remove the cap.

Grid Cleaner

Figure 5-20

The pad of the grid cleaner contains water. Clean the grid quickly so
‘ ? that the pad may not dry off.

Note

4 Lift up slightly on the main charger unit and pull it out a short distance as shown in
the figure below.

Main Charger
Unit

A

Figure 5-21

5-13
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5.3 Cleaning the Printer

5 Attach the grid cleaner to the printer with the pad facing up.

Grid Cleaner

Figure 5-22

6 Gently pull the main charger handle out and push it back in. Repeat this 2 to 3 times.
These movements clean the grid. After cleaning, make sure you restore the main
charger unit to its home position.

? Main Charger Unit

If the main charger unit is not restored to its home position, the
‘ i corresponding color will be printed over the whole page.

Figure 5-23

Note

5-14

Download from Www.Somanuals.com. All Manuals Search And Download.



5.3 Cleaning the Printer

Remove the grid cleaner from the printer and discard it. The grid cleaner cannot be
reused.

Figure 5-24

Use the same procedure to clean the main charger units for the other toner containers.

8 Close the left cover.

Figure 5-25

5-15
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5.3 Cleaning the Printer

5.3.2 Cleaning the Paper Transfer Unit

Print problems such as soiling of the reverse side of printed pages may occur if the paper
transfer unit becomes dirty. To clean the paper transfer unit, the following tool must be used:

*  Cleaning cloth (included in the toner kit)

Clean the paper transfer unit according to the procedure that follows:

While pulling the green paper transfer unit release lever, pull out the paper transfer

unit.
Paper Transfer Unit
Release Lever
Paper Transfer Unit
Figure 5-26

Wipe away the paper dust on the registration roller and the paper ramp using the
wiper cloth included in the toner kit.

Paper Ramp

Wiper Cloth

Transfer Roller
(Black)

Figure 5-27

Be careful not to touch the black transfer roller during cleaning as
‘ ? this may adversely affect print quality.

Note

3 Push the paper transfer unit back in completely.

5-16
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5.3 Cleaning the Printer

5.3.3 Cleaning the Advanced Beam Array Lenses
If lines, etc., appear on printed copies, the printouts appear dirty, or faint or blurred printouts
are produced, clean the advanced beam array lenses.

There is 1 lens on the main charger unit of each toner container. The following example
explains the procedure to clean the lens on the main charger unit of the black toner
container.

1 Open the left cover.

Left Cover

Figure 5-28

Grasp the tab of the green lens cleaner knob. Gently pull the lens cleaner knob out
and push it back in. Repeat this 2 times.

-
=
e >

Figure 5-29
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5.3 Cleaning the Printer

Push the lens cleaner knob back in completely. After cleaning, make sure you restore
the lens cleaner knob to its home position.

Figure 5-30

If the lens cleaner knob is not restored to its home position, the
‘ i corresponding color will be printed over the whole page.

Note

Use the same procedure to clean the lenses on the main charger unit of the other

toner containers.

4 Once you are finished cleaning all 4 lenses, close the left cover.

Figure 5-31

5-18
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Appendix A Options

Your printer can be installed with various options indicated in this appendix.
You can select the options that will satisfy your printing requirements.
For availability of the options, consult your Kyocera Mita dealer.
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A.1 Options

Options

A1

individual options, refer to the documentation included with the option. Some options are

The FS-C5016N printer has the following options available. For instructions on installing
explained in the following sections.

-up Output Tray

Face

||||||||

D
’
.
.

Duplex Unit DU-300

Envelope Feeder

EF-60

Paper Feeder PF-60

)

Expansion Memory
(DIMM 32/64/128/256 MB

1B-20/21E/22

Hard Disk

Figure A-1

A-2
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Expansion Memory Modules

A.2 Expansion Memory Modules

To expand the printer memory for more complex print jobs and faster print speed, you can
plug in optional memory modules (dual in line memory modules) in two memory slots
provided on the printer main controller board. You can select additional memory modules
from 32, 64, 128, or 256 MB (the maximum memory size is 608 MB, including the base
96 MB memory).

memory. Kyocera Mita shall not be liable for any damages caused by

g Only an authorized Kyocera Mita dealer should install the expansion
— improper installation of expansion memory.

Note

Precautions on handling the printer's main controller board and memory
modules

»  To protect electronic parts, discharge static electricity from your body by touching a
water pipe (faucet) or other large metal object before handling the memory modules. Or,
wear an antistatic wrist strap, if possible, when you install the memory modules.

e Always hold the main controller board or a memory module by its edges as shown
below to avoid damaging electronic parts.

YES

NO

Figure A-2

A-3
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A.2 Expansion Memory Modules

A.2.1 Installing the Memory Modules

1 Power off the printer and unplug the printer power cord.

2 Unscrew two screws at the back of the main controller board.

iy

Figure A-3

3 Pull out the main controller board gently.

Figure A-4

4 Push out the clamps on both ends of the memory socket on the main controller board.

Clamp

Clamp

Figure A-5

A-4
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Installing the Memory Modules

5 Remove the memory module from its package. Aligning the cutouts of the memory
module with the matching keys of the socket, carefully plug the memory module into
the memory socket until it clicks in place.

Cutouts

Figure A-6

6 Push down the two socket clamps to secure the memory modules.

Clamp

Clamp

Figure A-7

7 After you finish installing the memory modules, reinstall the main controller board
and fasten it with screws.

A-5
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A.2 Expansion Memory Modules

Removing a Memory Module

To remove a memory module, remove the main controller board, then carefully push out the
two socket clamps. Ease the memory module out of the socket to remove.

Testing the expanded memory

To verify that the memory modules are working properly, test them by printing a status
page. To print a status page:

1

2

4

Make sure the printer is switched off. Plug in the printer power cord into an AC
outlet and power on the printer.

Wait until the printer becomes Ready. When ready, press the MENU key.

Press the V key repeatedly until the message display shows Print Status
Page.

Press the ENTER key twice. A status page is printed.

Check the Memory field in the upper right area. It shows information about the memory
modules installed in memory slots 1 and 2. If you see an increase in the total memory size,
the installation is successful. (Note that the printer is shipped with 128 MB of base
memory.)

A-6
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A3

A.3.1

Memory Card

General Description of Options

Memory Card

The printer is equipped with a slot for a memory card with the maximum size of 256 MB. A
memory card is useful for storing fonts, macros, and overlays. You can use the IC Link for
Windows utility to download fonts, etc., to a flash memory card. This software is included
in the CD-ROM supplied with the printer.

Reading Font from the Memory Card

Once inserted in the printer’s slot, the contents of the memory card can be read from the
control panel or automatically when you power on or reset the printer. To manually read
read data in the memory card, see Chapter 3 Using the Operator Panel, section 3.9.1 Using
the Memory Card on page 3-59.

Before inserting a memory card in the printer, make sure that the
6 printer is switched off.

Insert the memory card in the memory card slot.

= W

Memory Card Slot

Figure A-8

A-7
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A.3 General Description of Options

A.3.2 PF-60 Paper Feeder

The PF-60 paper feeder allows you to add 3 more paper cassettes to the bottom of the printer
for continuous feeding of a large volume of paper. Each paper cassette can hold up to
approximately 500 sheets of ISO A4, ISO AS, JIS BS5, letter, and legal size (80 g/m?) paper.
This feeder is attached at the bottom of the printer as shown below.

For detailed information on installing the paper feeder, see the manual supplied with the
paper feeder.

Figure A-9

A.3.3 DU-300 Duplex Unit

The DU-300 duplex unit is attached to the bottom of the printer and allows you to print onto
both sides of the paper. Printing on both sides can be performed using ISO A4, ISO A5, JIS
BS5, letter, and legal sized paper.

For detailed information on installing the duplex unit, see the manual supplied with the
duplex unit.

Figure A-10

A-8
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PT-300 Face-up Output Tray

A.3.4 PT-300 Face-up Output Tray

Use the face-up output tray when you wish paper to be stacked with the printed side facing
up (reverse order), or when you are printing on envelopes, postcards, transparencies, or
thick paper.

1 Install the paper stopper according to the size of paper to be used.

\ I — Legal Size

E[ : A4 Size

\ \
} } L Letter Size
[ [

Figure A-11

2 Install the face-up output tray on the rear of the printer.

When installing directly to the printer

If a duplexer has been installed to the
printer

Face-up Output Tray

Figure A-12

A-9
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A.3 General Description of Options

A.3.5 Hard Disk

The hard disk is used for saving print data. This is advantageous when printing multiple sets
of copies, as high-speed printing is possible using the electronic sorting function. The hard
disk is further required in order to use the e-MPS function. You can use the KM-NET
Printer Disk Manager utility to keep track of the stored data. This software is included in
the CD-ROM supplied with the printer.

The hard disk must be installed in the option interface slot that is located at the back of the
printer as shown below.

The hard disk must be formatted before the initial use. To format the hard disk, use the
printer operator panel or the KM-NET Printer Disk Manager. Before you install the hard
disk in the printer, power off the printer and unplug the power cord.

Option Interface
Slot

Figure A-13

A-10
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A.3.6

IB-20/IB-21E/IB-22 Network Interface Cards

IB-20/IB-21E/IB-22 Network Interface Cards

Along with the standard for the network interface on the printer, the network interface card
supports TCP/IP, IPX/SPX, NetBEUI and EtherTalk protocols, so that the printer can be
used on network environments including Windows, Macintosh, UNIX, NetWare, etc. The
network interface card must be installed in the option interface slot that is located at the
back of the printer as shown below.

Figure A-14

Option Interface
Slot

Network interface card

Network connections

1B-20 10Base-T/100Base-TX/10Base-2
IB-21E 10Base-T/100Base-TX

1B-22 IEEE802.11b (Wireless)

Table A-1

A-11
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Appendix B Computer Interface

This appendix explains the signals used in the printer's parallel, USB, and serial (option)
interfaces. It also lists pin assignments, signal functions, timings, connector specifications,
and voltage levels. For details on the network interface, refer to the IB-21E/IB-22 User's
Manual contained on the CD-ROM that is supplied with the printer.

This appendix explains the following topics:

e Parallel Interface
¢ USB Interface
*  Serial Interface (Option)
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B.1 Parallel Interface

B.1 Parallel Interface

B.1.1 Communication Modes

The printer provides high-speed data transmission on a parallel interface. You can select the
parallel interface communication mode from the operation panel. To change communication
mode, see Chapter 3 Using the Operator Panel, section 3.5.1 Changing Parallel Interface
Mode on page 3-34.

0 Use a parallel interface cable that complies with the IEEE 1284 standard.

Note

You can choose from four communication modes:

Communication Reception Transmission
Mode
Auto (default) High-speed/ECP Nibble/ECP
Nibble High-speed Nibble
High-speed High-speed —
Normal Normal —
Table B-1
B-2
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B.1.2

B.1 Parallel Interface

Interface Signals
Table shows the connector pins and corresponding input and output signals of the parallel
interface. Explanation of each signal is also given in the table.

The description in [ ] indicates signal names in Auto mode and Nibble (high) mode (IEEE
1284-compliant). In Auto and Nibble modes, these signals are bidirectional.

Pin Inor Signal Description
out

1 In  Strobe’ [nStrobe] A negative-going-strobe pulse causes the printer to read
and latch the data on the Data 0 [1] to Data 7 [8] signal
lines.

2 In Data0[Datal] These eight signals form one byte of data sent from host

3 In  Datal [Data2] computer to printer. Data 7 [8] is the most significant bit.

4 In  Data? [Data 3]

5 In Data3[Data4]

6 In Data4 [Data5]

7 In Data5 [Data 6]

8 In  Data6 [Data7]

9 In  Data7 [Data 8]

10 Out AcknowledgeT [nAck] This negative-going pulse acknowledges the previous
character received.

1" Out  Busy [Busy] When this signal is high, the printer is busy. When itis low,
the printer is able to receive more data.

12 Out  Paper Empty This signal goes high when the printer runs out of paper.TT

[PError]

13 Out  Online (Select) [Select] This signal goes high when the printer is online and low
when the printer is offline. The signal goes low when you
press the GO key to make the printer go off line. '

14 In —[nAutoFd] Ignored

15 — — Not used

16 — 0VDC

17 —  Chassis Ground

18 —  +5VDC This pin is used for the printer’s +5 V DC power supply
(+540.5 V, 400 mA maximum, with fuse)

19 —  Ground return

20 —  Ground return

21 —  Ground return

22 —  Ground return

23 —  Ground return

24 —  Ground return

25 —  Ground return

26 —  Ground return

27 —  Ground return

28 —  Ground return

29 —  Ground return

Table B-2

B-3
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B.1 Parallel Interface

Pin In or Signal Description
out
30 —  Ground return
31 In — [nInit] Ignored
32 Out  Error' [nFault] When the high-speed parallel line control is on, this line
returns an error status.
33 —  — Not used
34 —  — Not used
35 Out Power Ready This signal goes high when the printer is powered on.
36 In  SelectIn[nSelectIn]  When this line is high, IEEE1284 mode is enabled.
Table B-2

t  Indicates signals that are low active.
+1 The Paper Empty, Online, and Error signals work only after you have enabled them using the O2
parameter of the FRPO command.

B-4
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B.2 USB Interface

B.2 USB Interface

This printer supports the Full-Speed USB 2.0. USB (Universal Serial Bus) interface
specifications and interface signals are as follows.

B.2.1 Specifications

Basic specification

Complies with the Full-Speed USB 2.0.

Connectors
Printer: B-type receptacle (female) with upstream port

Cable: B-type plug (male)

Cable
Use a shielded cable that complies with USB 2.0 and not longer than 5 meters (16 feet).

Transfer Mode

Full speed (max. 12 Mbps)

Power Control

Self-power device

B.2.2 Interface Signals

USB Connector Pin Assignment

Pin Signal Description
1 Vbus Power supply (+5 V)
2 D- Data transmission
3 D+ Data transmission
4 GND Signal ground

Shell Shield

Table B-3
B-5
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B.3 Serial Interface (Option)

B.3  Serial Interface (Option)

Installing the optional serial interface board kit (IB-11) in the printer enables connection to a
computer with an RS-232C standard serial interface.

B.3.1 Interface Signals

Table B-4 below shows the pins and corresponding input and output signals of the RS-232C
interface connector.

Pin In or out Signal Description

1 FG Frame Ground. This pin is connected directly to the printer
frame.

2 Out TXD Transmit Data. This pin is used to output asynchronous data
sent from the printer to the computer. This signal is often used
in handshaking.

3 In RXD Receive Data. This pin is used to input serial asynchronous
data sent from the computer to the printer.

4 Out RTS Request To Send. This output is always high (above 3 volts).

5 In CTS Clear To Send. Not used.

6 In DSR Data Set Ready. Not used.

7 SG Signal Ground. This pin is used to establish a common refer-
ence level for the voltages of all signals other than Frame
Ground.

20 Out DTR Data Terminal Ready . This pin is used to notify the status of
the printer buffer (i.e., nearly full or nearly empty) when hand-
shaking is used. The pin goes high (above 3 volts) when the
buffer is able to accept more data.

Table B-4

B.3.2 Interface voltage levels

The voltage levels of the interface signals conform to EIA RS-232C specifications. The
voltage level of SPACE is 3 to 15 volts. The voltage level of MARK is -3 to -15 volts.
Voltages between -3 and 3 volts are undefined.

B-6
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B.4 RS-232C Protocol

B.4 RS-232C Protocol

B.4.1 Parameters of the RS-232C Protocol

A protocol is a set of rules followed by various devices to send or receive data. The
parameters of the RS-232C protocol are stored in the battery-powered memory of the
printer. You can verify these parameters on the status printout as marked by the following
identifications:

HI:
H2:
H3:
H4:
H5:
He:
H7:
HS:

Baud rate

Number of data bits

Number of stop bits

Parity

Protocol logic
Buffer-nearly-full threshold
Buffer nearly-empty threshold
Received data buffer size

The parameters can be changed from the printer operator panel. To change the value for the
serial interface parameters, see Chapter 3 Using the Operator Panel, section 3.5.2
Changing Serial Interface Parameters on page 3-35.

This following section outlines the parameters and their values you can select on the
operator panel:

H1: Baud rate

Parameter value Baud rate

12
24
48
96
19
38
57
11

1200
2400
4800
9600
19200
38400
57600
115200

The factory setting is 96 (9600 baud).

H2: Number of data bits

7 or 8. The factory setting is 8.

H3: Number of stop bits

1 or 2. The factory setting is 1.

B-7
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B.4 RS-232C Protocol

H4: Parity

Parameter value Meaning
0 None

1 Odd

2 Even

3 Ignored

The factory setting is 0 (none).

H5: Protocol logic

Parameter value Meaning

0 Combination of DTR (positive logic) and XON/XOFF
1 DTR (positive logic)

2 DTR ( negative logic)

3 XON/XOFF

4 ETX/ACK

The factory setting is 0.

H6: Buffer nearly-full threshold
A percentage value from 0 to 99. The factory setting is 90.

H7: Buffer nearly-empty threshold

A percentage value from 0 to 99. The factory setting is 70. The factory settings of the buffer
nearly-full and nearly-empty thresholds (H6 and H7) are subject to change without notice.

The difference between the nearly-full and nearly-empty thresholds allows the computer to
send a fairly large amount of data in a continuous stream.

H8: Received data buffer size

The input buffer size is specified in increments of 100 kB. The factory setting is 5 (500 kB).

B.4.2 PRESCRIBE FRPO D0 Command

The PRESCRIBE FRPO D0 command is provided to allow manipulating XON/XOFF when
an error has occurred on the serial interface. Table B-5 summarizes the error status
corresponding to different DO values.

Timing of XON transfer to Serial interface error
host while Ready or Waiting error not handled error handled
XON sent every 3-5 seconds DO0=0 (default) DO0=1
XON not sent DO0=10 DO0=11
Table B-5
B-8
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B.5 RS-232C Cable Connection

B.5 RS-232C Cable Connection

B.5.1 Preparing an RS-232C Cable

After you procure an RS-232C cable, check its wiring against the pin assignments shown in
page section B.1.2 Interface Signals on page B-3. If you have an IBM communications
adapter cable type 1502067, use the procedure below to solder the wiring at the end (printer
side) of the cable:

1

2

oON O O

Unscrew the plastic cover at the end (printer side) of the cable.

A bare shield wire is provided for each wire in the cable. Solder all shield wires
together into a single bundle.

Connect the bundled shield wires to the connector metal face using a piece of flat
cable about 3 mm wide and 15 mm long,. Make sure that the soldered connections
are secure.

Unsolder wires 2 and 3, then resolder them in a crossover configuration. In other
words, solder wire 2 to pin 3 and wire 3 to pin 2. Cover the solder joints with a
thermofit tube.

Cut wires 4, 5, 6, and 20.

Solder wires 5 and 6 together and connect them to pin 20. Cover the solder joints
with a thermofit tube. Leave wire 4 unconnected.

Tape all remaining loose ends together, or seal them with a thermofit tube.

Screw the plastic cover back on the cable end.

B.5.2 Connecting the Printer to the Computer

Make sure that both computer and printer are powered off.

1

a0 DN

Discharge static electricity from your body by touching a metal object such as a
doorknob.

Plug the end (printer side) of the RS-232C cable into the printer’s serial interface
connector and screw it on securely.

Plug the other end of the cable into the computer’s serial interface connector.
Power on the printer.

The printer’s parameters are set at the factory as follows:

Baud rate = 9600 bps, data bits (character length) = 8, stop bits = 1, parity = none

The two RS-232C protocols are XON/XOFF and DTR. The printer executes both of
these protocols simultaneously, using positive logic for DTR.

B-9
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B.5 RS-232C Cable Connection

If you are not sure about the printer’s current parameter settings, reset them to the
values shown above (i.e., baud rate = 9600 bps, etc.). You can perform parameter
settings from the operation panel. See Chapter 3 Using the Operator Panel, section
3.5.2 Changing Serial Interface Parameters on page 3-35.

6 On the computer, set the same parameters as that of the printer. Most computers
allow you to do this by DIP switch settings that should be made before power is

turned on.

With Windows XP, make settings as follows:

1 Click on the Start button in the Windows XP task bar and align the cursor with
Settings, then click on Control Panel from among the items displayed.

2 The Control Panel window opens. Double click on System.

3 System Properties window opens. Click on the Hardware tab, then click on the
Device Manager button, and double click on Ports (COM & LPT).

£, Device Manager,

Al s
%1, DVDJCD-ROM drives

] = Floppy disk contrallers

#1 b Floppy disk drives

=12 IDE ATAATAPL controllers
1 o Keyboards

Figure B-1

Double click on Communications Port.

H

The Communications Port Properties dialog is displayed for the selected COM
port. Click on the Port Settings tab and set the port properties.

a

Communications Port (COM1) Properties (&S]

Genesal | Port Settings | Driver | Resources

i per second: ETI ~
Databits: |8 v
Paiity: | None ™
Stopbits: |1 b

Flow control: | None -

Advanced Restore Defaults

Figure B-2

6 After setting the properties, click the OK button.
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B.5 RS-232C Cable Connection

With Windows 95/98/Me, make settings as follows:

1 Click on the Start button in the Windows 95/98/Me task bar and align the cursor
with Settings, then click on Control Panel from among the items displayed.

2 The Control Panel window opens. Double click on System.

3 System Properties window opens. Click on the Device Manager tab, then
double click on Ports (COM & LPT).

System Properties [ 7] =]

General Devies Manager | Hardware Prafiles | Performance |

' View devices by lupe £ View devices by connection

Computer =
&5 COROM
Disk diives
Display adapters
Floppy disk controllers
Hard disk controllers
Keyboard

Moritors
7 Mouse

9 Network adapters

& 5C5l controllers
Sound, video and gams contrallers —

ytem devices E
Properties Refiesh | Femove | Pant |
Figure B-3

Double click on Communications Port.

H

The Communications Port Properties dialog is displayed for the selected COM
port. Click on the Port Settings tab and set the port properties.

A

Communications Port (COM1) Properties HE

General Port Settings | Driver | Resources |

Bits per second:
Dashis o ~]
Bait: [ore <]
Stepbits [T 7]
Flowecontiot [<on /%ot x|

Advanced | Restore Defaults |

Cancel

Figure B-4

6 After setting the properties, click the OK button.
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B.5 RS-232C Cable Connection

In DOS, enter the following commands:

C:\>MODE COM1:96,N,8,1,P
C:\>MODE LPT1:=COM1

To test the interface, enter the following:

CTRL P
C:\>DIR
CTRL P

The software settings made using the above procedures are temporary. On most computers,
permanent settings must be made with DIP switches.

B-12
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Appendix C Technical Specifications

The technical specification may be changed for improvement purpose.
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C.1 Printer Specification

CA Printer Specification

Item

Specification

Printing method

Electrographic by Advanced Beam Array, tandem interme-
diate transfer belt

Printing speed

See section C.2 Printing Speeds on page C-4.

Resolution

600 dpi (horizontal and vertical)

First print (A4, 23 °C)

Approximately 16 seconds or less (from power on)
Approximately 96 seconds or less (from sleep mode)

Warm up time (23 °C)

80 seconds or less

Main Controller CPU

PowerPC 750CXe (400 MHz)

Main memory

96 MB, expandable up to 608 MB maximum

Expansion Memory Module

32,64, 128, or 256 MB (for 2 slots)

Operating system

Windows 95/98/Me, Windows NT/2000/XP

Interfaces

IEEE1284

USB 2.0 Full-Speed

Protocol support: TCP/IP, IPX/SPX, NetBEUI, EtherTalk

Network interface card or Serial interface board (KUIO-
LV)/Hard disk

Memory card slot

Compact flash memory card, maximum 256 MB

Self-diagnostics

Performed at power-on

Maximum duty cycle (for standard dry A4

plain paper)

85,000 pages per month

Imaging drum

OPC

Developers

Touchdown projection development

Main charger

Positive scorotron charger

Transferring

Belt system

Roller system

Separation

Small diameter separation

Drum cleaning

Blade cleaner

Primary transfer belt cleaning

Brush cleaner

Drum discharging Discharging LED

Fuser Heat rollers

Paper See Chapter 2 Handling Paper, section 2.1.2 Paper specifi-
cations on page 2-2.

Paper sizes A4, BS, AS, legal, and letter sizes, adjustable

Multi-purpose tray

70X 216 mm to 148 X 297 mm

Unprintable areas

A top, bottom, left, or right margin of 4 mm

Paper capacity 500 sheets (80 g/m?)
Multi-purpose tray 100 sheets (80 g/m?)
Output tray capacities Face-down tray 250 sheets (80 g/m?)

250 sheets (80 g/m?) [100 sheets (80 g/m?) when the
optional duplexer is installed.]

Table C-1
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Printer Specification

Item Specification
Operating environ- ~ Temperature 10t0 32.5°C (50t0 90.5 °F)
ment Relative humidity 15 to 80 %
Optimum condi- 23 °C (73 °F), 60 % (relative humidity)
tions
Altitude 2,000 m (6,500 feet) maximum
Illumination 1,500 lux or less
Power supply U.S.A. and Canada 120V, 60 Hz, 9.1 A max
Europe, Asia,and  220t0 240V, 50 or 60 Hz, 4.5 A max. at 230 V
other countries
Allowable voltage + 10 % maximum
fluctuations
Allowable fre- + 2 % maximum
quency fluctuations
Power consumption  U.S.A. and Canada Maximum: 1,037 W
Normal operation: 491 W
Standby: 199 W
Sleeping: 21 W
Europe, Asia,and Maximum: 991 W
other countries Normal operation: 483 W
Standby: 202 W
Sleeping: 24 W
Noise Printing LpA=53dB(A)
Standby LpA=36dB(A)
Sleeping Unmesurably low
Dimensions 345 (13-9/16) wide x 385 (15-3/16) high X 470 mm (18-1/2
inches) deep
Weight 24 kg (52-7/8 1b)

Table C-1 (Continued)

+  Inaccordance with ISO 7779 (Bystander Position, sound pressure level at the front)

C-3
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C.2 Printing Speeds

C.2  Printing Speeds

Mode Paper Size Print Speeds (color/monochrome)
Simplex printing A4 16 pages/minute
Letter, B5, AS 17 pages/minute
Legal 14 pages/minute
Thick (A4)T, 8 pages/minute
Transparency (A4)T
Duplex printingTT A4, Letter, BS, AS 16 pages/minute
Legal 14 pages/minute
Table C-2

¥ Only with MP tray feeding
+1 The DU-300 duplex unit is required.

C-4
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A
Audible alarm
how to set 3-96
Auto-continue
changing recovery time 3-98
how to set 3-97

Cc

Carriage return
how to select 3-56
Cleaning
advanced beam array lens 5-17
main charger unit 5-11
paper transfer unit 5-16
using the grid cleaning tool 5-13
Color control
calibration 3-104
registration 3-100
selecting monochrome or color printing 3-86
Counters
reading the life counters 3-87
reading the total printed pages 3-87
toner, how to reset 3-88

Error log
on the status page 3-19
Error messages
of hard disk 4-11
of memory card 4-11
of RAM disk 4-11
tabled, with corrective actions 4-7

F

Face-down tray
location and function 1-6
Face-up output tray
option, diagrammed A-9
Font
adjusting character pitch for fixed fonts 3-48
changing the default size 3-47
printing lists of fonts 3-50
sample of the font list 3-51
selecting regular or dark Courier/Letter Gothic 3-46
setting the default using the operator panel 3-45
Formfeed
changing timeout time 3-90

G
D Gloss mode
Data dump how to select 3-58
receiving data for damping 3-93
Duplex printing
binding modes 3-78 H
description 3-78 Handling 2-1
note on using the MP tray 3-79 Hard disk
Duplex unit as an option A-10
option, diagrammed A-8 deleting data 3-62
formatting 3-63
writing data 3-61
E
e-MPS
as software feature 1-3 |
changing configuration 3-30 Indicators
general information 3-20 Interface 3-3
how to change hard disk spaces 3-30 Paper Size 3-4
printing a list of code jobs 3-27 Paper Type 3-5
Emulation - Ready, Data, Attention 3-5
appearing on the status page 3-19
KPDL, printing errors 3-44
KPDL, setting the alternative emulation 3-43
setting the default using the operator panel 3-42
Envelope
requirements 2-19
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J
Job retention
functions tabled 3-20
private job, how to use 3-24
proof-and-hold, how to use 3-23
quick copy, how to use 3-21
Job storage
functions 3-21

K
Keys
arrow keys 3-7
basic operation 3-6
Cancel 3-6
Enter 3-7
Go 3-6
Menu 3-7
KPDL3
as software feature 1-4
L
Label

required composition 2-17

requirements 2-18
Linefeed

how to select 3-55

Main charger unit
location 1-6

Memory
expanding memory A-3
installing memory modules A-4
on the status page 3-19

Memory card
deleting data 3-62
formatting 3-63
inserting in the slot A-7
location of the slot 1-8
writing data 3-61

Menu map
how to print 3-15
sample 3-16

Menu selection system
road map 3-8

Message display
changing the language 3-89
for replacing toner containers 5-3
indicators included 3-3
Online help messages 4-13
status information 3-2

MP tray
clearing paper jam 4-17
first mode, cassette mode 3-68
location and function 1-5
setting the paper size 3-69
setting the paper type 3-71

N

Network interface
a sample of the network status page 3-41
interface cards, diagrammed A-11
location of the slot 1-8
printing a network status page 3-40
protocols and parameters 3-37
resolving the IP address 3-39

Number of copies
how to select 3-52

(0

Online help messages
for clearing paper jams 4-13
Operator panel
configuring the printer defaults 3-42
diagram 3-2
function 1-5, 3-2
Options
a list of, diagrammed A-2
Orientation
how to select 3-53
Output device
how to select 3-85
Override A4/Letter
description 3-80

P

Page protect mode
how to select 3-54
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Paper
available paper 2-2
basic requirements 2-5
colored 2-20
envelopes 2-19
guidelines for choice 2-4
label 2-17
minimum and maximum sizes 2-3
other properties 2-7
paper sizes tabled, as Paper Size indicator 3-4
paper types, as Paper Type indicator 3-5
pre-printed 2-20
recommended makes and types 2-3
recycled 2-20
special paper 2-16
specifications, tabled 2-2
standard sizes 2-4
thick paper 2-19
transparencies 2-17
Paper cassette
as hardware feature 1-3
clearing paper jam 4-14
diagram 1-5
selecting the paper feed source 3-77
setting paper size 3-72
setting paper type 3-76
Paper feeder
diagrammed A-8
Paper jam
general considerations 4-13
messages and corrective actions,
diagrammed 4-14
possible locations, diagrammed 4-12
Paper transfer unit
location and function 1-7
Paper type
creating custom 3-80
how to create custom paper types 3-81
resetting the custom paper type 3-84
Parallel interface
changing parallel inteface mode 3-34
connector, location 1-8
signals and definitions B-3
understanding the modes B-2
Partition
a sample of the partition list 3-65
printing a list of 3-64
PRESCRIBE
as software feature 1-3
Print quality
Gloss mode 3-58
Printing problems
general guidelines tabled 4-2
print quality problems, blank printing, etc. 4-3

R
RAM disk
setup 3-59
Reset
resetting the printer 3-94
Resource protection
description 3-95

S
Serial interface
cabling B-9
changing parameters 3-35
computer interface B-10
protocol, RS-232C B-7
signals and definitions B-6
Setting the Timer 3-91
Sleep timer
setting the timer 3-91
setting timeout time 3-92
Status page
how to print 3-17
understanding 3-18
Storage device
reading fonts from 3-59
reading/writing 3-60
writing data 3-61

T

Toner containers

diagram 1-7

how to replace 5-4

kits 5-2

replacement 5-2

replacement, messages 5-3

service life 5-2

starter containers 5-2
Transparency

recommended makes and types 2-17
Two-dimensional barcode

as software feature 1-4

\')

Virtual mailbox
functions 3-21
how to change the maximum space 3-33
printing a list of mailboxes 3-28
retrieving jobs from 3-28
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Waste toner box
location 1-6
location and replacement 5-8
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